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1. Előszó helyett… 

Ez a könyv egy kétrészesre tervezett mű első kötete. Célja bevezetni az olvasót a hid-
rodinamikai és transzportmodellezés elméletébe és gyakorlatába. 
A kötet első fele a Szabó Imre szerkesztésében korábban megjelent, „Szennyezett 
területek kármentesítése” című könyv (FILEP et. al., 2002) modellezéssel foglalkozó 
részének kissé átdolgozott, aktualizált kiadása. A kötet második felében adom közre 
a Processing MODFLOW for Windows (PMWIN) környezet magyar nyelvű leírását. 
A közeljövőben – kollégáim közreműködésével - megjelentetni szándékozott máso-
dik kötetbe a PMWIN környezetben történő transzportmodellezést foglaljuk össze, 
továbbá számos példán és esettanulmányon keresztül gyakorlati tanácsokat is adunk. 
A számítógépes szimuláció egyfelől komoly szakmai feladat, tekintve, hogy nem-
csak a vízföldtannak, a szivárgás hidraulikájának, a matematika egyes fejezeteinek 
ismeretét, de számítástechnikai, sőt egyes esetekben programozási ismereteket is 
megkövetel. Mielőtt azonban gyorsan letenné a könyvet az olvasó, mondván ez va-
lami ördöngösség, meg kell jegyeznem: éppen az ellenkezője az igaz! A modellezés 
egy olyan eszköz, amivel könnyen sikerélményhez jutunk, játszva tanulhatjuk meg – 
általában saját hibáinkon keresztül - a felszín alatti vizek szivárgásának törvénysze-
rűségeit, a fizika által szabott korlátokat. A modellezés során eljátszhatunk a „mi 
lenne, ha” típusú gondolatokkal, vizsgálhatjuk, hogy „működhet-e” a Természet úgy, 
ahogyan azt mi gondoltuk. 
Lassan 10 éve kezdtem el a modellezés „oktatását” az egyetemeken, és mára elég 
impulzus ért, hogy belefogjak egy erről szóló könyv írásába. Bevallom, a legtöbbet a 
hallgatók által felvetett jó, illetve a logikusnak tűnő, de végiggondolva sokszor ab-
szurdnak bizonyult kérdésekből és felvetésekből tanultam, no és saját hibáimból. 
Volt olyan, hogy egy általam jónak vélt modell előtt akár egy hetet is ültem, mert 
„nem akart működni”. Valójában sosem a program volt a hibás: vagy téves volt a 
munkahipotézis, vagy ami még bosszantóbb: nem azt a feladatot írtam le a gép nyel-
vére, mint amit szerettem volna. A programozók alapigazsága: „a számítógép nem az 
akaratunkat hajtja végre, hanem a programot”. Ezért a modellezés - a programozás-
hoz hasonlóan - rászoktat, hogy logikusan rendszerezzük ismereteinket, azokat ér-
telmes formában és akár évekkel később is visszakereshetően lejegyezzük; hogy fo-
lyamatosan ellenőrizzük magunkat és akár a legbonyolultabb rendszerekben is - 
önállóan is értelmes egységeket vizsgálva - tudjunk hibát keresni és találni. Kémiku-
soktól hallottam azt a modellezésre is igaz mondást, miszerint „Két fajta kísérlet van: 
a sikeres és a tanulságos!”. Általában csak „tanulságos” modellek sorozatán keresztül 
jutunk végül el a sikereshez. Ha így nézzük a modellezést, akkor ez az egész olyan, 
mint egy nagy keresztrejtvény, ahol esetleg sokáig nem illeszkednek a vízszintesen 
és függőlegesen beírt szavak, de a végére minden a helyére kerül, és egy tiszta, el-
lentmondásmentes kép alakul ki.  
A közös „rejtvényfejtéshez” a Processing MODFLOW for Windows környezetet 
választottam. Tettem egyrészt azért, mert régóta használom ezt a logikus felépítésű, 
egyszerű és átlátható programrendszert, másrészt, mert a program Magyarországon is 
könnyen hozzáférhető teljes verzióban a Springer könyvkiadó által forgalmazott 
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könyv mellékleteként (Wen-Hsing Chiang - Wolfgang Kinzelbach: 
"3D-Groundwater Modeling with PMWIN", ISBN 3-540-67744-5, SPIN 10774334; 
Springer-Verlag Berlin, Heidelberg, New York). A programfrissítések letölthetők a 
http://www.pmwin.net honlapról. A program szerzője sokat segített a magyar Win-
dows és a kód inkompatibilitási hibáinak megoldásában, ötleteket adva a továbbju-
táshoz. Nem véletlen, hogy a könyv kapcsán kértem tőle a magyar modellezni tanu-
lóknak egy rövid mottót, ami ott található a könyv első oldalán. Tömörebben nehéz 
kifejezni a dolog lényegét: Sose add fel, mert sokszor napokig kell gondolkodnod 
egy probléma megoldásán! Mivel minden modell más és más, a hibák száma is per-
sze végtelen, ezért lehetetlen, hogy „megtanítsak” bárkit is modellezni. A könyv re-
mélem segít bevezetni az érdeklődőket a témakörbe, illetve elmélyíteni korábban 
szerzett ismereteiket. 
A könyv kézikönyv és segédlet is egyben, egyes részei külön-külön is használhatók 
lehetnek. Az alapegyenletek ismerete nélkül is meg lehet ismerkedni a programmal 
és viszont. A második kötetben bemutatni szándékozott példák és esettanulmányok is 
érthetőek és hasznosak lehetnek a korábbi fejezetek ismerete nélkül. Javaslom min-
denkinek, bátran lapozzon, ha olyan helyre ért, amit adott helyzetben számára feles-
legesnek érez. Több könyvvel voltam már magam is úgy, hogy mindig a legaktuáli-
sabb fejezeteket olvasva szinte mozaikszerűen ismertem meg az egészet, megörülve 
annak, hogy éppen az is benne van, amit az adott pillanatban kerestem. 
Végül megköszönöm a hallgatóim érdeklődését, egyetemi kollégáim segítségét, to-
vábbá a Miskolci Egyetem Műszaki Földtudományi Karának, illetve a Szegedi Tu-
dományegyetem Ásványtani, Geokémiai és Kőzettani Tanszékének, valamint a kö-
tetben szereplő cégek erkölcsi és anyagi támogatását. Ez utóbbi teszi lehetővé, hogy 
a szakirányú hallgatók a kötethez olcsón, gyakorlatilag a másolás árának megfelelő 
összegért juthassanak hozzá. Hozzájárulásukkal nemcsak a könyvet, hanem ezen ke-
resztül a magyar felsőoktatást is támogatták, hiszen a könyvet valamennyi magyaror-
szági egyetem szakirányú hallgatója részére elérhetővé kívánjuk tenni. Itt köszönöm 
meg az előzménymű lektorának Berecz Endre emeritusz professzornak lelkiismeretes 
munkáját és jelen kötet lektorának, Szanyi Jánosnak valamennyi észrevételét és gon-
dolatát. Számos megjegyzésük, észrevételük egyes részek továbbgondolására, átírá-
sára késztetett, amiért hálás vagyok mindkettőjüknek. 
Remélem a könyv hasznos segítőtársa lesz a hidrodinamikai és transzportmodelle-
zéssel foglalkozó valamennyi szakembernek, akiknek munkájához és a tanuláshoz 
kívánok a kitartáson kívül – szószerinti értelemben és bányászköszöntéssel is –  

 
Jó szerencsét! 

 
 

Kovács Balázs 
Miskolc-Szeged, 2004. december 6.  
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2. A hidrodinamikai és transzportmodellezés feladatai, célja, sajá-
tosságai 

A hidrodinamikai és transzportmodellezés, melyet a továbbiakban egyszerűen mo-
dellezésnek fogunk hívni, a valóságban a felszín alatt lejátszódó vízmigrációs és 
ezekhez kapcsolódó szennyezőanyag terjedési folyamatok szimulációja, követése 
számításokkal. Amennyiben a felállított modellel elvégzett számítások már bekövet-
kezett, azaz ismert folyamatokat jól követnek, akkor várhatóan alkalmasak feltétele-
zett hatásokra bekövetkező víz-, illetve szennyezőanyag-mozgás számítására, azaz 
előrejelzésre is.  
A modellezés három legfontosabb feladata tehát 
- a valóságot jól követő modellek felállítása, és ezáltal a valóságos környezet- és 

vízföldtani rendszerek működésének megismerése, vízföldtani jellemzőinek és a 
szennyezőanyagok adott környezetben érvényes terjedési tulajdonságainak meg-
határozása, 

- feltételezett helyzetekben (pl. havária-esetek) bekövetkező események szimuláci-
ója, a hatások által érintett térségek meghatározása, 

- valós helyzetekben lezajló tér- és időbeli változások előrejelzése (pl. szennyezett 
terület kármentesítésének előrehaladásának szimulációja, vagy éppen egy ma-
gára-hagyott szennyeződés hígulásának maghatározása). 

 

A szimulációs modellek a vízbázisvédelem, továbbá a hulladék-elhelyezés - kár-
mentesítés területén számos probléma vizsgálatára alkalmasak, melyek a teljesség 
igénye nélkül a következők:  
- a felszín alatti vizek áramlási viszonyainak meghatározása egy-egy tervezett vagy 

megvalósult vízbázis, nagyobb vízföldtani egység vagy hulladéklerakó környe-
zetében, 

- termelőkutak, továbbá szennyezőforrások hatóterületének, depressziós terének 
meghatározása a felszín alatti képződményekben, 

- a vízkivételi pontokig vagy a szennyezőforrásoktól kiindulva elérési idők megha-
tározása, veszélyeztetett vízkivételek meghatározása, 

- vízháztartás vizsgálata, 
- a hulladéklerakók aljzatszigetelésének, illetve szennyezőforrások izolációjának 

vizsgálata, 
- a szigetelő-rendszerek hatékonysági vizsgálata, adott szennyezőforrás által oko-

zott vagy okozható környezeti terhelések megismerése, 
- szigetelő rendszerek egyenértékűségének meghatározása, 
- szennyezett területek hatásvizsgálata, 
- koncentrációk tér- és időbeli változásának számítása, 
- magára hagyott szennyeződések szétterjedésének, az érintett vízadó rétegek ön-

tisztulásának számítása, 
- kármentesítési variánsok vizsgálata, a kármentesítés hatékonyságának ellenőr-

zése, optimális mentesítő létesítmény elhelyezés tervezése, a kármentesítés vár-
ható időtartamának maghatározása, 
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- laboratóriumi kísérletek alapján szennyezőanyagoknak adott képződményben 
való terjedési jellemzőinek meghatározása. 

 

A modellezés célja bonyolult felépítésű rendszerekben a felszín alatti víz szivárgási 
irányainak és sebességének kijelölése, a víz nyomásszintjeinek számítása (depresszi-
óstér-alakulás) a térben és az időben. A felszín alatti vizek mozgását szimuláló mo-
delleket hidrodinamikai modelleknek nevezzük. A hidrodinamikai modellek eredmé-
nyeinek felhasználásával különböző szennyezőanyagok mozgását, azaz a koncentrá-
ciók tér- és időbeli alakulását is számíthatjuk, ezeket a rendszereket transzportmo-
delleknek nevezzük. 
A hidrodinamikai és transzportmodellezés egy fontos sajátossága, hogy előzetes 
munkahipotézisen, azaz egy prekoncepción alapul, a számítások első feladata a mun-
kahipotézisnek megfelelő modell felépítése, és amennyiben azzal a valós folyamatok 
követése megvalósítható, akkor a prekoncepciót az adott feladat megoldása szem-
pontjából elfogadhatjuk. Amennyiben a valóságos folyamatok szimulációja nem 
vagy nem megfelelő szinten végezhető el, úgy az egyébként a terület korábbi vizs-
gálatain alapuló munkahipotézist módosítani kell, illetve a megváltoztatott munkahi-
potézisre vonatkozó (azt megerősítő vagy cáfoló) szakmai ismereteket összegyűjteni 
szükséges (1. ábra). A munkahipotézis fejlesztését mindaddig szükséges folytatni, 
amíg az egyfelől a szimulációs feladat megoldásához megfelelővé nem válik, másfe-
lől összhangba nem kerül valamennyi korábbi földtani és vízföldtani ismerettel.  

Földtani és vízföldtani ismeretek összegyûjtése és rendszerezése

A modellezési koncepció (munkahipotézis) felállítása

Modelladatrendszer felállítása

Numerikus számítások elvégzése

Eredmények értékelése

Modell felhasználása a vizsgálandó probléma megoldására

Munkahipotézis vagy 
adatrendszer módosítása

 
1. ábra 

A modellezési munkafolyamat 
 

Az áramlástanban korábban tanultak során ezzel szemben ismertek voltak geometriai 
adatok (pl. rétegvastagság), anyagjellemzők (pl. szivárgási tényező, szabad hézagtér-
fogat, tárolási tényező stb.), a folyamatokat indukáló paraméterek (depressziók, 
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nyomásszintek, illetve azok különbségei) és egy adott, későbbi időpontban kialakuló 
helyzet egyértelműen a kiindulási adatokból meghatározhatók voltak.  
Az alapvető különbség a két megközelítés között, hogy az egyik esetben ismerjük 
mind a pontos geometriai jellemzőket, mind az összes képződmény tulajdonságait, 
ennek következtében az eredményt explicit módon meghatározhatjuk. A vízföldtan 
területén viszont csak pontokra (fúrási mintákra), vonalakra (pl. fúrólyuk-geofizikai 
vagy más néven karottázs vizsgálat), esetleg kisebb-nagyobb, de méretileg pontosan 
meg sem határozható térrészre (pl. próbaszivattyúzás, vertikális elektromos szelvé-
nyezés (VESZ)) jellemző tulajdonságokat (szivárgási tényező, fajlagos ellenállás 
stb.) ismerünk. A geofizikai ismeretek – bár nagyon fontosak a vízföldtani kutatás-
ban, - mégis csupán közvetett információk (földtani interpretációk). A felsoroltak 
miatt a vízföldtani rendszerek ismeretességi nem lehet olyan szintű, hogy a számítá-
sok során az alapadatokból azonnal a végeredmény (pl. nyomásszintek vagy kon-
centrációk alakulása a térben és az időben) egy lépésben meghatározható legyen. (Az 
egyszerű áramlástani esetekben homogén izotróp közeget, állandó rétegvastagságot, 
vízszintes feküt stb. tételeztünk fel, és ilyen módon az eredményt azonnal számít-
hattuk.) 
Másképpen fogalmazva a hidrodinamikai és transzportmodellezés során önmaguk-
ban az alapadatok mennyisége és minősége sem teszi lehetővé a feladat matematika-
ilag korrekt megoldását, ezért olyan munkahipotézisre vagy modellezési koncepcióra 
van szükség, amellyel a hiányzó adatokat, ismereteket pótolni lehet. Tekintettel mind 
az adatokban, mind a hipotézisben rejlő bizonytalanságokra, a számítás eredményei-
nek is lesz egy bizonytalansága. Az hogy az eredmények mennyire jól hasonlítanak a 
valóságra, azt meghatározza a földtani és vízföldtani ismereteken alapuló modell-
koncepció minősége, a felépített modell struktúrája, az elvégzett számítási variánsok, 
illetve a variánsok tapasztalatai alapján végzett koncepcionális modellfejlesztés mér-
téke. Mindezen tényezőkből eredő kockázat nagysága a modellező szakmai (földtani, 
vízföldtani, matematikai és számítástechnikai) felkészültségének függvénye, amiből 
az következik, hogy egy adott probléma vizsgálatára különböző személyek által fel-
épített modellek természetszerűleg különböznek egymástól. A jó modellek ugyanak-
kor adott kérdésre egymáshoz és a valósághoz nagyon hasonló eredményeket szol-
gáltatnak. A modell „jósága” csak a megoldandó feladat ismeretében határozható 
meg, hiszen nincs olyan modell, amelyik minden kérdésre egyformán jó választ len-
ne képes adni. Általában azt a modellt tekintjük jobbnak két azonos „tudású” rend-
szer közül, amelyik egyszerűbb. A modellezés során nem lehet olyan szoftvert kifej-
leszteni, amit bárki használni tud, mert az eredményeket a modellező szakember fel-
készültsége alapvetően határozza meg. A hidrodinamikai és transzportmodellezés 
szépsége éppen a feladat alulhatározottságából eredő problémák kiküszöbölésében, a 
kreatív megoldások alkalmazásában áll. 
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3. A modellezés szakaszai és lépései 

A hidrodinamikai modellezés során a szivárgás alapegyenletét, a transzportmodelle-
zéskor a szennyezőanyagok migrációját leíró ún. transzport-egyenletet oldjuk meg a 
nyomásszintek, illetve a koncentrációk meghatározása érdekében. Az egyenletek 
megoldása mind analitikus, mind numerikus úton történhet. A hidrodinamikai 
és/vagy transzportmodellek általában numerikus modellek, melyek általában a véges 
differencia vagy a végeselem módszer alkalmazásán alapulnak. 
A modellezés teljes folyamata általában két szakaszra bontható. Az első szakaszban a 
cél az áramló közeg sebességének és áramlási irányának meghatározása a modelle-
zett térben. A számítási eredmények alapján lehetőség nyílik a rendszerek vízháztar-
tásának, vízmérlegének meghatározására is. Ezt követi a számított szivárgási sebes-
ségeknek és a transzportegyenletnek felhasználásával - a meghatározott terjedési és 
anyagi tulajdonságokkal rendelkező - szennyezőanyag mozgásnak számítása, amit a 
modellezés második szakaszának nevezünk (2. ábra).  
Az áramlási sebességek irányának és nagyságának, valamint annak időbeli változá-
sának ismeretében az első szivárgáshidraulikai számítási lépcső elhagyható, és a 
transzportfolyamat szimulációja közvetlenül megkezdhető, illetve amennyiben a 
probléma megoldása a szennyezőanyagok terjedésének számítását nem igényli, ak-
kor a második szakasz hagyható el. 
Mind a hidrodinamikai, mind a transzportmodellezési szakasz több lépésből áll: 

1. lépés, az előkészítés 
Az előkészítő munkafázis célja a teljes elvégzendő számítási folyamat körvonalazása 
a feladat konkretizálása. A feladat meghatározásával egyidejűleg célszerű a modell-
számítástól elvárható eredményeket számba venni, és azokat összevetni a megren-
delő által megfogalmazott elvárásokkal. A gyakorlati modellezés során felmerülnek 
olyan problémák, melyeknek a megoldására a számítások egyáltalán nem alkalma-
sak, esetleg olyan mértékbe pontatlanok, ami miatt értelmetlenné válhat az alkalma-
zásuk.  
Már az előkészítés fázisában fontos kigondolni, hogy az adott feladat szempontjából 
milyen egyszerűsítések engedhetők meg. Ezen belül is fontos lehet a szimmetriavi-
szonyok kihasználása, a modell dimenziószámának előzetes meghatározása, azaz, 
hogy a vizsgálandó folyamatokat lineáris, sík vagy térmodellezés segítségével lehet a 
legcélravezetőbben leírni.  
Az előkészítés egy kritikus pontja a modellezendő térnek a lehatárolása, mert az ek-
kor meghatározott térrészre fog a második lépés, az adatgyűjtés elsősorban koncent-
rálni. Mivel pontosan a modellezendő térrész az előkészítő fázisban nem határozható 
meg, mindig a még indokolható legnagyobb területben határozzuk meg a földtani és 
vízföldtani adatgyűjtés tárgyát. 
Az előkészítés során már megfontolandó a célszerű matematikai számítási eljárás 
kiválasztása, amelynek segítségével az előzetesen felmért mennyiségű és minőségű 
adatállományból a körvonalazott feladat a megkívánt szinten megoldható, de ameny-
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nyiben ez nem lehetséges, akkor a probléma megoldására biztosan nem alkalmazható 
módszereket ki kell zárni. 
 

Egyenlet vagy egyenlet-
rendszer felirása

Egyenlet vagy egyenlet-
rendszer megoldása

Számítási eredmények: 
h(x,y,z,t), v(x,y,z,t)

Eredmények grafikus
kiértékelése

Kalibráció -
eredmények
ellenõrzése

Eredmény
megfelelõ

Eredmény
nem megfelelõ

Számítási alapadatrendszer
kialakítása

Feladat 
  megfogalmazása  

Alapadatrendszer
módosítása

Esetleges szennyezõ-
anyag--terjedés számí-
tás számára a szivár-
gási sebességek és/
vagy nyomásszintek 

átadása

Áramlási közeg
jellemzõi (k, T, n)

Források és
nyelõk adatai

Kezdeti feltételek
(kezdeti nyomásszintek)

Peremfeltételek (adott nyomás-
szintek vagy vízhozamok)

Modell-
geometria

 
2.a ábra 

A hidrodinamikai számítás folyamata 

2. lépés, a földtani és vízföldtani adatgyűjtés és kutatás 
A modellezéshez szükséges földtani és vízföldtani adatok összegyűjtésén túl sokszor 
nyílik lehetőség új ismeretek megszerzésére is kutatás révén. A kutatást csak a meg-
lévő ismeretek áttekintése és rendszerezése után célszerű megkezdeni, mert akkor 
derülnek ki adathiányos vagy kevésbé ismert területrészek. Az adatgyűjtés és a ku-
tatás során a kutatáskor meghatározott valamennyi elvet figyelembe kell venni, de a 
modellezés szempontjából különös fontosságot kell tulajdonítani a teljesség elvének 
és az egyenletes megismerés elvének a teljesülésére. 
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Egyenlet vagy egyenlet-
rendszer felirása

Egyenlet vagy egyenlet-
rendszer megoldása

Eredmények grafikus
kiértékelése

Kalibráció -
eredmények
ellenõrzése

Eredmény
megfelelõ

Eredmény
nem megfelelõ

Számítási alapadatrendszer
kialakítása

Feladat 
  megfogalmazása  

Alapadatrendszer
módosítása

Számítási eredmények: 
c(x,y,z,t)

Modell-
geometria

Áramlási sebességtér
adatai [ v(x,y,z,t) ]

Áramlási közeg
jellemzõk (d, D, n)

Szennyezõanyag-források
és -nyelõk adatai

Áramló közeg ( a szennyezõanyag)
jellemzõi (sûrûség, késleltetés, bomlás)

Szivárgáshidraulikai
számítási eredmények,

modellgeometria és 
áramlási közeg-jellem-
zõk esetleges átvétele

Kezdeti feltételek
(kezdeti koncentrációk)

Peremfeltételek (adott koncentrációk
vagy szennyezõanyaghozamok)

 

2.b ábra 
A transzport-számítás folyamata 

 

A munkafázis célja egy a feladat megoldásához megfelelő szintű, ellentmondásmen-
tes földtani és vízföldtani képnek a kialakítása. A munkába célszerű a térséget is-
merő, tapasztalt geológus és hidrogeológus szakemberek bevonása. A munkafázis 
során meg kell ismerni a modellezett tér és tágabb környezetének geológiáját és víz-
földtanát és ennek alapján a megoldáshoz szükséges adatrendszert össze kell állítani 
(a helyszíni és laboratóriumi mérések eredményei, földtani és vízföldtani térképek, 
hidrológiai, hidrometeorológiai adatok, stb.). Amennyiben lehetséges, akkor feltétle-
nül javasolható a régebbi adatoknak újabb adatokkal való kiegészítése és ellenőrzése. 
Különösen fontos a felszín alatti vizek áramlási és nyomásviszonyaira vonatkozó 
ismeretek frissítése és kiegészítése, mert pl. a rétegvízadók nyomásviszonyai akár 
10-15 éves viszonylatban is számottevően megváltozhatnak. A nyomásviszonyok 
pontosítása mind a hidrodinamikai, mind a transzportmodellezés szempontjából na-
gyon fontos. Ugyancsak figyelmet kell fordítani a terület környezetében található 
víztermelési helyek megismerésére, valamint a szennyező-források feltárására. Mind 
a vízigények, mind a szennyező-források intenzitása időben jelentősen változhat, új 
potenciális vagy valós szennyező-források jelenhetnek meg, melyeknek a figyelembe 
vétele alapvető fontosságú. A szennyező-forrásokkal kapcsolatosan szükséges a 
szennyezett talajokat és talajvizet térben lehatárolni víz és talajkémiai mérések alap-
ján. Lehetőség van az adathiányos területeken a meglévő ismeretek alapján 
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geostatisztikai módszerekkel sűríteni az adatokat, azonban az így származtatott ada-
tok szükségképpen magukban hordozzák a kiindulási adatmező hibáit. 
Az adatgyűjtési lépcsőbe tartozik az első számítási szakasz elhagyása esetén a vízadó 
szivárgási viszonyaira vonatkozó adatrendszer kialakítása, esetleg korábbi hidrauli-
kai számítások eredményeinek átvétele. Gondoskodni kell az esetlegesen átvett hid-
rodinamikai modelladatok ellenőrzéséről. 
Az adatgyűjtés és a kutatás során felhalmozott ismereteket szükséges rendezett for-
mában összefoglalni és annak alapján a modellezésre vonatkozó korábbi döntéseket 
(modellezett tér lehatárolása, alkalmazandó számítási módszer kiválasztása stb.) felül 
kell vizsgálni. A rendelkezésre álló adatrendszert értékelni kell, az esetleges felme-
rülő ellentmondások kiszűrését a területre vonatkozó földtani vízföldtani koncepció 
alapján el kell végezni. 
Az adatgyűjtés és kutatás tekintetében általános irányelv, hogy a modellezés ered-
ményeinek pontossága legfeljebb az adatrendszer pontosságával egyező nagyságú 
lehet. Az angolszász irodalomban ezt „Rubish in, rubish out” jelenségnek nevezik, 
azaz rosszul felállított adatrendszer csak hibás eredményekhez vezethet.  

3. lépés, első számítási lépcső 
Az első számítási lépcső során elvégezzük az első próbaszámításokat, feltárjuk az 
adathiányokat és pótoljuk azokat. Bármennyire is alapos a kutatás és adatgyűjtés 
mégis előfordul, hogy a vízföldtani vagy földtani szakemberek által felállított kon-
cepció csak részben igazolódik, ilyenkor az első számítási eredmények alapján to-
vábbi adatgyűjtést esetleg újabb vízadó rétegekre vonatkozó adatok megszerzését 
irányozhatjuk elő.  
A leggyakoribb hibák: 
- A vízföldtani kutatás alapján a modellezett térrész határain felvett peremfeltétele-

ket a számítások nem igazolják. 
- A földtani, vízföldtani kutatás kapcsolatot állapított meg szomszédos hidrogeoló-

giai egységekkel, mélyebben vagy magasabban települő rétegekkel, melyekre vo-
natkozóan a számításokat ki kell terjeszteni, ugyanakkor az újonnan a modellbe 
integrált térrészekre információhiány jellemző. 

- A földtani, vízföldtani szakemberek által megadott, becsült vagy szakirodalmi 
adatok a valóságostól annyira eltérőek, hogy a modell egészében vagy csak egy 
kis területén irreális eredményekhez vezetnek akár az iteratív számítások legsú-
lyosabb numerikus hibáját, divergenciáját is okozzák. Leginkább a maradó beszi-
várgás, szomszédos vízadókból és hidrogeológiai egységekből átadott vízmennyi-
ségek, járulékos vízkészletek téves meghatározása okozza a hibát. 

Az első számítási lépcső során lépésről lépésre megoldjuk a számítások során felve-
tődő problémákat, korrigálva az adatrendszert. Ebben a fázisban komoly segítséget 
jelent a térséget ismerő hidrogeológus szakemberrel való folyamatos egyeztetés, hi-
szen a modell stabilitásának biztosítása ugyan a modellező szakember feladata, 
ugyanakkor a számítások alapján felvetődő koncepcionális ellentmondások kiszűrése 
és feloldása már csak a modellező és a koncepciót kidolgozó szakember együttmű-
ködésével lehetséges.  
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Az első számítási lépcső biztosítja a kalibráció alapadatait.  
4. lépés, a modell kalibrálása és paraméterérzékenységi vizsgálat: 
A kalibráció során a ismert valós folyamatokat szimulálunk a koncepcionálisan he-
lyesnek tartott számítási modellel, miközben a számítási eredményeket a valós ered-
ményekhez közelítjük az alapadat-rendszer szisztematikus változtatásával. 
A kalibrációt megkönnyíti az ún. paraméter-érzékenységi vizsgálat. A vizsgálat so-
rán a már jól működő modellben az egyes felvett paraméterek racionális szélsőérté-
kei mellett vizsgáljuk a modell válaszait, ezen keresztül az egész szimulált rendszer 
viselkedését ismerjük meg. A paraméter-érzékenységi vizsgálattal arra is választ ka-
punk, hogy egy paraméter ismertségének bizonytalansága lehetővé teszi-e a vizsgált 
kérdés megválaszolását.  
A kalibrációt követően egy olyan számítási rendszer alakul ki, amely az ismert fo-
lyamatokra a valóságos, vagy azt legjobban megközelítő választ szolgáltat. Munka-
hipotézisünk, hogy amennyiben ez a helyzet fennáll, akkor várhatóan ismeretlen új 
hatásokra (új víztermelő létesítmények, új vagy megszüntetett szennyezőanyag forrá-
sok) a modell valósághű válaszokat fog produkálni, ami természetesen csak bizonyos 
határok között lehet igaz. 

5. lépés, második számítási lépcső 
A második számítási lépcsőben elvégezzük azokat a szimulációkat, amelyeket az 
első szakaszban feltett kérdésekre a választ megadhatják. Ekkor elkészítjük az adott 
rendszer viselkedésére vonatkozó előrejelzéseket, a legkedvezőbb és a legkedvezőt-
lenebb eseteket szimulálva. A tervezett variánsok közül kiválasztjuk a leghatéko-
nyabbat, esetleg az ismeretlen felépítésű képződményeket sztochasztikus modelle-
zéssel vizsgáljuk. A második számítási lépcső az, amikor a modellt már valóban új 
problémák vizsgálatára használjuk fel. 

6. lépés, az eredmények kiértékelése 
A kiértékelés folyamán összegezzük és ábrázoljuk az eredményeket, ezeknek alapján 
megadjuk feltett kérdésekre a szabatos választ. A kiértékelési fázis feladata megfo-
galmazni a számítások korlátjait, összegezni az elkerülhetetlenül elkövetett hibákat, 
egyszerűsítéseket, megadni a felsorolt tényezők eredményre gyakorolt hatásait. A 
kiértékelés során további, mások által végzett munkafázisok részére megfelelő adap-
tációkat is készítünk (pl. környezeti hatástanulmányhoz, létesítési vagy megvalósítási 
tervhez stb.). 
A munka lezárásaképpen elkészítjük a modell teljes és részletes dokumentációját. A 
dokumentációnak minden lényeges kérdésre kiterjedőnek kell lennie. Ismertetnie kell 
a kialakított modellkoncepciót, indokolnia kell a mások által korábban felvett kon-
cepcióktól való lényegesebb eltéréseket. A dokumentációnak olyan mértékig részle-
tesnek kell lennie, hogy a modell felépítése teljesen rekonstruálható legyen, annak 
minden előnyével és hibájával együtt. Korrekt megoldás a modell adatrendszerének 
átadása a megbízónak, ezzel is segítve további munkáját. 
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4. A víz porózus közegbeli mozgásának törvényszerűségei 

4.1. A hidrodinamikai modellezés elméleti alapjai, a szivárgás alapegyenlete 

A hidrodinamikai modellezés során a vízmozgás alapegyenletének megoldását keres-
sük permanens és nem permanens állapotban, illetve telített vagy telítetlen közegben, 
ezért a megoldási lehetőségek ismertetését megelőzően bemutatjuk a szivárgás alap-
egyenletének alakjait, a Laplace- és Richards-egyenleteket. A szivárgás alapegyenle-
tének levezetését az ismert felszín alatti szivárgásokkal foglalkozó hidraulika köny-
vek (BEAR-VERRUIJT, 1987; KINZELBACH, 1986; FREEZE-CHERRY, 1979) 
részletesen ismertetik. 
A szivárgás alapegyenlete matematikai formában írja le a vízmozgás törvényszerű-
ségeit. A szivárgást leíró alapvető összefüggés a Darcy-törvény; ezt a porózus kö-
zegben áramló folyadékok tömegmegmaradásának kontinuitási egyenletével összeil-
lesztve a szivárgás alapegyenletét kapjuk meg.  
Az eredményként kapott parciális differenciál-egyenlet egymástól alig eltérő formá-
ban írható fel a permanens és nem permanens, telített közegbeli áramlás esetére, sőt 
kiterjeszthető a telítetlen közegbeli szivárgásokra is. Mindhárom esetre vonatkozóan 
megállapítható, hogy a kapott parciális differenciálegyenlet a matematikusok szá-
mára nagyon ismert, ezért megoldásukra vonatkozóan számos eljárást dolgoztak ki. 

4.1.1. Telített közegbeli permanens szivárgás 
Telített közegben a permanens vízmozgást – mellőzve a levezetést - az alábbi egyen-
let írja le: 
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Ez az egyenlet a matematikában jól ismert Laplace-egyenlet, melynek megoldása 
mutatja meg a h piezometrikus szint nagyságát bárhol egy háromdimenziós áramlási 
térben. Kétdimenziós esetben a Laplace-egyenlet megfelelő tagja kiesik, így kapjuk a 
nyomás-szint eloszlást a vizsgált sík mentén. 
Amennyiben a közeg anizotróp, akkor a szivárgási tényező vektor kx, ky és kz kom-
ponensei nem egyenlők és ekkor a szivárgás alapegyenlete anizotróp, porózus, telített 
közeg esetére permanens állapotot feltételezve: 
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ahol kx, ky és kz a szivárgási tényező tenzor főátlójának elemei. 

4.1.2. Telített közegbeli nem permanens szivárgás 
A nem-permanens szivárgás telített közegbeli alapegyenlete: 
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ahol ρ a folyadék sűrűsége, Ss a fajlagos tárolási tényező. A fajlagos tárolási tényező 
az egységnyi nyomásszint-változás hatására a kőzet kompressziója miatt, illetve a víz 
tágulása miatt felszabaduló vízmennyiség összege, azaz  

)( βαρ ngSs += ,         (4.4.) 
ahol α a kőzet, β a folyadék kompresszibilitása és n a hézagtérfogat. A fajlagos tá-
rolási tényező dimenziója [1/L], általában 1/m az SI rendszerben. 
Egy m vastagságú telített rétegben (zárt tükrű vízadó) a transzmisszivitás T=km és a 
tárolási tényező definíciószerűen S=Ssm: 

)( βαρ ngmmSS s +==         (4.5.) 
A tárolási tényező egy zárttükrű vízadóban megmutatja, hogy mekkora vízmennyiség 
szabadul fel egy egységnyi felületű részén a vízadónak, miközben a nyomásszint egy-
ségnyit csökken. A tárolási tényező dimenziónélküli szám, nagysága a 0,005-0,00005 
intervallumban szokott változni. SZÉKELY F. (1986) szerint az Alföldön a tárolási 
tényező nagysága 0,001 körüli. A tárolási tényező vízrekesztő képződményekre is 
definiálható, azonban ebben az esetben az nβ tag elhanyagolható nagyságú. 
Amennyiben a közeg izotróp és homogén, akkor a matematikában diffúzió-egyenlet-
ként ismert formulát kapjuk: 
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Az áramlási térben tehát a nyomásszintek változása a térben és az időben a k szivár-
gási tényező, α közeg összenyomhatóság és n hézagtérfogattól, mint közegjellem-
zőtől, és a folyadék β összenyomhatóságától és ρ sűrűségétől függ. 
Amennyiben egy m vastagságú horizontális vízadót tekintünk, akkor a tárolási té-
nyező S=m⋅SS, illetve a transzmisszivitás T=k⋅m és ekkor 
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ami a Theis-Jacob-féle analitikus megoldás kiinduló összefüggése. Az egyenlettel 
számítható a x, y síkbeli koordináták függvényében a piezometrikus szint, amennyi-
ben a vízadó T transzmisszivitása és S tárolási tényezője ismert. 
A nyílt tükrű rendszerben a víztárolási képességet a fajlagos hozammal jellemezhet-
jük. A fajlagos hozam az a vízmennyiség, amennyi felszabadul egy egységnyi felületű, 
nyílt tükrű vízadóból miközben a nyomásszint egységnyit csökken. A 3. ábra a víztar-
talom változását mutatja két időpontban (t1 és t2) a mélység függvényében. Az ábrán 
sraffozással jelölt, a görbék közötti terület nagysága arányos a felszabaduló vízmeny-
nyiséggel. Amennyiben a nyomásszint-változás éppen egységnyi, akkor a sraffozott 
terület éppen a fajlagos hozamnak megfelelő nagyságú. Amennyiben a telítetlen zó-
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nában tárolt vízmennyiségeket elhanyagoljuk, akkor a fajlagos hozam értéke meg-
egyezik a szabad hézagtérfogat értékével. 
A fajlagos hozam Sy értéke általában 0,01-0,3 közötti. A nagyobb értékek azt jelzik, 
hogy a pórusok nagy része leürül a nyomásváltozások hatására, a maximális vízka-
pacitás, azaz a vízmennyiség, amit a kőzet a gravitációs erő ellenében magában tar-
tani képes, kicsi. 

 
3. ábra 

A fajlagos hozam értelmezése 

4.1.3. Nem permanens szivárgás telítetlen közegben 

A telítettséget tekintsük a n/' ΘΘ = alakban, ahol Θ a térfogati víztartalom és n a 
hézagtérfogat. Következményként a telítettség akkor 100%, amikor a térfogati víztar-
talom és a hézagtérfogat értéke azonos. Tekintsünk egy függélyt a felszíntől a talaj-
vízig. A felszínen és közelében telítetlen a közeg, a talajvízszint közelében telített. 
Bár egyszerűsítve a telített és telítetlen közeg határát a talajvízszint magasságában 
tételezhetnénk fel, ez nem igaz, mert a talajvíz felett a kapilláris zóna található. A 
talajvízszint mélységében a pórusfolyadék p nyomásszintje pontosan megegyezik a 
légköri nyomással ezért a ψ nyomómagasság zérus. A talajvízszint alatt az értelme-
zés szerint ψ>0, ezért logikusan a talajvízszint felett ψ<0, ha h=z+ψ (4. ábra). Telí-
tetlen közegben a víz a talaj pórusaiban felületi feszültség miatt fellépő erők hatása 
alatt áll és az emiatt fellépő negatív nyomómagasságot szívómagasságnak vagy 
tenziónak szokták nevezni. 

A telítetlen zónában mind a Θ térfogati víztartalom, mind a k szivárgási tényező a ψ 
nyomómagasság függvénye. Mint azt kísérletek bizonyították a térfogati víztartalom-
nyomómagasság összefüggésnek alakja eltérő nedvesedés és száradás folyamán, azaz 
a görbének hiszterézise van (5. ábra:a). Mint ahogy az ábráról látható, a Θ térfogati 
víztartalom nemcsak a telített közegben (ψ≥0), hanem a telített állapothoz közeli, kis 
negatív nyomómagasságok, tenziók tartományában is megegyezik a hézagtérfogattal. 
Ez a tartomány finom szemcsés képződményeknél nagyobb, durva szemcsés anya-
goknál gyakorlatilag nem létezik. Azt a ψa tenzió-értéket, ahol a térfogati víztartalom 
csökkenni kezd levegő-belépési nyomómagasságnak, a pa nyomásszintet levegő-be-
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lépési vagy másképpen buborék nyomásnak nevezik. A térfogati víztartalomhoz ha-
sonlóan a szivárgási tényezők negatív nyomómagasság függésének is hiszterézise 
van. A ψ≥ψa tartományban k=k0, ahol k0 a telített közeg szivárgási tényezője. Mivel 
a k szivárgási tényező a ψ nyomómagasság függvénye és ugyanakkor a Θ térfogati 
víztartalom is függvénye a ψ nyomómagasságnak, ebből következik hogy a szivár-
gási tényező egyben a térfogati víztartalom, illetve a telítettségnek is a függvénye, 
azaz a szivárgási tényező növekszik a telítettséggel (5. ábra:b) Telítetlen közegben a 
víz mozgását az ábrán látható karakterisztikus görbék, azaz a k=k(ψ) és a Θ=Θ(ψ) 
görbék határozzák meg, ezért ezeket a telítetlen közegben végbemenő vízmozgás 
karakterisztikus görbéinek is szokták nevezni. A karakterisztikus görbe meredeksége 
a telítetlen közeg tárolási jellemzője, amit c fajlagos talajnedvesség kapacitásnak 
neveznek:  

ψd
d

c
Θ

= .          (4.8.) 

 
4. ábra 

A talajvíz állapota a felszín közelében  
(FREEZE – CHERRY, 1979) 



15 

 
5. ábra 

A telítetlen közegbeli vízmozgás karakterisztikus görbéi 
(FREEZE – CHERRY, 1979) 

 

Tekintettel arra, hogy a karakterisztikus görbe nem lineáris és hiszterézise is van, 
ugyanez mondható el a fajlagos talajnedvesség-kapacitásról is. Amennyiben a nyo-
mómagasság nagyobb, mint ψa, akkor c=0, azaz további víz nem tárolódik, mert a 
közeg telítetté vált. 
A karakterisztikus görbék alakja a porózus közeg szemnagyságától jellegzetesen 
függ. A 6. ábra néhány képződmény összehasonlító karakterisztikus görbéit mutatja 
be a hiszterézist figyelmen kívül hagyva.  
A Darcy- törvényt telítetlen közegre vonatkozóan az alábbi formában írhatjuk fel: 

( ) hkv ∇⋅−= ψ          (4.9.) 

A szivárgás alapegyenletének szokásos formája telítetlen közeg esetére: 

( ) ( ) ( )
tz

h
k

zy
h

k
yx

h
k

x ∂
∂

=







∂
∂

∂
∂

+







∂
∂

∂
∂

+







∂
∂

∂
∂ Θ

ψψψ .   (4.10.) 
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6. ábra 

Homok (a), iszapos homok (b) és iszapos agyag (c) jellemző karakterisztikus görbéje 
(FREEZE – CHERRY, 1979) 

 

A (4.10.) egyenletet olyan formára is szokás hozni, hogy a független változó a Θ tér-
fogati víztartalom helyett a ψ nyomómagasság, ehhez vegyük figyelembe, hogy a 
térfogati víztartalom időbeli változása a nyomómagasság változásán keresztül megy 

végbe, azaz 
tt ∂

∂⋅
∂
∂=

∂
∂ ψ

ψ
ΘΘ

, majd használjuk a c fajlagos talajnedvesség-kapacitás 

definícióját, valamint, hogy h=z+ψ: 

( ) ( ) ( ) ( )
t

c
z

k
zy

k
yx

k
x ∂

∂
=














 +

∂
∂

∂
∂

+







∂
∂

∂
∂

+







∂
∂

∂
∂ ψ

ψ
ψ

ψ
ψ

ψ
ψ

ψ 1 . (4.11.) 

 

A (4.11.) egyenlet a talajfizikában igen gyakran használt Richards-egyenlet amely 
meghatározza a ψ  nyomómagasságokat a telítetlen áramlási tér bármely pontjában 
egy adott időpontban. A megoldás a k=k( ψ ) és a C=C( ψ ) vagy Θ=Θ( ψ ) karakte-
risztikus görbék ismeretét kívánja meg. 

4.2. A szivárgás alapegyenletének megoldási módjai 

A szivárgás alapegyenletét mind analitikus, mind numerikus úton meg lehet oldani. 
Az analitikus megoldásokat az egyenlet integrálással való megoldásával kapjuk meg. 
Az integrálás csak néhány esetben és kizárólag úgy oldható meg, ha néhány közeg-
jellemzőt vagy egyéb paramétert a teljes rendszerben állandónak tekintünk és ki-
használjuk a megoldandó probléma speciális tulajdonságait, pl. hengerszimmetriáját 
vagy végtelen hosszúnak tételezzük fel a vizsgált létesítményt. Az analitikus megol-
dás eredménye matematikailag általában egzakt, ritkább esetben közelítő, pl. sorba 
fejtéses megoldás. Az analitikus megoldások jellemzője, hogy az eredményt egy exp-
licit összefüggéssel meghatározható. 
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A numerikus megoldások ezzel szemben matematikai szempontból közelítő megol-
dások. Lehetővé teszik, hogy a képződmény jellemzők tér és időbeli változásait fi-
gyelembe vegyük a megoldásoknál. Általános alakú létesítmények környezetében 
határozhatók a nyomásszintek, illetve a szivárgás sebességvektorának komponensei. 
A numerikus megoldások általában egy egyenlet-rendszer vagy mátrix-egyenlet ite-
ratív megoldására vezetik vissza a vizsgált problémát. A megoldás nemcsak közelítő, 
hanem numerikus hibákkal is terhelt. A szivárgás alapegyenletének legismertebb 
numerikus megoldásai a véges differencia módszerrel és a végeselem módszerrel 
való megoldás, melyeket a következőkben részletesen bemutatunk. 

4.2.1. Analitikus megoldások 
 
Zárt tükrű rendszerben, álló víz esetén , permanens vagy más néven stacionér áram-
lási helyzetben a (4.1.) Laplace egyenletet használhatjuk a nyomásszintek változásá-
nak meghatározására.  
Egy végtelen hosszú galéria esetén (7. ábra) a galériára merőleges irányú x tengely 
mentén a változásokat (tekintettel arra, hogy a nyomásszintek nem változnak y és z 

irányban, azaz 0=
∂
∂

y
h

 és 0=
∂
∂

z
h

) az alábbi egyenlet írja le: 

02

2

=
dx

hd
. (4.12.) 

Integrálva: 

1K
dx
dh

= , (4.13.) 

majd tovább integrálva: 

21 KxKh += , (4.14.) 

 
7. ábra 

Zárt tükrű galéria számítási ábrája 
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azaz a piezometrikus szintek zárttükrű galériánál a galériától mért távolság függvé-
nyében lineárisan változnak, a szivárgás sebessége, ami a nyomásszintek első deri-
váltja (4.13.) állandó. 
Tekintettel arra, hogy a nyomásszint a galériában h0 a tápterület határán H, a megol-
dás két peremfeltétele h=h0 az x=0 helyen és h=H az x=R helyen, ahol R a galéria 
távolhatása, vagy a végtelennek tekintett utánpótlódási hely (pl. folyó) távolsága. 
Behelyettesítve a peremfeltételeket (4.14.) egyenletbe a K1 és K2 konstans értéke 
meghatározható: 

R
hH

KéshK 0
102

−
== , és ezért a (4.12.) egyenlet megoldása: 

0
0 hx

R
hHh +

−
= , (4.15.) 

a lamináris (Darcy-féle) szivárgási sebesség pedig (4.15.) első deriváltja, az I hidra-
ulikus gradiens és a szivárgási tényező szorzata, azaz  

R
hHk

dx
dhkkIv 0−

===  (4.16.) 

A végtelen galéria egységnyi hosszúságú szakaszán belépő hozam az m vastagságú 
réteget figyelembe véve az adott irányból: 

R
hH

mkmvqg
0−

==  (4.17.) 

Nyílt-tükrű, oldalról táplált galéria esetén (8. ábra) az áramlási keresztmetszet (ami 
zárttükrű esetben a rétegvastagság és a hosszúság-egységnyi vastagság szorzata) nem 
állandó, hanem h nyomásszint függvényében változik. 

 
8. ábra  

Nyílt tükrű galéria számítási ábrája 
(JUHÁSZ, 1981) 
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A galéria hosszúságegységre eső hozama: 

R
hH

k
dx
dhkhkIhhvqg 2

22
0

−
==⋅==  (4.18.) 

amiből a nyílt-tükrű galéria esetén a depressziógörbe egyenletére egy gyökös össze-
függést kapunk: 

0

2
hx

k
q

h g +=  (4.19.) 

A megoldás az áramtér Dupuit-Thiem-féle közelítésén alakul, vagyis hogy az 
ekvipotenciális vonalak függőlegesek, és az arra merőleges áramvonalak vízszinte-
sek. Ezen feltételezés mellett az áramvonalak egy-egy görbévé nem köthetők össze, 
hanem szakadásuk van. A valós áramlási helyzetben az áramkép a 9. ábra szerinti, 
azonban ebben az esetben az egyenlet integrálással nem oldható meg. 

 
9. ábra 

 Nyílt tükrű galéria közelében kialakuló áramvonalak 
(JUHÁSZ, 1981) 

 

Magányos kút esetén permanens állapotban a z irányú nyomásszint-változásokat ha-
nyagoljuk el, ekkor a (4.1.) Laplace egyenletet az alábbi alakban írhatjuk fel: 

02

2

2

2

=
∂
∂

+
∂
∂

y
h

x
h

, 





 =

∂
∂ 0

z
h

. (4.20.) 

Tekintettel a kút körül kialakuló depresszióstér hengerszimmetriájára a Laplace 
egyenlet polár-koordinátás alakjára térünk át: 

0
1

2

2

=
∂
∂

+
∂
∂

r
h

rr
h

. (4.21.) 

Integrálva: 
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rK
r
h

ln3=
∂
∂

, (4.22.) 

majd 

43 KrKh += ln , (4.23.) 

azaz a piezometrikus szintek a magányos kútnál az r sugárirányú távolság függvé-
nyében logaritmikusan változnak, a szivárgás sebessége, ami a nyomásszintek első 
deriváltja (4.22.) a sugárirányú távolsággal logaritmikus összefüggésben áll. 
Tekintettel arra, hogy a nyomásszint a kútban h0 a tápterület határán H, a megoldás 
két peremfeltétele h=h0 az r=0 helyen és h=H az r=R helyen, ahol R a kút távolha-
tása. Behelyettesítve a peremfeltételeket (4.23.) egyenletbe a K3 és K4 konstans ér-
téke meghatározható: 

434030 KRKHésKrKh +⋅=+⋅= lnln , (4.24.) 

amiből 

0

0

0
4

0

0
3 r

r
R
hHHKés

r
R
hHK ln

lnln

−
−=

−
= , (4.25.) 

azaz a (4.23.) egyenlet az alábbi formában írható fel: 

0

0

0

0

0 r

r
R
hHHr

r
R
hHh ln

ln
ln

ln

−
−+

−
= . (4.26.) 

A lamináris (Darcy-féle) szivárgási sebesség pedig (4.26.) első deriváltja, az I hidra-
ulikus gradiens és a szivárgási tényező szorzata, azaz  

r
r
R
hH

k
dr
dhkkIv 1

0

0

ln

−
=== . (4.27.) 

A nyomás alatti vízadót megcsapoló kútba (10. ábra) a hengerszimmetrikus áramlási 
térben a belépő hozamot a bármely r sugarú hengeren v sebességgel áthaladó víz 
mennyisége adja, ami zárttükrű rendszerben: 

0

022

r
R
hH

mkvmrAvQ
ln

−
=⋅== ππ  (4.28.) 

Nyílt-tükrű, oldalról táplált kút (11. ábra) esetén az áramlási keresztmetszet (ami 
zárttükrű esetben a hengerpalást felülete) az r sugárral változik a h nyomásszint 
függvényében változik, ezért a kút hozama: 
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10. ábra 

Zárt tükrű vízadóra telepített kút számítási ábrája 
(JUHÁSZ, 1981) 

 

 
11. ábra 

Nyílt tükrű vízadóra telepített kút számítási ábrája 
(JUHÁSZ, 1981) 

dr
dh

khrkIhrhvrQ πππ 222 =⋅==  (4.29.) 

A változókat szétválasztva: 

∫∫ =
H

h

R

r

hdh
Q

k
dr

r
00

21 π
 (4.30.) 

majd integrálva: 
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0

22
0

r
R
hH

kQ
ln

−
= π  (4.31.) 

Amennyiben az integrálást r és r0, valamint h és h0 határok között végezzük el, akkor 
megkapjuk a depressziógörbe egyenletét: 

2

0
0

h
r
r

k
Q

h += ln
π

 (4.32.) 

A megoldás ebben az esetben is az áramtér Dupuit-Thiem-féle közelítésén alakul, 
vagyis hogy az ekvipotenciális vonalak függőlegesek, és az arra merőleges áramvo-
nalak vízszintesek. Ezen feltételezés mellett az áramvonalak egy-egy görbévé nem 
köthetők össze, hanem szakadásuk van (12. ábra). 

 
valós áramkép 

 
Dupuit-Thiem-féle közelítés 

12. ábra 
Egy kút körül kialakuló valós és a számításokhoz használt közelítőleges áramkép 

(JUHÁSZ, 1981) 
 

Egy kút körül nem permanens esetben az időben változó depresszióstér számításához 
a (4.3.) egyenletből indulhatunk ki, melyet a hengerszimmetria miatt polár-koordi-
nátákkal felírva alkalmazunk: 
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
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 (4.33.) 

ahol 22 yxr += , ),( rthh = . 

vagy másképpen, felhasználva, hogy a s depresszió hHs −=  









∂
∂

∂
∂

=
∂
∂

r
sr

rrt
h

T
S 1

 (4.34.) 

Ha a kút üzemelése t=0 időpontban kezdődött és Q=konstans hozammal folyik. Eb-
ben az esetben a kezdeti és peremfeltételek: 0=∞= ),( rts , 00 == ),( rts  és 

r
s

TrQ
∂
∂

= π2 , amennyiben t > 0. 

Megoldás az s depresszióra nézve )(),( uf
T
Qtrs =  helyettesítéssel lehetséges, ahol 

Tt
Sru
4

2

= , ekkor: 

∫
∞

− +−=
u

u K
u
dueKuf 65)( , (4.35.) 

a kezdeti és peremfeltételek behelyettesítésével: 

)(),( uF
T
Qrts

π4
=  (4.36.) 

ahol ∫
∞

−=
u

u

u
dueuF )( , és 

Tt
Sru
4

2

=  (Theis-féle megoldás). 

F(u) függvény sorba fejthető: 

−+−
⋅

+
⋅

−+−−= KK
!!

)ln(,)(
3322

57720
32 uuuuuF  (4.37.) 

Ha u kicsi (azaz a szivattyúzás kezdete óta eltelt t idő nagy, vagy a termelt kúthoz 
közel számítjuk a depressziót, azaz a r sugár kicsi): elegendő a sor első két tagjának 
figyelembe-vétele (Jacob-féle megoldás). Jacob szerint az elhanyagolás feltétele, 
hogy u<0,01 vagy F(u)>4,0. Az F(u) függvényt Eiry függvénynek is nevezik és 
egyes szerzők Ei(u)-val jelölik. 
A Theis-Jacob-féle megoldás során a T transzmisszivitást állandónak tekintjük, ami 
implicit módon magában hordja a feltételezést, hogy vagy zárt tükrű, állandó vastag-
ságú és homogén szivárgási tényezőjű a vízadó, vagy amennyiben nyílt tükrű a réteg, 
akkor olyan nagy vastagságú, hogy az okozott s depresszió elhanyagolható hozzá 
képest és emiatt válik a transzmisszivitás állandóvá. 
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Amennyiben a zárttükrű vízadó felett egy b’ vastagságú, k’ szivárgási tényezőjű 
szemipermeabilis réteg és afelett egy felső vízadó réteg található, akkor az alsó víz-
adóban létesített depresszió hatására a féligáteresztő rétegen keresztül a kutat tápláló 
szivárgás indul meg. 
Ebben az esetben az alsó vízadó rétegre a szivárgás alapegyenlete: 

,

,

Tb
hk

r
h

rr
h
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h

T
S
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∂
∂
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Az egyenlet analitikus megoldását Hantush, majd egy könnyebben alkalmazható 
formában Walton adta meg: 
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vagy egyszerűbben 
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13. ábra 

Magyarázó ábra a Hantush-féle megoldáshoz 
 

A megoldás k’=0 esetén, azaz ha a „szemipermeabilis” réteg „vízzáró”, a Theis féle 
megoldást adja eredményül.  
Nyílttükrű rendszer esetére a Theis- és az azokból levezetett módszerek nem korrek-
tek, minthogy a számítások során feltétel a transzmisszivitás állandósága. Erre az 
esetre ismeretes Neuman megoldása, aki a depresszió idő függvényt az alábbi formá-
ban vezette le: 
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ahol H a telített vízoszlop magasság, Sy a fajlagos hozam, S a tárolási tényező, T a 
transzmisszivitás. 
Ugyancsak a Laplace egyenletből indult ki Tóth (1963), amikor egy függőleges szel-
vény mellett határozta meg a potenciál-eloszlást, aminek segítségével medencében 
kialakuló vízáramlási rendszerek vizsgálatát végezte el (14. ábra). 
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14. ábra 

A Tóth-féle medence-modell (Tóth, 1963) 
 

A vertikális metszetben a potenciál: 
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ahol z a medence vízzáró feküje felett mért magasság, g a nehézségi gyorsulás, p0 a 
légköri nyomás, p a nyomás a rendszer bármely pontjában és ρ a víz sűrűsége. 
Amennyiben a víztükör szintje egy olyan speciális piezometrikus szintet jelent, ahol 
definíciószerűen a gravitációs potenciál maximális és ahol a nyomás megegyezik a 
légköri nyomással, akkor az egyenlet egyszerűsödik: 
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tgz=Ψ , (4.45.) 

ahol zt víztükör topográfiai magassága a rendszer bármely pontján. Mivel a terepi 
mérések mutatják, hogy a talajvíztükör helyzete lokálisan követi a domborzatot, ezért 
a zt magasságot tekintsük három tag: z0, z1 és z2 összegeként. 
z0 legyen állandó és jelentse a medence mélypontjának a magasságát a vízzáró fekü 
felett, z1 legyen a medence-felszín átlagos emelkedésének mértékével azonos és z2 a 
medencefelszín magasság-eltérésének mértéke az egyenletesen emelkedő felszíntől. 
z2 tényezőt tételezzük fel szinuszosan változónak, ennek alapján legyen: 
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aztgxz =⋅= 21 , (4.46.) 

ahol x a medence mélypontjától mért távolság, a a sinushullám amplitúdója, b=2π/λ 
a frekvenciája és λ a periódusa. A víztükör magasságát a három tag összegeként kap-
juk: 
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atgxzzt +⋅+= 0  (4.47.) 

Bevezetve a következő jelöléseket: c’=tgα, a’=a/cosα, b’=b/cosα zt a következő egy-
szerűbb formába írható fel: 

xbaxczzt 'sin'' +⋅+= 0 . (4.48.) 

Ezek alapján a potenciál: 

( )xbaxczg 'sin'' +⋅+= 0Ψ  (4.49.) 

Mivel a medencében a vízmennyiség állandó, ezért permanens állapot van, azaz a 
vízmozgást az aktualizált Laplace egyenlet (4.1.) írja le: 
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A megoldás peremfeltételei: 
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A megoldás általános alakja: 
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( ) ( )( ) ( ) ( )( )kxNkxMekxBkxAe kzkz sincossincos ⋅+⋅+⋅+⋅= −Ψ , (4.52.) 

ahol Az A, B, M és N konstansok a peremfeltételekből számíthatók. 
A potenciálra ezután a következő végeredményt kapjuk: 
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A kapott képlettel a potenciál számítható az x,z  síkon és a Darcy- törvény felhasz-
nálásával bármely irányban mozgó folyadékhozamok számítását is el lehet végezni: 

Ψgradj ⋅−= ρσ , (4.54.) 

ahol σ=kρ/η és η a folyadék kinematikai viszkozitása. 

4.2.2. Numerikus megoldások 
A numerikus megoldások a szivárgás alapegyenletének közelítő megoldásai. A köze-
lítő megoldást matematikai értelemben kell érteni, azaz hogy a megoldás nem eg-
zakt. Ha a megoldás közelítő, akkor hibákkal terhelt, amelyeket numerikus hibáknak 
hívunk.  
A numerikus megoldások úgy közelítik a valós folyamatokat, hogy mind időben, mind 
térben szakaszolják a lezajló folyamatokat. Az egyes szakaszokon belül a számítás-
hoz szükséges paramétereket állandónak tekintik, és ezzel válik lehetővé a megoldás.  
A térbeli szakaszolás alatt a numerikus módszerek alkalmazásánál az elemekre bon-
tást értjük. A vizsgált térrészt olyan elemekre bontjuk melyeken belül az egyes kö-
zegjellemzők (pl. szivárgási tényező, transzmisszivitás, szabad hézagtérfogat, táro-
lási tényező, stb.) állandónak tekinthető.  
Az időbeli szakaszolást időlépcsőkre bontással oldjuk meg. Az időben történő válto-
zásokat olyan egységekre bontjuk, melyek alatt az időben változó tényezők (pl. a 
kutak hozama) állandónak, ritkább esetben lineárisan változónak tekinthetők.  
Mind az elemek, mind az időlépcsők száma elvileg korlátlan, így a szakaszolás mind 
térben, mind időben tetszőleges. Minél több elemre vagy időlépcsőre bontjuk a vizs-
gált folyamatot, annál pontosabban tudjuk a tér-, illetve időbeli változásokat követni. 
Tudni kell azonban, hogy a tér és időbeli szakaszolás növelésével egyes numerikus 
hibák is nőnek és a probléma számításigénye is exponenciálisan növekszik. Éppen 
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ezért a feladat tér- és időbeli szakaszolásának van egy optimuma, ahol a numerikus 
módszerrel közelített probléma már megfelelő mértékben követi a valós folyamato-
kat az időben és a térben, ugyanakkor a számítási igénye és különösképpen a nume-
rikus hibák nagysága még elhanyagolható.  
A víz porózus közegbeli szivárgásának jellemzőit a következő numerikus módsze-
rekkel lehet vizsgálni: 
- véges differencia módszer 
- véges elem módszer 
- peremelem módszer 
- analitikus elemek módszere 
A felsoroltak közül most röviden a leginkább elterjedt véges differencia és 
végeselem módszereket mutatjuk be. 

4.2.2.1. Véges differencia-módszer 
A véges differencia módszer alapgondolata a szivárgás alapegyenletének, mely egy 
parciális differenciál-egyenlet, differencia egyenletté történő alakítása. A számítási 
eljárás alkalmazásának jellegzetes lépései: 
- A modellezett teret tetszőleges számú síkban tetszőleges darabszámú, de azonos 

eloszlású, egymással hézagmentesen érintkező, téglatest alakú elemekre bontjuk, 
egyenletes vagy változó osztású rácsháló segítségével (15. ábra). 

- A szivárgás alapegyenletét (a differenciál-egyenletet) differencia-egyenletté ala-
kítjuk. 

- Meghatározzuk az egyes hasábelemek és az azokkal közvetlenül érintkező ele-
mek közötti vízhozamokat a Darcy-törvény és a kontinuitási tétel felhasználásá-
val, 

- Meghatározzuk az egyes kutak, galériák, és egyéb létesítmények (pl. szivárgók) 
által az egyes elemekbe táplált vagy onnan kivett hozamokat, valamint a rendszer 
vízmérlegét befolyásoló egyéb objektumok (pl. felszíni vizek és vízadók kommu-
nikációjából eredő hozamok) vízmérlegre gyakorolt hatását. 

- Összegezzük minden egyes elemre a vízmérleg-elemeit. A hiányzó elemek pótlá-
sára a modell szélein peremfeltételeket alkalmazunk. Felírva az összes elemre a 
vízmérleg elemeket, felállítjuk a modellezett tér vízforgalmát az adott időlépcső-
ben leíró lineáris egyenletrendszert, majd numerikus iteratív eljárásokkal meg-
oldjuk. 

- Az egyes elemekre felírt vízmérleg aktívum vagy passzívum, azaz az elemben 
tárolt vízkészlet növekedés vagy csökkenés alapján meghatározzuk az elemben 
bekövetkező vízszint (nyílt tükrű rendszer) vagy nyomásszint (zárt tükrű rend-
szer) változásokat. 

- Nem permanens rendszerben a következő időlépcsőre ismét felírjuk a Darcy-
törvényen alapuló, elemek közötti vízhozamokat és a számítás fázisait – a szük-
ség szerinti időlépcsőkre – megismételjük. 

A módszerrel abszolút nyomásszinteket nem tudunk számítani, csak a nyomásszintek 
változásait, éppen ezért szükséges a számításhoz egy kiindulási állapot, egy alap-
helyzet, amit számítás kezdeti feltételének nevezünk. A szivárgás alapegyenletének 
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megoldásához szükséges kezdeti feltétel egy tetszőleges, de ismert kezdeti időpont-
ban a nyugalmi nyomásszint-eloszlás. 
A leírtak alapján kirajzolódnak a módszer előnyei és hátrányai: 

 
15. ábra 

Négy rétegből álló rendszer véges differencia elemekre bontása 
(CHIANG és KINZELBACH, 1999) 

 
A módszer használatának legnagyobb előnye, hogy a megoldás során a differenciál-
operátort differenciaoperátorral helyettesítjük és így a megoldás során megmarad az 
eredeti differenciálegyenlet-összefüggés. Ennek következtében a számítás részered-
ményei valós fizikai tartalommal bírnak, ami a számítás folyamatának követését elő-
segíti. Az egyes hasábelemekre felírt vízmérleg-elemek időbeli változása jól követ-
hető, ezért a módszer nagyon szemléletes. Előny továbbá a többé-kevésbé szabályos 
elemkiosztás miatt a modell alapadat-rendszere részben függvényeket és 
geostatisztikai módszerek használatával generálható, ami - tekintettel az alapadat-
rendszer méretére – számottevő gyakorlati könnyebbség.  
Sajnos az ilyen téglalap alapú hasábokkal a modellezett térben az egymástól eltérő 
vízföldtani tulajdonságokkal rendelkező és ezért a modellben egymástól elhatáro-
landó térbeli testek csak nehezen követhetőek. További hátrány, hogy a rendelkezésre 
álló földtani és vízföldtani információk többnyire pontszerűek (fúrási helyek, mag-
minták vizsgálati eredményei), a modellben azonban az egyes elemekre jellemző 
értékek szerepelnek. Minthogy a háló nem követheti a fúrási hálózatot, gyakran elő-
fordulnak olyan elemek, amelyekre vonatkozóan csak közvetett információkkal ren-
delkezünk, esetleg teljesen információhiányos térrészek is lehetnek.  
A kapott eredmények az egyes elemekre jellemző átlagértékek lesznek, ezért csak 
megfelelően nagy sűrűségű háló esetén lehetnek az eredmények megfelelően repre-
zentatívak. 
A háló lokálisan nem, vagy csak speciális technika alkalmazásával sűríthető, ami a 
modellalkotás és feldolgozás során számos kellemetlen következményhez vezethet. 
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4.2.2.1.1. A differenciálegyenlet differenciaegyenletekké történő alakításának mód-
jai 

Mint azt a véges differencia módszer rövid bevezetőjében már említettük, a módszer 
alapgondolata a differenciáloperátor differenciaoperátorral való helyettesítése, azaz 
a differenciálegyenletek differenciaegyenletekké történő alakítása. A térbeli differen-
ciálhányadosok differenciahányadosokká alakítása formálisan a differenciáloperátor 
differenciaoperátorra cserélésével történik, azaz  
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Az időbeli differenciaképzésnek ugyanakkor van egy sajátossága, amely a modell-
számítások numerikus hibáinak előfordulását alapvetően meghatározza. Tételezzük 
fel, hogy a h nyomásszintek az időben a 16. ábra szerint alakulnak. Az átlagérték 
teoréma alapján tudjuk, hogy a h=h(t) függvény időszerinti deriváltját kiszámíthatjuk 
egy a [t, t+∆t] időintervallumon belül található ε időpillanatban, az időintervallum 
két végpontjában észlelt h(t) és h(t+∆t) értékek alapján. Sajnos az ε időpillanat helyét 
a [t, t+∆t] időintervallumon belül nem ismerjük, ezért különböző feltételezésekkel 
élhetünk, melyek alapján az időbeli differenciaképzés különböző módszerei alakul-
tak ki. 

 
16. ábra 

Az időbeli differenciaképzés magyarázó ábrája 
(ISTOK, 1989) 

 

A 16. ábra alapján a h(ε) nyomásszintet a h(t) alaphelyzetből az alábbi összefüggés-
sel kapjuk: 
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Definiáljunk egy 
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ω  változót. Az ω változó segítségével (4.56.) differenciál-

egyenlet az alábbi differencia-egyenletté alakítható: 
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( ) ( ) ( ) ( )tththh ∆+⋅+⋅−= ωωε 1 .      (4.57.) 
A (4.57.) egyenletben amennyiben ω=0, azaz az ε időpontot a [t, t+∆t] időinterval-
lum kezdetén tételezzük fel, akkor előrelépéses differenciákról (Forward Difference 
Method), beszélünk. Amennyiben ω=1, azaz az ε időpontot a [t, t+∆t] időintervallum 
végén tételezzük fel, akkor hátralépéses differenciákat alkalmazunk (Backward 
Difference Method). Amennyiben az ε időpontot a [t, t+∆t] időintervallum közepén 
tételezzük fel, akkor ω=0,5, ezt központi vagy középponti differenciák (Central 
Difference Method) alkalmazásának nevezzük. Szokás a középponti differenciák 
alkalmazását Crank-Nicholson módszernek is hívni. 
A differenciaképzés módja befolyásolja a numerikus hibák előfordulását, ezért szük-
séges ismeretük. A három felsorolt approximációs eljárás közül a középponti diffe-
renciák alkalmazása a leggyakoribb, mivel ebben az esetben a legkisebb a közelítés 
átlagos hibája az első-differenciálhányados képzése esetén, ezért az ilyen megoldá-
sok általában gyorsabbak. A középponti differenciákkal történő megoldás hátránya 
az oszcillatív hibákra való hajlamosság. Az előre- és hátralépéses differenciákkal 
való számolás esetén viszont nagyobbak a hibák, ami miatt gyakoribb a számítási sor 
divergenciája, ugyanakkor nem jelentkezik numerikus oszcilláció a megoldás során. 
A numerikus hibákat a későbbiek során részletesen bemutatjuk. 
A differenciaképzés módja csak a számítási metodikát befolyásolja, nincs köze ah-
hoz, hogy a számítás során egy ismert állapotból korábbi vagy későbbi állapotra, az-
az időben előre vagy hátra történik a számítás. 

4.2.2.1.2. A szivárgás alapegyenletének felírása véges differenciák segítségével (az 
egyes cellák vízmérlege) 

Tekintsünk egy véges differencia elemet, legyen az elem sorszáma 0 és a környező 
elemeket számozzuk 1-től 4-ig. (17. ábra) Tételezzük fel, hogy a szomszédos elemek 
felől a vizsgált elem felé Qi hozamok szivárognak, a vizsgált elemből a források vagy 
nyelők által kitermelt vagy betáplált vízmennyiség Q0. A vízmérleg megváltozása ∆t 

idő alatt ∑
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⋅∆
4

0i
iQt . Ez a vízmérleg változás indukálja a h0 nyomásszint meg-

változását a 0 jelű elemben, azaz  

( ) yxSthtthQQQQQt ∆∆⋅⋅−∆+=++++∆ )()()( 00403020100 ,   (4.58.) 
ahol t a kezdeti időpont és S a tárolási tényező vagy a Darcy- törvényt felhasználva: 
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, (4.59.) 

ahol Ti0 a kiszemelt és a szomszédos elem transzmisszivitásai alapján számított mér-
tékadó transzmisszivitás értéke. 
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17. ábra 

A véges differencia módszer vizsgált eleme 
(KINZELBACH, 1986) 

 

A (4.59.) egyenleten belül a Ti0 átlagérték meghatározására különböző módszerek 
terjedtek el. Lehet a sorba kötött ellenállások elvének figyelembevételével meghatá-
rozott átlagos transzmisszivitásokat 
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de szokták az egyszerű számtani átlagot 
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vagy a mértani átlagképzést használni: 
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Az egyes átlagképzésekkel végzett számítások között megfelelő hálóképzés esetén 
általában nincsen nagy különbség, ugyanis a jól megtervezett rácsháló esetén a 
szomszédos elemek méretei csak kis mértékben különböznek egymástól, nincsenek 
túlságosan nagy méretbeli ugrások. A lényegi különbség a (4.62.) egyenlet szerinti 
mértani átlagképzés és a két másik bemutatott módszer között van, mert az a vízzáró 
peremre eső cellaoldalon zérus hozamokat számít (18. ábra), mert a szorzat egyik 
tagja: T1=0. A bemutatott egyéb átlagképzési megoldások esetén a számított T10 egy 
pozitív szám (T1<T10<T0). Éppen ezért azon programok, amelyek nem a mértani át-
lagszámításon alapuló transzmisszivitási átlagképzést használnak egy további para-
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métert használnak a vízszivárgás engedélyezésére. Ennek alapján aktív és inaktív 
cellákat kell definiálni, melyek közül az inaktív cellákba/ból definíciószerűen víz se 
nem lép be, se nem lép ki. 

 
18. ábra 

A vízzáró határ esete 
(KINZELBACH, 1986) 

 

A felszíni vizekből átadott járulékos készletek számítását a véges differencia mód-
szernél egy egyszerűsítő feltételezéssel végezzük el. Tételezzük fel, hogy a felszíni 
víz a talajvízadóval hidrodinamikai kapcsolatban, kommunikációban áll. A felszíni 
víz szintje hr, a meder fenékszintje br. A valós és a modellezett helyzetet a 19. ábra 
mutatja be.  

 
19. ábra 

Felszíni vizekből átadott vízhozamok számítása 
(KINZELBACH, 1986) 

 

A folyót tehát olyan cellákkal szimuláljuk, melyeknek az oldala a folyó fenékszintjé-
nek mélységéig vízzáró, azaz a kommunikáció a mederfenék-üledékeken keresztül 
csak függőleges történik. Tételezzük fel, hogy a folyómedernél d vastagságú kk szi-
várgási tényezőjű kolmatált zóna alakult ki. A felszíni és felszín alatti vizek között 
kialakuló kommunikációból származó Qf hozam arányos az ábra szerinti hr-h nyo-
másszintkülönbséggel a folyó és a vízadó között, a kk kolmatált zóna szivárgási té-
nyezővel, a cella méretével és fordítottan arányos a kolmatált zóna d vastagságával, 
azaz: 
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( ) yxhh
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Q r
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f ∆∆⋅−= .        (4.63.) 

A képletben szereplő 
d
kk [T-1] hányadost átszivárgási tényezőnek nevezik. Az átszi-

várgási tényező a kommunikáció mértékének jelzőszáma. Amennyiben a felszíni víz 
csak az elem egy kisebb részét fedi le akkor a Qf hozam arányosan csökkentendő.  
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∆∆⋅−= .    (4.64.) 

ahol Ffolyó, a folyó medre által a cellából lefedett terület nagysága. A Qf hozam füg-
gően a folyó hr vízszintje és a vízadó h nyomásszintjének egymáshoz viszonyított 
nagyságától pozitív vagy negatív, azaz a folyó táplálja vagy megcsapolja a vízadót. 
A folyó szimulációs elvén nyugszik a drének vagy más néven szivárgók szimulációja. 
A drének abban különböznek a folyóktól, hogy csak a vízadó megcsapolására képe-
sek. A megcsapolt hozam függ a vízadó nyomásszintjének és a drén fenékszintjének 
különbségétől, valamint attól, hogy mekkora a drén környezetében a szivárgási té-
nyező, azaz, hogy milyen könnyen tud a víz a szivárgóba jutni. A drén által megcsa-
polt Qd vízhozamot az alábbi képlettel számíthatjuk: 

( ) dddd hhhahhCQ ≥−−=       (4.65.) 
ahol h a vízadó nyomásszintje, hd a szivárgó fenékszintje vagy a vízszint a drénben 
és Cd az a szivárgó vezetőképessége. A Cd szivárgó vezetőképesség a kd ekvivalens 
szivárgási tényező, amely figyelembe veszi az összes nyomásveszteséget a vízadó és 
drén között és a drén elemen belüli L hosszának szorzata: 

LkC dd ⋅= .          (4.66.) 
Tekintettel arra, hogy a kd ekvivalens szivárgási tényező általában ismeretlen, ezért 
azt szivárgó ismert hozama alapján szokás inverz úton meghatározni. A (4.65.) 
egyenletben a negatív előjel azt jelzi, hogy a kivett hozam a vízadó szempontjából 
negatív. Amennyiben a vízadóban a nyomásszint a drén fenékszintje alatt van, akkor 
a szivárgó szárazra kerül, nem működik, ekkor Qd=0.  
Az egyes elemekhez hozzárendelendők a termelő és injektáló kutak Qkút hozamai. 
Amennyiben egy elembe több kút esne, akkor ezeket összegezve kell a vízmérlegbe 
helyettesíteni. Mivel a vizsgálat a vízadóra vonatkozik a negatív kúthozamok a ter-
melő kutakat, a pozitívak az injektáló kutakat jelentik. 
A maradó beszivárgásból származó hozamokat a cellák alapterületével szorozva tud-
juk a számításokban figyelembe venni: 

yxBQB ∆∆= ,         (4.67.) 
ahol B az adott mélységben elhelyezkedő talajvízszintig időegység alatt leszivárgó 
csapadékvíz mennyisége egységnyi felületen [L/T]. 
A teljes vízmérleget az egyes cellákra a következőképpen írhatjuk fel: 
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A (4.68.) egyenlet bal oldalán található hozamok előjeles összege adja a vizsgált 
elemben tárolandó vízmennyiség megváltozását, ami zárt tükrű vízadó esetén a nyo-
másszintek változásával, nyílt tükrű vízadó esetén a vízszint emelkedésével követke-
zik be (20. ábra) Az egyenlet jobb oldala ezt a nyomás- illetve vízszintnövekedést 
írja le. Amennyiben a számítást permanens esetre végezzük el, akkor a (4.68.) egyen-
let jobb oldala zérus. 
 

 
20. ábra 

A tárolási mechanizmus nyílt tükrű rendszer esetén 
(KINZELBACH, 1986) 

4.2.2.1.3. A teljes modellezett tér vízmérlege 
Eddig az egyes elemekre határoztuk meg a vízmérleget. Ahhoz, hogy a teljes vízadó-
ban lejátszódó folyamatok számítani tudjuk a rendszer valamennyi elemére fel kell 
írni a vízmérleget. Ezáltal az ismeretlenek száma nem növekszik, mert az egyes ele-
mek között átadott hozamok azonos nagyságúak, tehát a 17. ábra szerinti Q10=-Q01. 
Ennek következtében ahány elem van a rendszerben, annyi vízmérleget lehet felírni. 
Ahhoz, hogy az egyenletrendszer megoldható legyen maximálisan annyi lehet az 
ismeretlenek száma, mint a felírható egyenleteké. Ha jobban szemügyre vesszük a 
(4.68.) egyenletet, akkor minden vízmérlegben csupán a h(t) nyomásszint ismeretlen, 
azaz az egyenletrendszer megoldható. A megoldáshoz azonban szükségesek a kez-
deti és peremfeltételek. 

4.2.2.1.4. Kezdeti és peremfeltételek 
A számítás kezdeti feltételeire, azaz egy kiindulási állapotra azért van szükség, mert a 
vázolt számítási rendszer csak tárolt vízmennyiség, azaz víz és nyomásszint-változá-
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sokat tud számítani. Ahhoz, hogy a nyomásszinteket abszolút értékben is megadhas-
suk van szükség a nyomásszinteknek egy kezdeti időpontban való eloszlásának isme-
retére. 
Peremfeltételekre a számításba bevont térrész szélein van szükség. Ahhoz, hogy a 
számítást el lehessen végezni, minden egyes elemre fel kell írni a vízmérleget. Te-
kintettel arra, hogy a rendszer szélén található elemeknél valamelyik (sarokelemnél 
valamelyik szomszédos kettő) 17. ábra szerinti Qi hozamot nem ismerjük, ezért a 
vízmérleg határozatlanná válik. Az említett határozatlanság megszüntetése érdeké-
ben peremfeltételeket használunk, melyeknek számos megvalósítási módja, típusa 
ismert.  
A peremfeltételek három csoportba sorolhatók a Dirichlet, Neumann és a féligát-
eresztő (vegyes) típusba. 
Dirichlet-típusú peremfeltétel a peremi helyzetű cellában nem a vízmérleget módo-
sító hozamot vesz figyelembe, hanem a cella vízforgalmát a cella előírt nyomás-
szintjén keresztül szabályozza. A nyomásszint lehet időben állandó vagy előírt mó-
don változó. 
Az időben állandó nyomásszintet kétféleképpen lehet megvalósítani: egyrészt szokás 
a vízmérleget a hagyományos módon számítani, majd minden időlépcső elején 
h(t+∆t)=h(t) helyettesítéssel a kezdeti nyomásszintek értékeit újrafelhasználni. Egyes 
programok az állandó nyomásszintű határt a tárolási tényezőn keresztül hozzák létre. 
A tárolási tényező az egységnyi nyomásszint-változás hatására felszabaduló vagy 
tárolódó vízmennyiséget jelenti. Amennyiben kicsi vízszintváltozások hatására tet-
szőlegesen nagy vízmennyiséget szabadítunk fel elérhetjük, hogy bármekkora víz-
mérleg-változást a tárolási tényezőn keresztül kompenzálni tudunk. A rendszer visel-
kedését úgy is magyarázhatjuk, hogy az elemben végtelen nagyságú vízmennyiséget 
tárolunk el, amiből egy tetszőleges mennyiséget eltárolva vagy eltávolítva az adott 
cellában a vízszint vagy a nyomásszint nem változhat meg. 
Az időben előírt módon változó nyomásszinteket elsősorban a talajvízjárás vagy fo-
lyó vízszintváltozások szimulációjára szokás használni. Általában a feltételezés sze-
rint az előírt nyomásszint az időlépcső kezdetén h(t) a végén (azaz a következő idő-
lépcső kezdetén) h(t+∆t) és a két időpont között egyenletesen változik, azaz egy a [t, 
t+∆t] időponton belüli t+ti időpillanatban az éppen aktuális nyomásszint 
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A Dirichlet típusú határ hátránya, hogy depresszió a peremen nem alakulhat, ki, en-
nek következtében a peremhez közeli vízkivételi helyek körül irreális áramlási sebes-
ségtér alakul ki. Előnye az ilyen típusú határoknak, hogy a modellt stabillá teszik, a 
megoldás során fellépő divergencia lehetőségét lecsökkentik. 
A Neumann-típusú peremfeltételen a vízmérleget egy adott, állandó hozammal korri-
gáljuk. A Neumann típusú határ két alapesete a vízzáró és a nem vízzáró határ. 
A vízzáró határ esetén a perem felől érkező Qi hozamot zérusnak adjuk meg. Másik 
megvalósítási lehetőség a peremen túl egy fiktív cella felvétele, melynek szivárgási 
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tényezője és/vagy transzmisszivitása zérus. Ebben az esetben a mértani átlaggal szá-
mított eredő transzmisszivitással a vízzáró határ – a korábbiakban bemutatott módon 
– automatikusan megvalósul. 
Amennyiben a határ nem vízzáró, akkor egy tetszőleges pozitív vagy negatív ho-
zammal módosítható a peremi helyzetű cella vízmérlege. A megoldás hibája, hogy 
függetlenül az aktuális vízföldtani helyzettől a meghatározott vízmennyiséggel a 
vízmérleg módosul, és amennyiben ez tartósan több, mint amennyi szükséges volna, 
akkor a nyomás- vagy vízszintek folyamatosan emelkedni, ellenkező esetben csök-
kenni fognak. Ez azt is okozhatja, hogy a vizsgált elem kiszárad. Bármelyik irányban 
is tér el a megadott hozam a valóságostól a rendszer instabilitását okozza. 
Féligáteresztő típusú a perem, ha a cellák vízmérlegének módosulása, azaz a peremi 
hozam időben nem állandó, hanem az aktuális hidrodinamikai helyzettől függő nagy-
ságú. Az ilyen peremek egyesítik a Dirichlet és a Neumann típusú peremek előnyeit. 
Legismertebb képviselője az ún. általános nyomásszintű határ, amit angol nevének 
rövidítéséből GHB (General Head Boundary)-peremnek is hívnak. A GHB peremen 
van egy előírt vagy mértékadó hm nyomásszint, melyet a határon a megközelítőleg 
tartani szándékozunk. A peremi cellában - a szomszédos elemekkel való vízforgalom 
következtében - azonban változna a vízmérleg és ennek következtében a nyomás- 
vagy vízszint ∆h értékkel változna. A változás korrekciójára a GHB peremen a ∆h 
értékkel arányos vízmennyiséget táplálunk be.  

)( mGHBGHB hhCQ −= ,        (4.70.) 
ahol QGHB a peremi hozam, CGHB az arányossági tényező és h és hm az aktuális és a 
mértékadó víz- vagy nyomásszint.  
Mettől nagyobb a vízszintváltozás igény, annál nagyobb a peremen átjutó hozam, 
ami azt eredményezi, hogy az abszolút nyomásszintek egy adott szinten állandósul-
nak, azaz a peremen egy adott – a mértékadó vízszinthez képest számított - depresz-
szió alakulhat ki. A perem stabilitása és a kialakuló depresszió nagysága a CGHB ará-
nyossági tényező nagyságától függ. Amennyiben az arányossági tényező nagy, akkor 
a GHB cella állandó nyomásszintű peremként viselkedik és tartja a mértékadó víz-
szintet. Ha az arányossági tényező tart a zérushoz, egyre inkább egy Neumann típusú 
határ valósul meg, a vízzáró határ.  

4.2.2.1.5. A vízmérleg egyenletrendszer megoldási módjai 
Amennyiben a (4.68.) egyenlet szerinti ti időpillanatot a [t,t+∆t] időintervallum ele-
jén vesszük fel, akkor t=ti és ebben az esetben a vízmérleg- egyenlet explicit módon 
is megoldható, azaz az ismeretlen hi(t) nyomásszintek, kifejezhetők az egyenletekből. 
Ennek a megoldásnak a legnagyobb problémája az instabilitás. Kimutatható, hogy a 
megoldás instabil mindaddig, míg nem teljesül a minden egyes elemre a következő 
stabilitási kritérium: 
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A stabilitási kritérium azt fejezi ki, hogy az időlépcső alatt bekövetkező nyomás-
szint-változás sosem lehet nagyobb, mint az elemek között az időlépcső elején fenn-
állt nyomásszint-különbség. Sajnos a kritérium következtében a gyakorlatban hasz-
nált rácshálók esetén a ∆t időlépcsőt nagyon le kell csökkenteni, ami egyrészt a szá-
mítási időigényének növekedésével, másrészt a kerekítési hibák növekedésével jár. 
Az implicit megoldások közül a közvetlen vagy direkt megoldás a legstabilabb meg-
oldási módszer. Ebben az esetben a (4.68.) egyenlet szerinti ti időpillanatot a [t,t+∆t] 
időintervallum végén vesszük fel, akkor ti= t+∆t. A megoldási módszert az alkalma-
zott matematikával foglalkozó szakkönyvek részletesen ismertetik. A megoldási 
módszer lényege, hogy az elemeket sorszámokkal látjuk el, majd egy az összes elem 
darabszámával megegyező sor-és oszlopszámú mátrixegyenletet írunk fel. Ebben a 
mátrixban csak a főátlóban és soronként néhány cellában található zérustól eltérő 
érték. Amelyik érték nem zérus: az a vizsgált sorhoz tartozó elem és a környező ele-
mek közötti vízforgalomból adódó hozamokból adódik. A főátlóban tárolt szám pe-
dig az adott sorszámú elemben a vízmérleg változásból következik. A mátrix egyen-
letet valamilyen numerikus módszerrel, általában a Gauss-Jordan eliminációval old-
juk meg. 
A direkt megoldó algoritmusok hátránya a nagy és elemeket alig tartalmazó mátrix-
egyenlet-rendszer miatti memória-igény. Főként 3D megoldások esetén keletkeznek, 
akkora egyenletrendszerek, hogy azokkal a számítógép nem képes megbirkózni. 
Az implicit megoldások egy következő lehetősége az iteratív megoldás. Ezek a meg-
oldások számottevően kisebb memóriát igényelnek, sőt ún. relaxációs paraméterek-
kel tovább is gyorsíthatók. Sajnos az előnyökkel szemben a kisebb stabilitás áll. 
Az iteratív megoldásoknál az alapgondolat az, hogy amennyiben a (4.68.) egyenlet-
ben a ti= t+∆t feltételezéssel élünk, akkor minden egyes elemben a h(t+∆t) nyomás-
szint meghatározható lenne a szomszédos elemekben ismert h(t+∆t) nyomásszintek 
ismeretében. Tekintettel arra, hogy azokat nem ismerjük, ezért ha azokat egy-egy 
felvett értékkel helyettesítjük be, akkor iteratív úton kaphatjuk meg a megoldást. 
Ilyen módon a rendszer valamennyi elemére számítjuk a megoldás első közelítését, 
majd ezeket felhasználva a következő közelítést és így tovább. Ezt a módszert hívják 
a Jacobi-féle iterációnak. Erről a módszerről kimutatható, hogy az mindig konver-
gens a szivárgás alapegyenletéből származó lineáris egyenletrendszerek esetén. 
A Jacobi-iteráció tovább fejleszthető ezáltal gyorsítható. Amennyiben az iteráció so-
rán a következő elemre végzett számítások során az előzőleg számított közelítéseket 
is felhasználjuk, akkor a konvergencia gyorsabb. Ezt a megoldást Gauss-Seidel mód-
szernek hívják. Az iteráció gyorsítására relaxációs paraméter használatát vezették 
be. Az iteráció során a ∆h nyomásszint változás: 

hhh régiúj ∆+= .         (4.72.) 
Amennyiben a konvergenciát gyorsítani kívánjuk akkor az iteráció során a következő 
közelítő értéket így is meghatározhatjuk, hogy: 

hRhh régiúj ∆⋅+= ,         (4.73.) 
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ahol 1<R<2 a relaxációs paraméter. Amennyiben R értékét túl nagyra választjuk, úgy 
az iteráció során divergenciát, kedvezőbb esetben oszcillációt okozhatunk. Ha a 
megoldás relaxációs paraméter nélkül is oszcillál, úgy szükség lehet R<1 relaxációs 
tényezők használatára az iteráció során. 
Változó irányú implicit megoldás (IADI = Iterative Alternating Direction Implicit 
procedure) valójában a felsorolt korábbi módszerek együttes alkalmazása. Ebben az 
esetben is a a ti= t+∆t feltételezéssel élünk. A nyomásszintekre vonatkozóan egy mát-
rixegyenlet-rendszert írunk fel. Tudjuk, hogy a szomszédos elemekben ismerve a 
nyomásszinteket, a választott elemben is meghatározható volna a nyomásszint. Ezért 
felveszünk kezdeti értékeket és megkezdjük az iterációt (Jacobi-módszer). Ahogy 
soronként haladunk végzett számítások során az előzőleg számított közelítéseket is 
felhasználjuk (Gauss-Seidel módszer). Amikor a soronként elvégeztük a mátrix ele-
mek első közelítésének meghatározását áttérünk az oszloponkénti számításokra. Itt is 
felhasználjuk a korábban kiszámított közelítő értékeket a Gauss-Seidel módszer sze-
rint. Amikor az összes oszloppal is végeztünk, újrakezdjük a számítást, de soronként 
alulról felfelé, majd ha ezzel is végeztünk, akkor oszloponként, de jobbról balra szá-
mítjuk a következő iterált értékeket. Ezzel egy iterációs ciklus lezárult, és ha a kon-
vergencia még nem következett be, akkor a mátrix bal felső elemével újra kezdjük 
soronként a számítást. Az IADI iteráció feltétlenül stabil, ezért alkalmazása nagyon 
előnyös.  
A bemutatott eljárások a leggyakrabban használt módszerek a hidrodinamikai mo-
dellezés terén. 

4.2.2.2. Végeselem-módszer 
A szennyezőanyag-terjedés alapegyenletének végeselem módszerrel történő megol-
dása, hasonlóan a véges differencia módszerhez, ugyancsak megköveteli a modelle-
zett tér tetszőleges számú csomópontra és az azokat összekötő vonalak által határolt 
elemekre történő felosztását. Míg azonban a véges differencia módszer megköveteli 
a rácsháló alkalmazását, addig a végeselem módszer elvileg lehetővé teszi a tarto-
mány tetszőleges alakú elemekre való felbontását (21. ábra). Mindez egyben azt is 
jelenti, hogy az elemkiosztást a rendelkezésre álló információkhoz sokkal inkább 
hozzá lehet igazítani, mint azt a véges differencia módszernél láttuk. A továbbiakban 
a végeselem módszert – tekintettel arra, hogy a PMWIN környezet a véges differen-
cia-megoldást használja - csak röviden mutatjuk be. 

4.2.2.2.1.1. A végeselem módszer alapgondolata 
A végeselem módszer alapgondolata a lokális approximáció (lokális közelítés) elve, 
ami azt jelenti, hogy az egyes, felvett elemek mentén a keresett mezőt vagy mezőket 
előre felvett paramétereket tartalmazó függvényekkel közelítjük. (Esetünkben nyo-
másszint, szivárgási sebesség vagy koncentrációmezők vizsgálatát végezzük el.) A 
lokálisan felvett approximációs függvényeket azután a szomszédos elemek közös ha-
tárai mentén valamilyen hibaelv alapján illesztjük, így végül a teljes vizsgált tarto-
mányra állítunk elő egy megfelelő rendben folytonos approximációs mezőt. A hiba-
elv alkalmazása - konkrét matematikai átalakításokon keresztül egy lineáris vagy - 
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nem lineáris peremfeladat esetén - egy növekményes formátumú egyenletrendszer-
hez vezet, amelynek megoldása a korábban említett eredményeket szolgáltatja. 

 
21. ábra 

Egy szennyeződés modellezésénél használt végeselem-háló 
(VOGT, 1993.) 

Az említett alapelv a hidrodinamikai és transzportmodellezésnél a következőképpen 
valósul meg. Az elemek a végeselem-módszer esetén nem oldalaikon, hanem az 
elemek csomópontjaikon keresztül illeszkednek egymáshoz. Ennek megfelelően az 
elemek vízmérlege helyett a csomópontok vízmérlegét írjuk fel és nem az elemek 
átlagos nyomásszintjeit, hanem a csomóponti nyomásszinteket számítjuk. A térbeli 
folytonosság azáltal valósul meg, hogy egy adott csomópontban a potenciál értéké-
nek egyformának kell lennie függetlenül attól, hogy melyik - a csomóponthoz tartozó 
- elem felől közelítjük is meg. A kezdeti feltételek egy t0 időpontbeli csomóponti po-
tenciálértékek és a peremfeltételeket is a csomópontokban adjuk meg. Mivel va-
lamennyi csomópontra felírható a vízmérleg, ezért a csomópontok számának megfe-
lelő számú egyenletrendszer megoldását kell elvégeznünk, minek eredményeképpen 
valamennyi csomópontra meghatározzuk egy ∆t idő elteltével kialakuló potenciálér-
téket. 

4.2.2.2.1.2.  A hálókiosztás elvei 
A végeselem-háló egy-, két- és háromdimenziós elemekből épülhet fel, a megoldandó 
feladattól függően. Néhány gyakoribb elem-alakot a 22. ábra mutat be. Leggyakrab-
ban az egydimenziós vonal és a kétdimenziós háromszög, illetve négyszög elemeket 
alkalmazzák. Térbeli feladatok megoldása esetén tetraéder, háromszög alapú oszlop 
vagy téglatest alakú elemek kialakítása a szokásos. Az egyes elemek alakja, nagysága 
még azonos rendszeren belül is tetszőleges lehet, egyazon modellen belül többfajta 
elemet is alkalmazhatunk. Természetesen az elemek számának növekedése az egyen-
letrendszert alkotó egyenletek és ennek megfelelően az ismeretlenek számának nö-
vekedésével jár együtt, ami könnyen meghaladhatja a számítógép erőforrásai által 
alkotott határt. 
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22. ábra 

A végeselem módszernél alkalmazott gyakoribb elemtípusok  
(ISTOK, 1989.) 

 

Az elem- és csomópont-kijelölés néhány általános szabálya: 

− A durvább hálóosztás pontatlanabb eredményekhez vezet, mint a finom, ezért 
törekedni kell arra, hogy a számítógép nyújtotta korlátokon belül, az alapadat-
rendszer sajátosságainak figyelembevételével egy megfelelően részletes hálót 
alakítsunk ki.  

− A csomópontokat egyfelől a vízkivételek és betáplálások helyén, a modellezett 
tér határain és minden olyan pontban célszerű elhelyezni, ahová a későbbiek so-
rán számítási eredményeket kívánunk kapni. 

− Azokon a területeken, ahol nagyobbak a koncentráció-, illetve áramlási sebesség 
(hidraulikus gradiens)-változások, célszerű finomabb osztást, míg a további te-
rületeken lazább hálót felvenni. 

− A különböző anyagi tulajdonságokkal jellemzett területek határán úgy célszerű 
az elemek alakját megválasztani, hogy a határvonal az elemek oldalai mentén 
húzódjék. Az anyagi tulajdonságok egy-egy elemen belül állandóak, elemenként 
azonban különbözőek lehetnek. 

− Az elemtípusok közül célszerű a legegyszerűbbet kiválasztani, azok közül, ame-
lyek az adott probléma megoldásához megfelelnek.  

− Az elemek nem lehetnek egymással átfedésben, a teljes modellezett teret ki kell 
tölteniük anélkül, hogy közöttük bármilyen űr maradna. 

− Kerülni kell az erősen anizometrikus elemek alkalmazását, különösen a nem-per-
manens változások szimulációja esetén. Célszerű a finomabb osztásból a laza há-
ló felé való fokozatos átmenetet kialakítani. 

− Az adott probléma esetleges szimmetriáját jól megválasztott peremfeltételekkel célszerű 
kihasználni, így az elemek száma csökkenthető. 
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4.2.2.2.1.3. Végeselem módszer síkszivárgás vizsgálatára permanens esetben 
A végeselem módszert célszerűen síkszivárgási feladatokra mutatjuk be. Ennek leg-
főbb oka, hogy a hidrodinamikai modellezésben használt 3D megoldások is általában 
2D rétegek sorozatával dolgoznak, követve a rétegzett víztározók rendszerét. Terje-
delmi korlátok miatt itt csak a permanens állapotra vonatkozó, könnyebben érthető 
megoldást mutatjuk be KINZELBACH (1986) és ISTOK (1989) nyomán. 
A vízadó legyen izotróp és nyomás alatti vizet tároló. Először bontsuk az áramlási 
teret szabálytalan, a modellezett tér határait jól követő háromszög alapú hasábele-
mekre. A háromszög alapú elemek csomópontjait lokálisan 1,2,3 sorszámokkal látjuk 
el. Az alkalmazott háló csomópontokból (N db) és elemekből (M db) áll, azaz a cso-
mópontok globális számozása 1, 2, 3, 4,…, N. 
Vegyünk egy háromszög alapú elemet, melynek csomópontjai 1, 2, 3; koordinátái 
rendre (x1,y1), (x2,y2), (x3,y3); és a csomópontokban a nyomásszintek h1, h2, h3 (23. 
ábra). Legyen a nyomásszint elemen belüli meghatározására alkalmas interpolációs 
függvény egy sík: 

cybxayxh ++=),(
^

.        (4.74.) 

 
23. ábra 

A vizsgált elem az interpolációs függvénnyel 
(KINZELBACH, 1986.)  

Behelyettesítve a csomópontok koordinátáit: 

111 cybxayxh ++=),( , 

222 cybxayxh ++=),( ,        (4.75.) 

333 cybxayxh ++=),( . 

Ezek az egyenletek megoldhatóak a, b, c-re: 
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ahol F az 1,2,3 csomópontok által határolt terület. Bevezetve az alábbi jelöléseket: 

32321 xyyxA −= ,  13132 xyyxA −= ,  12123 xyyxA −= , 

321 yyB −= ,  132 yyB −= ,  213 yyB −= ,        (4.77.) 

231 xxC −= ,  312 xxC −= ,  123 xxC −= , 

és behelyettesítve a (8.39.) egyenletbe: 

( ) ( ) ( )
D
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      (4.78.) 

ahol D a determináns. Alkalmazva Darcy törvényét síkszivárgási esetre, és feltéte-
lezve, hogy a ks síkszivárgás szivárgási tényezője az elemen belül állandó: 
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Tehát a vx és vy sebességvektor-komponensek az elemen belüli (x, y) helyzettől 
függetlenül állandóak. (Ez abból következik, hogy az interpolációs függvény sík). A 
(4.78.) egyenlet az adott elemen keresztül szivárgó víz mennyiségét határozta meg. 
Ez a vízmennyiség az áramlási sebességvektor irányától (az interpolációs sík dőlés-
irányától) függően lép be és ki a háromszög alapú hasábelem oldalain. Az oldalfa-
laknál fellépő hozamokat jelöljük így: Qs1,Qs2,Qs3 (24. ábra). Mivel az interpolációs 
sík dőlésiránya és szöge a szomszédos elemekben természetszerűleg nem lehet azo-
nos, ezért a vízmérleg az elemek oldalai mellett sérül (az egyik elemből az adott ol-
dalfalon keresztül kilépő vízmennyiség nem pontosan egyenlő a szomszédos elem 
érintkező falán belépő vízmennyiséggel). A kontinuitást - ha az egyes oldalfalak 
mentén nem lehet biztosítani – legalább az egyes elemek szintjén meg kell valósítani, 
ehhez pedig az oldalfalak mentén fellépő hozamokat a csomópontokhoz kell rendel-
nünk. 
Vezessük be a Wi csomóponti áramlás fogalmát, úgy, hogy az egyes csomópontok-
hoz hozzárendeljük a szomszédos oldalakon átáramló hozamok felét. A kontinuitás 
törvénye miatt az elemre igaz kell, hogy legyen: 

222
123

1
sss QQQ

W −=+= , 
222

213
2

sss QQQ
W −=+= , 

222
321

3
sss QQQ

W −=+= .  (4.81.) 
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24. ábra 

Csomóponti hozamok értelmezése 
(KINZELBACH, 1986.) 

 

A Qsi hozamok meghatározhatóak, mint a v sebességvektor az adott oldalra merőle-
ges komponensének, az m vízadó telített vastagságának és az adott elemoldal hosz-
szának szorzatai: 
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Behelyettesítve a (4.81) egyenletbe a vx és vy szivárgási sebességeket ((4.79.) és 
(4.80.)), Qsi hozamokat ((4.82.)), valamint felhasználva, hogy mkT s= : 

∑
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jjii hEW , , ahol 

( )
D

CCBBT
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=, , i=1,2,3 és j=1,2,3.  (4.83.) 

A (4.83.) egyenlet azt jelenti, hogy a csomóponti hozamok a csomópontokban érvé-
nyes ismeretlen nyomásszintek lineáris függvényei. Eddig csak egyetlen elemmel 
foglalkoztunk, azaz a lokális approximációt alkalmaztuk, most kiterjesztjük az isme-
reteket a teljes modellezett térrészre. A lokális (elemi) jelölésrendszer kiterjesztését a 
globális rendszerre az incidencia-mátrix segítségével végezzük el. Az incidencia-
mátrix mutatja meg a csomópont globális k sorszámát az elem e sorszáma és a cso-
mópont i sorszáma függvényében (k=k(e, i)), ahol e=1, 2, …, M és i=1, 2, 3. 
Az összes csomóponthoz rendelt adatot az incidencia-mátrixban tárolt k sorszámnak 
megfelelően átnevezzük (xk, yk, hk és Wk) ahol k = k(e,i), ahol i = 1, 2, 3 és e = 1, 2, 
…, M: 
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i WWhhyyxx ⇒⇒⇒⇒ ;;; ,    (4.84.) 

ahol a felső index az elemi (lokális) vagy globális jelölésrendszert jelenti és i = 1, 2, 
3, illetve k = 1, …, N. 
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A (4.77.) szerinti A, B és C vektort is átalakítjuk a csomópontok N darabszámának 
megfelelő vektorra, ahol az összes komponens - három kivételével - zérus. A (4.83.) 
szerinti, 3x3 elemből álló, lokális E mátrixot a globális NxN elemű globális E mát-
rixszá alakítjuk, amelynek 9 elem kivételével minden eleme zérus.  
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ahol a felső index az elemi (lokális) vagy globális jelölésrendszert jelenti, és i és j = 
1, 2, 3, illetve k és l = 1, 2, …, N. 
A (4.83.) elemre vonatkozó egyenletet most írjuk fel a globális mátrixok segítségé-
vel: 
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A Wk értékek zérust adnak az összes olyan k sorszámú csomópontra, amelyik nem 
tartozik az adott elemhez. Most írjuk fel a kontinuitást az összes csomópontra. A 
kontinuitás miatt az összes Wk csomóponti hozam és a csomópontnál kitermelt Q 
hozamok előjeles összege zérus, azaz 
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ahol k=1, 2, …, N, és ahol Qk az elemben lévő külső (piezometrikus nyomástól füg-
getlen) források és nyelők összes hozama. A (4.87.) összefüggés egy N darab egyen-
letből álló egyenlet-rendszer, ahol az N db ismeretlen az N db csomópontbeli hk 
nyomásszint. 
A (4.86.) egyenletet a (4.87.) egyenletbe illesztve az N csomópontú és M elemből 
álló hálóra kapjuk: 
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illetve általános alakban 
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Az egyenletet minden elemre felírva N darab N ismeretlenes egyenletből álló egyen-
letrendszert kapunk, amit a véges differencia módszer megoldásánál ismertetett, ite-
ratív matematikai módszerrel megoldunk. 

4.2.2.2.1.4. Peremfeltételek megadása 
A peremfeltételek elsősorban Neumann- és Dirichlet-típusúak lehetnek. A vízzáró 
határ (Neumann-típus) szimulációjakor azokat a peremi helyzetű csomópontokat, 
ahol nincs áramlás, egyszerűen belső helyzetűnek kell tekinteni. Az áramlás hiányát 
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automatikusan figyelembe vesszük azzal, hogy a határ túlsó oldalán az elemek hiá-
nyoznak. Az adott, állandó hozamú perem esetén a Qk értékbe javasolt a hozamot 
beszámítani (az áramlás az elem falán keresztül történik, a határon beáramló hozam a 
két szomszédos csomópontnál fele-fele arányban számítandó be) (25. ábra). Az ál-
landó piezometrikus nyomásszintű határ (Dirichlet-típus) esetén a határon fekvő 
csomópontoknál a hk = konstans szintet helyettesítjük be a (4.87.) egyenlet adott 
csomópontra való felírásakor. 

 
25. ábra 

Peremi hozamok csomópontokhoz rendelése 
(KINZELBACH, 1986.) 

 

Amennyiben a területen megoszló terhelésként jelentkező hozamokat (pl. maradó 
beszivárgás) is a rendszerbe illeszteni kívánunk, akkor ezeket a hozamokat is a cso-
mópontokhoz kell rendelni (26. ábra). 

 
26. ábra 

Megoszló terhelések csomópontokhoz rendelése 
(KINZELBACH, 1986.) 

 

4.2.2.3. A numerikus megoldások jellemző hibái 
A numerikus megoldások hibákkal terheltek. A numerikus megoldás alapgondolatá-
ból ered az a triviális hiba, hogy a numerikus megoldás matematikai szempontból 
közelítő: Amennyiben pl. iteratív módszert használunk, akkor a közelítés mértékét mi 
magunk határozzuk meg, azáltal, hogy megadjuk azt az értéket, melynél kisebb elté-
réseket találva az utolsó és az azt megelőző iteráció eredménye között, akkor az ite-
rációt eredményesnek tekintjük, azaz az utolsó iteráció során kapott eredményt a 
megoldásnak tekintjük. Ezt az értéket konvergencia kritériumnak szokták nevezni.  
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Ahhoz, hogy a számítás során az iteratív megoldás eredményes legyen, két feltétel-
nek kell teljesülnie: egyrészt a megoldás hibájának a konvergencia kritériumnál ki-
sebbnek kell lennie, másrészt az iterációk számának az általunk engedélyezett maxi-
mális iterációszámnál kisebbnek kell lennie. 
A konvergencia kritérium mértékegysége mindig a vizsgált mennyiség mértékegy-
sége, azaz a hidrodinamikai modellezés során hosszúság dimenziójú, minthogy a víz- 
vagy nyomásszinteket pl. mBf. egységben számítjuk. Mettől kisebb a konvergencia 
kritériumban meghatározott érték, a valóságot annál jobban követő megoldást ka-
punk.  
Bár a konvergencia kritériumot magunk választjuk meg, mégis szükséges a követke-
zőket figyelembe venni. A konvergencia kritérium által meghatározott maximális 
nyomásszint-hibák a kialakuló hidraulikus gradiensben is hibát okoz. A gradiensben 
okozott hiba – egyenletesen megoszló nyomásszint-hibát feltételezve – ott lesz a leg-
nagyobb, ahol a legkisebb elemek vannak, mivel a gradiens 

y
hIvagy

x
hI

∆
∆

=
∆
∆

=  pl. véges differencia módszernél. A gradiensben elkövetett 

hibát a szivárgási keresztmetszettel szorozva kapjuk a vízmérlegben elkövetett hibát, 
ennek alapján, ahol nagyobb az elem ∆x és ∆y oldalhosszának és a vízadó telített 
vastagságának szorzata, ott kell a közelítésből fakadó hibáknak a legnagyobbaknak 
lenniük. Ezek a hibatényezők részben egymás ellen hatnak, ugyanakkor mindig vi-
gyázni kell arra, hogy a vízmérleg-hiba elméleti maximuma mindig elhanyagolható-
an kicsi legyen a rendszerből az egyes források és nyelők által kitermelt vagy eltávo-
lított vízmennyiséghez képest. Éppen ezért javasolt a konvergencia-kritériumot úgy 
megválasztani, hogy a legkedvezőtlenebb esetekben sem lehessen a vízmérleg-hiba 
nagyobb, mint az egyes elemekből kitermelt minimális vízmennyiség 1%-a. Ez a 
hiba az esetek legnagyobb részében még megengedhető, egyes speciális esetektől 
eltekintve.  
Az iteratív megoldás során van lehetőség az iterációk maximális számának megadá-
sára is. Amennyiben a megoldás konvergens, csak lassan közelít a valós megoldás-
hoz, akkor az iterációk lehetséges számának növelésével konvergencia kritériumnak 
megfelelő megoldáshoz juthatunk. Azonban arra figyelemmel kell lenni, hogy álta-
lában a reális adatrendszereknél végzett iteratív számítások gyorsan konvergálnak, 
míg azok a rendszerek, melyeken belül belső ellentmondások vannak, azok igen las-
san. Éppen ezért nem célszerű az iterációk maximális számát egy határon túl növelni, 
mert a kapható megoldás szakmailag helytelen lesz. Ezzel az eszközzel inkább a mo-
dellezés kezdeti szakaszán élünk, amikor tudjuk, hogy az adatrendszer még nem kel-
lően kiforrott, ugyanakkor a kapott szakmailag megkérdőjelezhető megoldás alapján 
szeretnénk visszakövetkeztetni arra, hogy hol keresendő a hiba. Természetszerűleg 
az iterációk számának emelésével a kerekítési hiba nem növekszik, tehát ilyen szem-
pontból a hosszú iterálás és a rövid iteráció után kapott eredmények elvileg egyenér-
tékűek. 
A továbbiakban a módszerből eredő hibákat tudomásul vesszük,, ezeket nem tekint-
jük többé hibáknak, azaz a konvergens megoldást numerikus szempontból helyesnek 
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tekintjük. A megoldás azonban nem feltétlenül konvergens, két numerikus hiba lép-
het fel: a divergencia, azaz instabilitás és az oszcilláció. 
A megoldás instabilitásán azt értjük, hogy a közelítő megoldás a valódi megoldáshoz 
nem konvergál (27. ábra). Az instabilitás jelensége elsősorban explicit megoldási 
módok esetén jelentkezik, azonban az elemszám növekedésével, elsősorban három-
dimenziós numerikus modellek és/vagy implicit megoldó rutinok használata esetén is 
előfordul. Az instabilitás egyik speciális esete a numerikus oszcilláció, amikor a 
számítások eredményei nem képesek a hibahatáron belül közelíteni a valós megol-
dást. A numerikus hibák csökkentésére vonatkozó gyakorlati lehetőségeket a gya-
korlati hidrodinamikai és transzportmodellezés című fejezetben foglaljuk össze. 
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27. ábra 
A numerikus instabilitás és a numerikus oszcilláció jelensége 

4.2.2.4. Az analitikus elemek módszere (Analitic Element Method, AEM) 
Az analitikus elemek módszerét STRACK fejlesztette ki a ’80-as évek elején. A kez-
detben kevésbé népszerű megoldás mára egyre ismertebbé válik, és mind a tudomá-
nyos, mind a kereskedelmi szoftverek terén terjed. Az analitikus elemek módszerét 
itt csak röviden ismertetjük részletes leírását STRACK és HAITJEMA (1981) és 
STRACK (1989) tartalmazza.  
Az analitikus elemek módszerét eredetileg 2D problémák vizsgálatára fejlesztették 
ki, de később rétegzett rendszerek leírására is alkalmassá tették. Az analitikus mód-
szerek alkalmazásánál feltételezzük, hogy a víz szivárgása uralkodóan vízszintes 
irányban történik a vertikális sebességkomponenseket, és a kőzet szivárgással szem-
beni ellenállását függőleges irányban ezért elhanyagolhatjuk (DUPUIT-
FORCHEIMER közelítés). Amennyiben 3D megoldásról van szó, akkor ott ilyen 2D 
rendszerek sorozatára történik a számítás.  
Az analitikus elemek módszerének alapgondolata analitikus összefüggések szuperpo-
zíciója, azaz ezáltal a különböző termelőlétesítmények depressziós terének szuperpo-
zíciója. Valamennyi alkalmazott analitikus függvény kielégíti a Poisson- vagy a Lap-
lace-egyenletet. Egy-egy analitikus összefüggés egy-egy elemtípust jelképez. Ilyen 
analitikus elem-típusokat fejlesztettek ki az azonos homogén talajvíz-áramlásra, csa-
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padék beszivárgásra, folyó, patakok, tavak szimulációjára. A rendszerbe speciális 
elemekkel akár résfalak, repedések szivárgók stb. is beilleszthetők. 
Az alapgondolat értelmében nincs szükség a vizsgált tér rácshálóval vagy egyéb mó-
don történő elemekre bontására, a diszkretizálásra. Ebben a rendszerben csak a fel-
színi vizeket szimbolizáló elemek esetén történik a diszkretizálás, azaz szakaszokra 
bontás, azonban az összes ilyen szakasz, mely egy folyó vagy tó egy-egy részletét je-
lenti, zárt alakú analitikus összefüggéssel szerepel a rendszerben, ezeket hívjuk ana-
litikus elemeknek. Egy komplex, regionális felszín alatti szivárgási rendszer szimulá-
cióját így néhány száz analitikus elem hatásának összegzésére vezetjük vissza. 
Az analitikus megoldások szuperpozícióját hagyományosan csak homogén, állandó 
transzmisszivitással jellemezhető vízadókra lehetett alkalmazni. A felszín alatti víz-
áramlási problémák speciális kezelése megfelelően a megválasztott víztermelési po-
tenciálok segítségével lehetővé tette, hogy zárt és nyílt tükrű, valamint inhomogén 
vízadókban történő folyamatok szimulációját is. Az egyes jelenségek szimulációjára 
olyan analitikus elemeket választunk, amelyek a legjobban reprezentálják az adott 
jelenséget, pl. tavak határai vagy patakok vonalmenti forrásként vagy nyelőként, kis 
tavak mocsarak területi forrásként szerepelnek a rendszerben. A rendszer a forráso-
kat negatív nyelőkkel szimulálja. A nem teljes hidrodinamikai kommunikációval 
jellemezhető tavak vagy patakokat olyan vonalmenti vagy területi források vagy nye-
lők szimbolizálják, melyek fenékellenállással rendelkeznek. A vízadó vastagsági és 
hidrodinamikai (szivárgási tényező) diszkontinuitásai kettősrétegekkel szimulál-
hatók.  
A módszer alkalmazása során néhány pontban illesztjük a modellt a valósághoz. 
Ezeket ellenőrző pontoknak hívjuk. Az ellenőrző pontok darabszámának meg kell 
egyeznie az összes ismeretlen számával a vizsgált területen, így válik a rendszer ha-
tározottá. Az ellenőrző pontok az analitikus elemek módszerének peremfeltételei. 
Az analitikus elemek módszere is csak közelítő végeredményt ad. Az eredmény 
azonban matematikai szempontból teljesen analitikus, az eredményt iteráció nélkül 
kapjuk, a szivárgási sebességet pedig a kapott nyomásszintek deriválásával számít-
hatjuk. 
Az analitikus elemek módszerének a legnagyobb előnye az úgynevezett lépésenkénti 
modellezés lehetősége, ami annyit jelent, hogy először egy gyengébben feltárt terü-
leten kevesebb elemmel végezzük el a gyors számításokat, majd ahogyan egyre is-
mertebbé válik a terület, újabb és újabb elemeket illeszthetünk tetszőleges számban a 
rendszerbe. Nincs az ismeretek növekedése miatt a háló sűrítésére szükség, ugyanaz 
a rendszer szolgálhat akár eltérő problémák vizsgálatára. 
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5. A szennyezőanyagok terjedésének törvényszerűségei porózus kö-
zegben 

5.1. A transzport-folyamatok és a transzportegyenlet 

A vízben oldható szennyezőanyagok terjedését két alapvető folyamat határozza meg: 
egyfelől az advekció (konvekció), amely a fizikailag vagy kémiailag oldott anyagok 
pórusokban való tömeges áramlását; másfelől a diszperzió, amely a szennyezőanyag 
térbeli szóródását jelenti. (28. ábra) 

 
28. ábra 

A transzportfolyamatok jellegzetes elemei 
(KINZELBACH, 1986) 
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A szóródást kémiai illetve fizikai folyamatok okozhatják. Eredete részben a diffúzi-
óra, amely a különböző koncentrációjú oldatok között a részecskéknek a koncentrá-
ció-különbség kiegyenlítődéséig tartó mozgása, részben a szivárgási sebesség lokális 
eltérései következtében kialakuló mechanikai diszperzióra vezethető vissza. A két 
alapvető folyamaton kívül további fizikai és kémiai folyamatok az oldat áramlásának 
késleltetéséhez, valamint a szennyezőanyag lebomlásához, degradációjához vezet-
hetnek (TAMÁS et. al. 2002). 

5.1.1. A kémiai anyagmérleg 
Tekintsük a porózus közeg egy elemi kockáját x, y, z koordinátarendszerben úgy, 
hogy annak oldalai merőlegesek a koordináta tengelyekre. Legyenek a térbeli szeny-
nyezőanyag-áramot leíró fluxus-vektor komponensei Fx, Fy és Fz. A kémiai anyag-
mérleget figyelembe véve az elemi kockában tárolt anyagmennyiség időbeli megvál-
tozásának egyenlőnek kell lennie az elemi kockába - időegység alatt - be- és kilépő 
fluxusok előjeles összegével. Az elemi kockában tárolt anyagmennyiség változása a 
belépő és kilépő fluxusok különbsége, azaz (29. ábra): 
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29. ábra 

Az elemi térrész szennyezőanyag-mérlege 

5.1.2. A transzportfolyamat elemei 
Porózus közegben a kémiai anyagáramlás fő komponensei az advektív anyagáramok, 
valamint a diffúzió és a mechanikai diszperzió következtében kialakuló anyagtransz-
port. Az oldott fázisban maradó anyag mennyiségét ezen felül még további folya-
matok, a felületi adszorpció és a kémiai vagy radioaktív bomlás befolyásolja. 
A valós anyagmérleget tovább módosíthatják a reverzibilis és irreverzibilis kémiai 
folyamatok következtében mobilizálódó vagy lekötődő anyagmennyiségek, amelye-
ket napjaink transzport-modelljei általában figyelmen kívül hagynak, mivel ezeknek 
a jelenségeknek a számításokkal való követése bonyolult és a hidraulikai esemé-
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nyekkel közvetlen kapcsolatban sincsenek. A kémiai folyamatok pontos követésére a 
nemzetközi szakirodalomban csupán néhány próbálkozás található, ezek elsősorban 
egydimenziós transzportmodellek, melyek homogén áramlási teret tételeznek fel. 

5.1.2.1. Az advektív (konvektív) anyagáramok 
Az oldott anyagok vízzel való együttes tömeges áramlását advekciónak , illetve a hő-
tanból kissé helytelenül átvéve konvekciónak nevezzük. (konvekció: hőmérsékleti 
különbségek hatására létrejövő mozgási folyamat; advekció: a potenciálos (és a hőt 
kizáró) erőtér által létrejött mozgási folyamat (MÁRKOS, 1987)). Az advektív 
szennyezőanyag-áram a közegbeli v átlagos áramlási sebesség és a C koncentráció 
szorzata, azaz: 

Cv
dxdydt
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FCv
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FCv
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F z
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ahol M a szennyezőanyag kémiai mennyisége és t az eltelt idő. 

5.1.2.2. A diffúzió 
A térbeli kémiai potenciál-különbségek hatására létrejövő tömegáramot, melyet a 
Fick I. törvénye ír le, diffúziónak nevezzük. A koncentráció-különbségek hatására 
létrejövő diffúziót közönséges diffúziónak (30. ábra), míg az elektromos potenciál- 
vagy hőmérséklet-különbségek okozta anyagáramokat kényszerdiffúziónak nevezzük 
(FILEP, 1988).  
Fick I.-törvény értelmében a diffúzió által szállított kémiai anyagfluxus három kom-
ponense - porózus közegben - az alábbi formában írható fel: 
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ahol Deff az effektív (vagy látszólagos) diffúzió-állandó, amelynek értéke porózus 
közegben kisebb, mint a D0 vizes közegben mért diffúzió-állandó. 

C=1 C=0 C=0C=1

átmeneti zóna

t = 0 t > 0
Koncentráció változása  

30. ábra 
A közönséges diffúzió folyamata 

(BEAR-VERRUIJT, 1987) 



53 

 

A vízben mért és a porózus közegbeli diffúzió-állandó közötti kapcsolatra számos 
empirikus összefüggést határoztak meg, melyeket az 5.1.táblázat mutat be.  

5.1. táblázat 
Az effektív diffúzió-állandó meghatározása néhány szerző szerint 

SHACKELFORD és DANIEL (1991) nyomán 

Képlet Szerző 

τ= /DD 0eff  GILLHAM et al.(1984), BARONE et. al.(1990) 

τα⋅= /DD 0eff  LI és GREGORY (1974) 

τΘ= /DD 0eff  BERNER (1971), DREVER (1982) 

ταγΘ= /DD 0eff  KEMPER et al.(1964), OLSEN és KEMPER (1968), NYE (1979) 

τγ= /DD 0eff  PORTER et al.(1960) 

ταΘ= /DD 0eff  van SCHAIK és KEMPER (1966) 

)K1(
1DD

d
0eff +τ
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FILEP (1988) FRIED és COMBARNOUS (1971) alapján 

F
1DDD 020eff ⋅=

τ
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A tárolómérnöki gyakorlatban alkalmazott formula, ahol F a formációs 
ellenállási tényező 

ahol: 
D0 a vizes oldatban mért diffúzió-állandó 
θ a víztartalom térfogat %-ban, a fázisos összetétel v jelzőszáma 
τ a tortuozitás (labirintus-faktor, tekervényesség)  
γ a negatív adszorpciós szorzótényező (≤1)  
α a viszkozitási faktor (≤1) 
Kd a megoszlási együttható 

Mint az látható, az effektív diffúzió-állandó egyenesen arányos a vizes oldatban mért 
diffúzió-álladóval és fordítottan a tortuozitással. A tortuozitás értéke porózus közeg-
ben általában 1,25 és 5 között változik a szemcseméret-eloszás és a szemcsék érint-
kezésének módja függvényében. Tömény oldatok, valamint viszkózus anyagok ese-
tén az adszorpció mértékét meghatározó negatív adszorpciós tényező, valamint a 
viszkozitási faktor tovább csökkenti az effektív diffúzió-állandó értékét. A diffúzió 
állandónak a bemutatott táblázat szerinti számítása a felsorolt paraméterek meghatá-
rozási bizonytalanságai miatt nehézkes, ezért az effektív diffúzió állandót laboratóri-
umi kísérletek segítségével szokás meghatározni. 

A D0 értékét néhány ion híg vizes oldatára vonatkozóan, 25 °C hőmérsékleten, az 
5.2. táblázat foglalja össze. Tekintettel arra, hogy a vizes oldatra vonatkozó diffúzió 
állandók kémiai kézikönyvekből kikereshetők, már egy komponensre meghatározva 
az effektív diffúzió állandót, az összes többi komponensre jó közelítéssel megkap-
hatjuk az effektív diffúzió állandót: 
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5.2. táblázat 
Néhány ion vizes oldatban mért diffúzió-állandója 25 °C-on 
QUIGLEY és szerzőtársai (1987) LERMAN (1979) nyomán 

Kation D0 (x 10
-10

 m
2
/s) Anion D0 (x 10

-10
 m

2
/s) 

H 93,1 OH 52,7 
Li 10,3 Cl 20,3 
Na 13,3 HS 17,3 

K 19,6 SO4 10,7 

NH
4
 19,8 NO2 19,1 

Mg 7,05 NO3 19,0 

Ca 7,93 HCO3 11,8 

Mn 6,88 CO3 9,55 

Fe 7,19 PO4 6,12 

Cu 7,33 CrO4 11,2 

Zn 7,15   
Cd 7,17   
Pb 9,45   

 
A diffúzió-állandó szigorú értelemben véve nem tekinthető állandónak, mivel értéke 
kis mértékben függ a koncentrációtól (SHAW, 1986) és erősen függ a hőmérséklettől 
is. Egyes laboratóriumi vizsgálatok szerint értéke 5°C-on akár felére is csökkenhet a 
25 °C-on mért értékhez képest (ISTOK, 1989). FILEP (1988) szerint az ionok effek-
tív diffúziós együtthatóját befolyásolja továbbá a közeg nedvességtartalma, illetve a 
közeg szerkezete, pórusméret-eloszlása (illetve az ezektől függő labirintus-hatás). 

5.1.2.3. A hidrodinamikai (mechanikai) diszperzió 
A hidrodinamikai diszperzió - egyes szerzők szerint mechanikai diszperzió - jelensé-
gét az áramlási sebesség nagyságának és irányának lokális mikro-változásai okozzák 
a porózus közegen belül (31. ábra). 
A hidrodinamikai diszperziót okozó legfontosabb hatások:  
- a szivárgási sebesség nagyságának változása a pórusokon belül, mivel a szem-

cséket körülvevő kötött vízburok esetén a szivárgási sebesség zérus. és távolodva 
a szemcsétől a sebesség növekszik, 

- a szivárgási sebesség irányainak változása, mivel a szivárgó folyadékban a szem-
csék kikerülése miatt pontról pontra változik a szivárgási sebességvektor iránya, 

- a pórusok méretváltozásai, mert az eltérő nagyságú (átmérőjű) pórusokban két 
különböző potenciállal jellemezhető pont között eltérő szivárgási sebességek ala-
kulnak ki. 
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31. ábra 

A hidrodinamikai (mechanikai) diszperziót előidéző jelenségek 
(BEAR-VERRUIJT, 1987) 

 

A hidrodinamikai diszperzió egy speciális esete az úgynevezett makrodiszperzió (32. 
ábra), amikor az egymástól eltérő vízföldtani tulajdonságokkal (szivárgási tényező, 
transzmisszivitás, szabad hézagtérfogat stb.) jellemezhető földtani képződményekben 
kialakuló egymástól eltérő áramlási sebességek okozzák a szennyezőanyag szóródá-
sát, diszperzióját. Gyakorlati tapasztalatok szerint a makrodiszperzió abban az eset-
ben válik dominánssá az egyéb mechanikai diszperziós folyamatok felett, amikor a 
modellezett területrész horizontális kiterjedése meghaladja a 10÷50 métert. 
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32. ábra 

Szennyezőanyag makrodiszperziójának kialakulása 
(KINZELBACH, 1986) 

 

Mind a hidrodinamikai (mechanikai), mind a makrodiszperzió következtében kiala-
kuló szennyezőanyag-hozam – a jelenséget kiváltó okokból következően - arányos a 
pórusokra jellemző átlagos szivárgási sebességgel, tehát nagyobb pórusbeli szivár-
gási átlagsebesség mellett nagyobb lesz a szennyezőanyag szóródása is az említett 
transzport-folyamatok következtében. Ugyanez nem igaz ugyanakkor a diffúzió mi-
atti anyagtranszportra, mert az teljesen hidraulikus gradiens, azaz szivárgási sebes-
ség független, nagysága kizárólag a koncentráció-gradiens és az effektív diffúzió-
állandó függvénye. 
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Tekintettel arra, hogy a hidrodinamikai diszperzió (beleértve a makrodiszperziót is), 
illetve a diffúzió okozta koncentráció-eloszlás jellegében azonos, ezért a hidrodina-
mikai diszperzió következtében kialakuló anyagmozgást is – az analógiát felhasz-
nálva - Fick I.törvénye segítségével írhatjuk fel.  
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ahol Dxx, Dxy,..., Dzz a hidrodinamikai diszperzió-állandó. Tekintettel arra, hogy a 
(5.5.) szerinti diszperzív hozamok arányosak a pórusokban kialakuló átlagos szivár-
gási sebességgel, ezért a Dxx, Dxy,..., Dzz hidrodinamikai diszperzió-állandóknak is 
arányosnak kell lenniük a pórusokban kialakuló átlagos szivárgási sebességgel. Az 
említett átlagos pórusbeli szivárgási sebességet a Darcy-törvényből meghatározott 
vx, vy és vz sebességek felhasználásával számíthatjuk: 
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v ===        ,       , ,      (5.6.) 

mivel a Darcy által feltételezett teljes V térfogat helyett csak a Vp = Θ⋅V pórustérfo-
gaton keresztül történik a folyadék mozgása. 
A szivárgási sebesség és a hidrodinamikai diszperzió-állandó közötti arányszámot 
diszperzivitásnak nevezzük. Tekintettel arra, hogy a diszperzió-állandó mértékegy-
sége a Fick-törvény analógiájára [L2/T], a szivárgási sebességé [L/T], ezért a 
diszperzivitás hosszúság [L] dimenziójú. Mivel a szennyezőanyag hidrodinamikai és 
makrodiszperzió miatti szóródása eltér a szivárgás irányában és arra merőleges irá-
nyokban, ezért szükséges a longitudinális és a transzverzális diszperzivitás fogalmá-
nak bevezetése.  

A diszperzió-állandó számításának módját az αL longitudinális és αT transzverzális 
diszperzivitás felhasználásával SCHEIDEGGER (1957) adta meg: 
Egydimenziós esetben : 

xLxxx vDD α== .         (5.7.) 
Kétdimenziós esetben: 
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Háromdimenziós esetben: 
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Amennyiben egy vízadóban homogén az áramlási sebességtér, azaz a víz szivárgása 
x irányú, az (5.5.) egyenletek az alábbi formára egyszerűsödnek: 
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ahol xTzxTyxLx vDvDvD ααα ===  ,, . 

A szennyezőanyag-transzport diffúzió, illetve hidrodinamikai diszperzió miatti kom-
ponenseinek számítása Fick I.törvényén alapulnak, ezért célszerű az (5.3.) és (5.5.) 
egyenletekben szereplő effektív diffúzió-állandót és hidrodinamikai diszperzió-ál-
landót összevonni a szennyezőanyag szóródását meghatározó D* diszperzió-állan-
dóba: 

xeffx DDD +=* , yeffy DDD +=*  és zeffz DDD +=* .    (5.11.) 

5.1.2.4. Az adszorpció 
Az adszorpció a szennyezőanyag porózus közeg felületén történő reverzibilis meg-
kötődését jelenti. Ez a folyamat a modellezett tér anyagmérlegében hasonlóan visel-
kedik, mint egy időben állandóan változó forrás vagy nyelő, függően attól, hogy az 
adott koncentrációviszonyok között a megkötődés (adszorpció), vagy a szennyező 
anyag oldatba jutása (deszorpció) az uralkodó felületi kémiai folyamat. 
Az adszorbeált és deszorbeált anyagmennyiségek egyensúlyát az alábbi matematikai 
egyenlőség írja le: 

t
C

dV
t
C

dV b ∂
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ρ
∂
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⋅−=⋅Θ ,       (5.12.) 

ahol C a pórusfolyadék koncentrációja [M/L3], C  a szennyezőanyag koncentrációja a 
talajban [M/Mszáraz talaj], ρb a porózus közeg testsűrűsége [M/L3] és Θ a térfogatszáza-
lékban kifejezett víztartalom [-](amely telített közegben egyenlő a hézagtérfogattal) 
és V a teljes vizsgált térfogat. 
Ha a kémiai egyensúly kialakult, a megkötött anyag koncentrációja számítható: 
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CKC d= ,          (5.13.) 
ahol Kd az egyensúlyi folyamat megoszlási együtthatója. 

A fentiek alapján a szorpciós folyamatok miatt egy adott V térfogatban a koncentrá-
cióváltozás miatt bekövetkező kémiai anyagmennyiség megváltozását a következő 
matematikai alakban írhatjuk le: 
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Az (5.14.) egyenletben a negatív előjel azt jelzi, hogy miközben a pórusfolyadék 
koncentrációja emelkedik, addig a szorpciós folyamatok miatt szennyezőanyag távo-
zik el – reverzibilisen – a rendszerből. 

Az (5.13.) alapján látható, hogy a C pórusfolyadék koncentráció és C  talajbeli 
szennyezőanyag koncentráció között összefüggés van. Az összefüggést egy függ-
vény írja le, ami a szennyezőanyag koncentrációján kívül még a hőmérséklettől is 
jelentősen függ. Annak érdekében, hogy a hőmérséklet-függést kizárjuk a pórusfo-
lyadék és az adszorptívum koncentrációja közötti összefüggést állandó hőmérsékle-
ten veszik fel, ezért az említett függvényt szorpciós izotermának nevezik. 
Ha feltételezzük, hogy az adszorbeált anyag mennyisége és a pórusfolyadék egyen-
súlyi koncentrációja egyenesen arányos egymással, azaz az adszorpció lineáris (Hen-
ry-féle szorpciós izoterma), akkor a Kd megoszlási együttható (amennyiben elte-
kintünk a hőmérséklet-változástól) állandónak tekinthető. 
A gyakorlatban előforduló esetek nagy részében (például nehézfémeknek az agyag-
ásványokon való megkötődése esetén, vagy ha az oldott anyag koncentrációja nagy), 
ez a feltétel nem teljesül, azaz a pórusfolyadék egyensúlyi koncentrációja nem egye-
nesen arányos a megkötött anyagmennyiséggel, ezekben az esetekben a megkötődő 
anyagok mennyiségét nem-lineáris adszorpciós izotermák segítségével jellemezhet-
jük. 
A vizsgált komponensnek a pórusfolyadékban, illetve a megkötő felületen való meg-
oszlási viszonyát kvázi-egyensúlyi helyzetben, állandó hőmérsékleten egy előre meg-
határozott koncentrációintervallumban mérjük. A kapott eredmények adják a szorp-
ciós izoterma tapasztalati pontjait. Ezen pontokra adott matematikai formában felír-
ható görbéket illesztünk, amelyek közül a gyakorlatban leggyakrabban a Freundlich 
és a Langmuir izotermákat alkalmazzuk. 
A Freundlich izoterma (33.a ábra) esetén az emelkedő koncentrációval exponenciáli-
san növekszik a megkötődő anyagmennyiség, azaz: 

NCKAC ⋅+= ,         (5.15.) 
ahol K a koncentrációtól függően változó megoszlási együttható, és A és N 
Freundlich-állandók. 
A Langmuir izoterma (33.b ábra) esetében arra vagyunk tekintettel, hogy a megkötő 
felület véges és ezen meghatározott mennyiségű szorpcióra alkalmas belépési pont 
található. Éppen ezért a megkötődő anyagmennyiség egy Cmax telítési határértékhez 
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közelít. Ebben az esetben a megkötött anyagmennyiség hiperbolikusan közelít ehhez 
a telítési határértékhez a koncentráció emelkedésével: 
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max ,         (5.16.) 

ahol K állandó. 
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33. ábra 

A Langmuir (a) és a Freundlich (b) izoterma alakja 
 

A Freundlich-izoterma elsősorban akkor írja le jellemzőbben a szorpciós folyamato-
kat, amikor uralkodóan egy ionkicserélődési folyamatról van szó, azaz a megkötött 
felületen nagy számban „A” ionok kötődtek meg, amelyek egy „B” ion koncentráci-
ójának függvényében részben „B” ionokra cserélődnek ki. Ebben az esetben a kon-
centráció növekedésével fokozatosan nő a megkötött, "A"-ról „B”-re cserélt ionok 
száma, amit jól leír a Freundlich-izoterma folyamatosan emelkedő és nem határér-
tékhez tartó görbéje. Ebben az esetben a nagymennyiségű ellenion miatt elhanya-
goljuk a felületi koncentrációváltozást. 
A Langmuir-izoterma inkább „üres” szorpciós helyek feltöltődése esetén alkalmaz-
ható vagy ha elhanyagoljuk a deszorbeált anyag koncentrációváltozását. Ekkor adott 
számú felületi megkötésre alkalmas hely létezik a rendszerben, amelyek a koncentrá-
ció növekedésével exponenciálisan fogyni kezdenek, amit jól követ a Langmuir-izo-
terma határértékhez közelítő jellege. A valóságban mindkét felvázolt folyamat a 
rendszerekben jelen van, ezért a két folyamat aránya határozza meg azt, hogy vajon 
melyik izoterma írja le jobban egy adott rendszer viselkedését (CZINKOTA, 1994). 
A nem lineáris adszorpció esetén a számítások az (5.13.) egyenlet szerint történnek, 
ugyanakkor a Kd megoszlási együttható helyett az adszorpciós izotermák alapján az 
aktuális koncentrációértéknek megfelelően számított Kd′ értéket kell időről időre vál-
tozóan behelyettesíteni, amely megfelel az izoterma adott koncentráció értéknél vett 
deriváltjával. 
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Alkalmazhatjuk a korábban leírtakat egy kétfázisú rendszerre, ahol az anyagmennyi-
séget kívülről változtatjuk. A megoszlási együttható definíciószerűen  

f
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tadszorbeál
d dC

dC
dC

dC
K == ,        (5.17.) 

ezért az adszorbens koncentrációjának megváltozása elvileg  

fda dCKdC ⋅= .         (5.18.) 
Tekintve egy V térrészt, amelyben nV a pórusok térfogata, így a megkötött és a pó-
rusokban található anyagmennyiségek egyensúlya 

fda dCKVndCV ⋅⋅−=⋅ ,        (5.19.) 
amennyiben az adszorbens koncentrációját a teljes térfogatra vetítjük. Feltételezve, 
hogy dM az a kémiai anyagmennyiség, amely egy adott idő alatt a rendszerbe jut és 
amelynek egy része megkötődik, egy másik része pedig folyadékfázisban marad, 
ezért  

fa dCnVdCVdM ⋅+⋅= .       (5.20.) 
Ebből a bevitt kémiai anyagmennyiség és a folyadékfázisra, illetve a teljes térfogatra 
vetített koncentrációváltozás kapcsolata:  

ffd dCnVdCnVKdM ⋅+⋅= * , azaz       (5.21.) 
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Mivel általában a megoszlási együtthatót mól/kg talaj vagy mg/kg talaj adszorbeált 
anyagmennyiségek mellett mg/dm3 vagy mg/m3 pórusfolyadék koncentrációk mellett 
adják meg, ugyanakkor a vizsgált rendszerben nem feltétlenül 1 kg adszorbens van 
jelen literenként vagy köbméterenként, ezért a megoszlási együtthatókat az adott 
rendszerre átszámítani szükséges. Ennek alapján  

n
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dimenziónélküli szám. 
Ezeknek az egyenleteknek a felhasználása a számítások során azért előnyös, mert azt 
biztosítják, hogy az adszorbeált anyagmennyiség, és ezért a adszorbeált anyag kon-
centrációja az adszorbensben az izoterma vízszinteshez közelítő szakaszán 
(Langmuir-izoterma) tovább már nem nő, ugyanakkor az is biztosított, hogy maxi-
málisan akkora kémiai anyagmennyiség adszorbeálódhat, amennyit a folyadékfázis 
tartalmazott. Ez a később bemutatott numerikus számítások stabilizálásánál válik 
fontossá.  
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5.1.2.5. A bomlás 
A bomlási folyamatok a szennyezőanyag mennyiségének időbeli csökkenéséhez, 
degradációjához vezetnek. Bár a bomlás két alapvető típusa a kémiai bomlás és a 
radioaktív bomlás jellegében alapvetően különbözik egymástól, a szennyezőanyagok 
terjedésének modellezésekor mégis azonos matematikai formában vehetők figye-
lembe, melynek algebrai alakja: 

)()( CKC
t
C

dVdt
dM

dbρλ
∂

∂
+−== Θ

Θ
,      (5.26.) 

ahol λ a bomlási állandó. 
Az (5.26.) egyenlet első tagja a folyadékfázisból, második tagja a megkötött fázisból 
való bomlást írja le. Tekintve, hogy az (5.26.) összefüggés, mind a pórustérben lévő, 
mind a felületen megkötött szennyezőanyag esetében λ intenzitású bomlást tételez 
fel, ez az egyenlet elsősorban a radioaktív bomlásra vonatkozóan írható fel. 
Biodegradáció esetén a bomlás üteme a folyadék, illetve a szilárd fázisban jelentősen 
eltér: 

CKC
t
C

dVdt
dM

dbρλλ
∂

∂
21 −−== Θ

Θ )(
.     (5.27.) 

Ebben az esetben a megkötött szennyezőanyag bomlására vonatkozóan általában 
nem rendelkezünk ismeretekkel, csak azt feltételezhetjük, hogy intenzitása nagyság-
renddel kisebb, mint folyadékfázisban. Ha λ2<<λ1, akkor a szilárd fázisban bekövet-
kezett bomlást a biztonság javára történő elhanyagolással figyelmen kívül hagyhat-
juk: 
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A fenti összefüggés azonban a kémiai reakciók egy részét, az elsőrendű kinetikájú, 
reverzibilis reakciókat írja le. Emiatt azokban az esetekben, amikor a bonyolultabb 
kémiai folyamatokat is követni szükséges, speciális, a hidraulikai számításokkal 
kompatibilis kémiai modulokat használnak fel, melyek rendkívül erősen megnövelik 
a feladatmegoldás erőforrásigényét. Éppen ezért ezek a megoldások az általános hid-
rodinamikai és transzport-modellezési gyakorlatban nem terjedtek el. 

5.1.3. A porózus közegben mozgó konzervatív szennyezőanyagokra érvényes 
transzportegyenlet 

A transzport-egyenletnek több formáját használják a gyakorlatban. Amennyiben va-
lamennyi szennyeződés-terjedési folyamatot vizsgálni kívánjuk, akkor az általános 
transzport-egyenlet megoldására van szükség:  
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Amennyiben a közeg telített: 
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Behelyettesítve az R késleltetési tényezőt: 
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Egyes esetekben a szorpciós és bomlási folyamatok elhanyagolhatók, ilyen például 
egy áramló talajvízben, egy kavics-homokos kavics vízadóba telepített kút vagy kút-
csoport közelében történő számítás. A homok és a kavics felületén megkötődő 
anyagmennyiségeket elhanyagolhatjuk és a gyorsan lejátszódó folyamatok miatt a 
bomlás számításától is eltekinthetünk. Ezt a helyzetet az advektív-diszperzív transz-
port-egyenlet írja le, amely az (5.29.-5.31) egyenletek megfelelő tagjainak elhagyá-
sával kapható meg. Amennyiben a szivárgás iránya azonos az egyik koordináta ten-
gellyel, akkor a transzport egyenlet további tagjai válnak zérussá, így az egyenlet 
tovább egyszerűsödik. 
A szennyezőanyagok szóródásáról, diszperziójáról megemlítjük, hogy a szennyező-
anyag diszperziója mindenképpen bekövetkezik, azonban a diszperziót okozó domi-
náns folyamat eltérő lehet. Amennyiben a szivárgás sebessége kicsi, akkor a diffúzió 
a domináns folyamat, mivel a hidrodinamikai diszperzió-állandó, ekkor sebességará-
nyosan kicsi. Amennyiben a szivárgás sebessége jelentős (áramló talajvíz esete), ak-
kor az advektív transzport mellett a hidrodinamikai diszperzió okozza a szennyező-
anyag szóródását, melyhez képest a diffúzió okozta anyagáramok elhanyagolhatóvá 
válnak (34. ábra). 
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Problémát jelent a nem-konzervatív, adszorbeálódó szennyezőanyagok mozgásának 
követése. Ezek az anyagok a gyakorlatban sokszor előfordulnak, ugyanakkor szorp-
ciós tulajdonságaik többnyire ismeretlenek. Ezért a figyelem mindjobban az anyag-
jellemzők meghatározására irányul, valamint a cél olyan hidraulikai modellek kifej-
lesztése, amelyekkel a hidraulikai jelenségeken túl, az áramló folyadékban lejátszódó 
kémiai folyamatok is megfelelően követhetők. 
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34. ábra 

Az advektív transzport, a diffúzió és a hidrodinamikai diszperzió okozta anyagára-
mok összevetése a szivárgási sebesség (szivárgási tényező) függvényében 

(ROWE, 1987) 

5.2. A transzportegyenlet megoldási módjai 

A fejezetben megismert transzportegyenletnek a szivárgás alapegyenletéhez hason-
lóan számos megoldási módja ismeretes. Ezek közül a legismertebb analitikus meg-
oldásokat, a numerikus megoldások közül a véges differencia és végeselem módsze-
ren alapulókat és a részecskeszemléletű megoldásokat mutatjuk be. 

5.2.1. Analitikus megoldások 
Egyszerű esetekre a transzportegyenlet analitikusan is megoldható. Ezek a megoldá-
sok adják egy-egy probléma felmerülésekor a legfontosabb első becsléseket és egy-
ben az analitikus megoldásokkal való összevetéssel szokás egy újonnan kifejlesztett 
számítási algoritmusokat is ellenőrizni is. Mivel a korábban felírt transzport-egyen-
letnek - az analitikus megoldásokon túlmenően - csak közelítő megoldásai ismerte-
sek, ezért tartjuk szükségesnek az alapegyenletek analitikus úton - különböző kezdeti 
és peremfeltételek mellett - történő megoldásának részletes tárgyalását. Az analitikus 
megoldások eredményeként kapott, egyszerű formulák lehetőséget biztosítanak egy-
szerű függvényvizsgálaton alapuló hibaanalízis végrehajtására is, amelynek segítsé-
gével a transzport-folyamatokat leíró paramétereknek a számított koncentráció nagy-
ságára vonatkozó hatása becsülhető.  
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5.2.1.1.  Egydimenziós megoldások 
Az egydimenziós analitikus megoldások a gyakorlatban elsősorban állandó áramlási 
sebesség mellett, a sebességvektor irányára merőlegesen elhelyezett kutak esetén, 
vagy pl. egy folyóból történő elszivárgás számítására alkalmazhatók (35. ábra) 

 
35. ábra 

A transzport-egyenlet egydimenziós analitikus megoldásainak alkalmazási területei 
(SAUTY, 1980) 

 

Tekintsük az (5.31.) egyenlet alábbi egydimenziós formáját, ahol a víztartó vastag-
sága m, infinitezimálisan kicsiny szélessége w, a koncentráció-gradiens y és z irány-
ban zérus: 
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Legyen a pillanatnyi szennyezés tömege M az x=0 helyen t=0 időpontban. Ezt a kez-
deti feltételt a Dirac-delta függvénnyel lehet leírni: 
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0 = ,        (5.33.) 

ahol a Dirac-delta függvény: 
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δδ 0x     (5.34.) 

Másfelől legyen C t( , )±∞ = 0. Ebben az esetben a megoldás a jól ismert Gauss-görbe: 
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Ez a haranggörbe Rvx /  sebességgel mozog az időben az x tengely pozitív irányá-

ban, a szórása RtvxL /α2 . A függvény amplitúdója az időben csökken (36. ábra). 
 

 
36. ábra 

Pillanatnyi szennyeződés terjedésének időbeli lefolyása bomlás nélkül és bomlással 
 

Ismerve a koncentráció időbeli alakulását egy pillanatnyi szennyezésre, bármilyen 
időbeli lefutású szennyezés esetére függvények konvolúciójával a koncentráció-idő 
függvény meghatározható, mivel a transzportegyenlet lineáris és a peremfeltétel ho-
mogén. 

Tekintve egy változó aktivitású forrást az x=0 helyen és az időben 
dt

dMtM =
•

)(  

formában változó tömegáramot, a megoldás: 
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Amennyiben a szennyezőanyag terhelés megoszló és az értéke egységnyi hosszra 
vetítve µ(x,t), a koncentrációt a t időpontban így számíthatjuk: 

∫ ∫
∞

−∞= =

−−





















−








 −
−−

−
−

=

=

ξ τ

ξττλ
τα

τ
ξ

τπα
ξµ .))(exp(

)(

)(

exp
)(

),(

),(

ddt

R
tv

R
tvx

R
tvRwmn

t

txC

t

xL

x

xL0

2

0

4
2

 (5.37.) 

Ez az egyenlet az egyszerű (idealizált) lefolyású szennyezési esetekre analitikusan 
megoldható. Amennyiben a forrás az x=0 pontban található, M állandó

•

= , valamint a 
szennyezés kezdeti időpontja t=0, ekkor a megoldás: 
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illetve )()( ξξ erferfc −= 1   a standard hibafüggvény és annak komplementere. 

Egydimenziós transzport-folyamatokkal írhatók le a laboratóriumi oszlopkísérletek 
is. Ebben az esetben az egyenletet kissé eltérő peremfeltételek mellett oldjuk meg: 
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A megoldást OGATA (1970), OGATA és BANKS (1961), valamint GUPTA és 
PANDEY (1980) adta meg egymástól alig eltérő formában: 
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ahol C0 az influens koncentráció és  4+1= L
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formulával: 
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Amennyiben a nem bomló szennyezőanyag az áramlási közeg felületén nem adszor-
beálódik (R=1 és λ=0), az (5.40.) összefüggés tovább egyszerűsödik: 
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Az (5.41.) egyenlet az alapja a diszperzió-állandó laboratóriumi meghatározásának. 
Az egyenletből levezethető, hogy amennyiben a relatív koncentráció C/C0=0.5, azaz 
ahol az áttörési görbének inflexiós pontja van, ott a koncentráció-gradiensre vonat-
kozóan igaz, hogy 
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A kísérlet során a koncentrációt egy adott pontban az idő függvényében mérjük és 
meghatározzuk a koncentráció-profil meredekségét. Tekintettel arra, hogy a transz-
port-folyamat egydimenziós, ezért minden t időponthoz egy tvx x ⋅= hely tartozik és 
ennek alapján két közeli ti időpont felhasználásával a ∆C/∆x koncentráció-gradiens is 
meghatározható. Amikor a C mért koncentráció éppen C0/2, akkor az (5.42.) egyen-
let alapján a longitudinális diszperzivitás számíthatóvá válik. 
Az OGATA féle oszlopkísérlet megoldásából indult ki SHACKELFORD (1990), 
amikor a szigetelőrétegen való átjutáshoz szükséges idők számítására alkalmas meg-
oldást fejlesztett ki. A megoldás alapja az (5.43.) egyenlet, amelyik az (5.39.) egyen-
letből származtatható: 
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ahol  
xR
tv = CoT x

RR ⋅
⋅

= Courant-szám és a  
D

xv = PeP
x

x
LL *

⋅
= Peclet-szám. Ameny-

nyiben nagyon kicsi a szivárgás sebessége, akkor Lxeffx vDD α⋅+=* , ha azonban a 
diszperzív transzportfolyamatok közül a hidrodinamikai diszperzió dominál a diffú-
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zióhoz képest, akkor Lxeff vD α⋅<< , ezért Lxx vD α⋅≅* diszperzió-állandó használ-
ható. 
A megoldás során a kérdés, hogy konstans C0 koncentrációjú influens oldat esetén 
egy adott x távolságban mekkora t idő elteltével válik a koncentráció értéke C érté-
kűvé. A feladat tehát inverz: nem a koncentrációt keressük a hely és az idő függvé-
nyében C=C(x,t), hanem a t időpontot egy adott x helyen a bemenő és a kialakuló 
koncentráció függvényében t=t(C,C0). 
A keresett t időpontot csak a TR Courant-szám ismeretében kaphatjuk meg, ez 
ugyanakkor zárt alakban az (5.43.) egyenletből nem kapható meg. A számításokhoz 
egy nomogramot használunk fel, amelyik az adott Peclet-számok esetére a Courant-
szám és a C/C0 relatív koncentráció közötti összefüggést ábrázolja ( 
37. ábra). 
A megoldás során az adott x távolságra meghatározzuk a Peclet-számot, majd ennek 
ismeretében és az elérendő koncentrációhoz tartozó C/C0 relatív koncentráció függ-
vényében a  
37. ábra segítségével meghatározzuk a Courant számot, amiből a t idő az (5.43.) 
egyenlet alapján számítható. 
Egy másik ismert megoldás, ami az (5.39.) egyenletből is levezethető, a pusztán dif-
fúzió esete. Ekkor a szivárgás pórusbeli xv sebessége zérus, így sem advektív transz-
port sem hidrodinamikai diszperzió nem léphet fel. Ebben az esetben a megoldás: 
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37. ábra 
Összefüggés a Courant-szám és a C/C0 relatív koncentráció között 

(SHACKELFORD, 1990) 

 
38. ábra 

Az advektív, advektív-diffuzív és az advektív-dizperzív transzport áttörési görbéinek 
összehasonlítása 

(FREEZE – CHERRY, 1979) 

 
39. ábra 

A diffúzív transzport áttörési görbéi 10-10 és 10-11 m2/s 
 effektív diffúzió-állandó esetén 
(FREEZE – CHERRY, 1979) 

5.2.1.2. Kétdimenziós megoldások 
Legyen az áramlás iránya párhuzamos az x tengellyel. Ebben az idealizált esetben az 
(5.31.) egyenlet a következő formában írható fel: 
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Legyen a pillanatnyi M tömegű szennyezés ismét az x=0 és y=0 helyen t=0 időpont-
ban. A kezdeti feltétel: 

)()(),,( yx
mRn
M

yxC δδ
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0 = , ahol δ(x) és δ(y) - a korábbiakhoz hasonlóan - a 

Dirac-delta függvény, másfelől legyen 0=±∞±∞ ),,( tC . Ebben az esetben a meg-
oldás (CSANÁDY, 1973): 
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40. ábra 

Pillanatnyi szennyezőforrás okozta koncentráció-eloszlás 
 

Ez az egyenlet az alapja a nyomjelzéses vizsgálatokat követő számításoknak két 
megfigyelő kút esetén. 
A korábbiakhoz hasonlóan, ismerve a koncentráció időbeli alakulását egy pillanatnyi 
szennyezésre, bármilyen időbeli lefutású szennyezés esetére integrál-számítással a 
koncentráció-idő függvény meghatározható. Tekintve egy változó aktivitású forrást 
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az x=0 és y=0 helyen és az időben változó tömegáramot 
dt

dMtM =
•

)(  formában, a 

megoldás: 
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ahol 222 yxr
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+= . Az integrál megoldása a Hantush-függvényhez vezet, amelyet 

csak numerikusan lehet megoldani, de jó analitikus közelítő megoldása is ismert: 
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ahol 
xvmn
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=  és 
xv

Rλα
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A közelítő megoldás pontossága 1
2

>
L

r
α

 , akkor kb.10%, de ha , akkor 1%. Az 

(5.48.) egyenlettel számítható koncentráció eloszlás alakját a 41. ábra mutatja be. 

5.2.2. Numerikus megoldások 

5.2.2.1. Véges differencia módszer 
A véges differencia módszer alkalmazása során a hidrodinamikai alkalmazásnál lá-
tottakhoz hasonlóan, a modellezett teret tetszőleges számú, egymással érintkező tég-
latest alakú elemekre bontjuk, egyenletes vagy változó osztású rácsháló segítségével. 
Mivel a hidrodinamikai modellezésnél kapott eredmények a transzportmodell beme-
neti adatai, ezért célszerű mind a hidrodinamikai, mind a transzportmodellezéshez 
azonos rácshálót használni. Ezután a transzport-egyenletnek a differenciaegyenletté 
alakított formája alapján a meghatározzuk az egyes hasábelemek és az azokkal köz-
vetlenül érintkező elemek közötti advektív és diszperzív szennyezőanyag fluxusokat, 
az adszorbeált és az esetlegesen kémiai vagy radioaktív bomlás útján degradálódott 
szennyezőanyag mennyiségeket. Figyelembe véve a szennyezőanyag-nyelők és forrá-
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sok hatását, valamint alkalmazva a kezdeti és peremfeltételeket, felírjuk az egyes 
elemek szennyezőanyag-mérlegét egy a kezdeti t0 időpontra és az azt követő ∆t idő-
pontra. Ezt követően az egyes elemek anyagmérlege alapján felállítjuk a modellezett 
tér szennyezőanyag forgalmát - az adott időlépcsőben - leíró lineáris egyenletrend-
szert, amit a korábban vázlatosan bemutatott matematikai eljárásokkal megoldunk. 
Eredményként az egyes elemekre vonatkozó koncentráció-értékeket kapunk. Nem 
permanens esetben az utóbbi lépéseket tetszőleges számú időlépcsőre megismételjük. 
 

állandó pontszerű
szennyezőforrás

t1 t2 t3 t4

 
41. ábra 

Állandó forrás okozta szennyezőanyag-eloszlás időbeli változása 
 

5.2.2.1.1. A szennyezőanyag-mérleg elemei 
Az egyszerűség kedvéért tekintsünk egy síkmodellt, amelyben a rácsháló osztása x és 
y irányban is egyenletes, ∆x, illetve ∆y. Legyenek a rácsháló elemeinek koordinátái 
x irányban 1,2,..., i-1,i,i+1,...n, míg y irányban 1,2,...,j-1,j,j+1,...n. így egy általános 
helyzetű elemre a koncentráció értéke Ci,j, az elem magassága mi,j és így tovább 
(42. ábra). 
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Bomlás

Adszorpció

Tárolt szennyezőanyag
mennyiség

x

y

Források és nyelők hozama

Víztartó
vastagsága

C

Elem ( i , j )

Ca

 
42. ábra 

Szennyezőanyag-mérleg elemei egy kiválasztott elemi hasáb környezetében 
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Ha a pórusokban az áramlási sebesség komponensei ( yx v,v ), akkor az oldott szeny-
nyezőanyagokat tartalmazó víztömeg áramlása következtében az egyes elemekbe be- 
illetve kilépő advektív szennyezőanyag hozamokat az alábbi egyenlet írja le: 
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,  (5.49.) 

ahol Ci,j a koncentráció az i,j hasábban és n0 a szabad hézagtérfogat.  

Függően attól, hogy milyen módon képezzük a differenciákat α, β, γ és δ értéke az 
alábbiak szerint alakul:  
- központi differenciák alkalmazása esetén: 50,==== δγβα . (5.50.) 
- előrelépéses differenciák esetén:  

( )[ ] 21 1 /sgn ,, jixv −+=α , ( )[ ] 21 /sgn ,, jixv+=β ,  
( )[ ] 21 1 /sgn ,, −+= jiyvγ és ( )[ ] 21 /sgn ,, jiyv+=δ .    (5.51.) 

- hátralépéses differenciák esetén:  
( )[ ] 21 1 /sgn ,, jixv −−=α , ( )[ ] 21 /sgn ,, jixv−=β ,  
( )[ ] 21 1 /sgn ,, −−= jiyvγ , ( )[ ] 21 /sgn ,, jiyv−=δ .    (5.52.) 

A három differenciaképzési eljárás közül, amennyiben az advektív transzport domi-
náns az előrelépéses, amennyiben a diszperzív transzport a jellemző, a központi dif-
ferenciákat felhasználó algoritmust javasolja KINZELBACH (1986) használni. 
A szennyezőanyag hidrodinamikai diszperziója, illetve a molekuláris diffúzió követ-
keztében a kiválasztott hasábelem és a környezetében lévő elemek között áramló 
szennyezőanyag fluxus párhuzamos és diagonális diszperzív fluxusokból tevődik ösz-
sze (43. ábra). Amennyiben az áramlás iránya megegyezik valamelyik (pl. x) ten-
gellyel, akkor a diszperzív szennyezőanyag áramlásnak csak az elem falára me-
rőleges illetve azzal párhuzamos (tehát a másik két oldalára merőleges) komponense 
van (párhuzamos fluxusok): 
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Amennyiben az áramlási irány nem párhuzamos a koordináta tengelyekkel, a 
diszperzív hozamok számításánál az úgynevezett diagonális irányú diszperzív hoza-
mokat is tekintetbe kell venni, amelyek a következő módon számíthatók: 
- Diagonális diszperzív hozam x irányból: 
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- Diagonális diszperzív hozam y irányból: 
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ahol Dxx, Dyy, Dxy és Dyx a diszperzió-állandó tenzor elemei, amelyeket az (5.9.) ösz-
szefüggések segítségével számíthatunk. 
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43. ábra 

A párhuzamos és diagonális diszperzív hozamok értelmezése 
 

A korábbiak alapján tehát a diszperzív hozamok fluxusa )(1
dd JJ = , ha az uralkodó 

áramlási sebesség iránya párhuzamos bármelyik koordináta tengellyel és 
)()()( y

d
x

ddd JJJJ 221 ++=  általános irányú sebességvektor esetén. 

Az egyes elemek szennyezőanyag mérlegét az elemen belüli szennyezőanyag forrá-
sok és nyelők (pl. termelő kutak) hozamai módosíthatják, amelyeknek két alapvető 
típusa van: a koncentrált és a területi források.  
A vízkitermeléshez illetve vízbetápláláshoz kötött koncentrált források és nyelők 
fluxusa 

jikutjiq CyxqJ .,,
)( ⋅∆∆⋅=1 ,        (5.56.) 
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ahol Ckut,i,j a kúttal kitermelt vagy a kútba injektált víz koncentrációja, qi,j a betáplá-
lás/kivétel hozama az elem egységnyi felületére vetítve. A területen megoszló - ú.n. 
belső - szennyezőanyag források (pl. depóniák) esetében a fluxus 

yxSJ jibelsöq ∆∆⋅= ,,
)(2 ,        (5.57.) 

ahol Sbelső,i,j [mg/s/m
2
] a belső forrás (depónia) aktivitásának az értéke a hasábelem 

egységnyi területére vonatkoztatva. 
A szennyezőanyagok egy része biológiai, kémiai vagy radioaktív úton lebomlik. A 
degradáció során a rendszerből távozó anyagmennyiség fluxusa  

jijir CmyxnJ .,deg ⋅⋅⋅⋅−= ∆∆0λ ,       (5.58.) 
ahol λ a bomlási együttható, Ci,j a koncentráció az elemben az időlépcső kezdetén. 

A lineáris adszorpció figyelembevételére a be- és kifolyó hozamokat az R késlelte-
tési tényezővel osztjuk el. Amennyiben az adszorpciót nem kívánjuk figyelembe 
venni, akkor R=1.  
A korábban felsorolt szennyezőanyag-hozamok hatására az adott időlépcső alatt a 
vizsgált elemben a koncentráció, tehát a tárolt szennyezőanyagok 

( ) ( )[ ]tCttCmyxnM jijijit ,,, −+⋅⋅= ∆∆∆0      (5.59.) 
mennyisége megváltozik. Alkalmazva a korábban felírt összefüggéseket, a szennye-
zőanyag-mérleg kétdimenziós áramlás (síkszivárgás) esetén az alábbi módon fogal-
mazható meg: 
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Ez az egyenlet minden egyes hasábelemre felírható, így a probléma megoldását egy 
sok-ismeretlenes egyenletrendszer megoldására vezettük vissza. 
A szennyezőanyag-mérleg valódi háromdimenziós esetben kissé módosul, mert ek-
kor a kiválasztott elem nemcsak a korábban figyelembe vett szomszédos négy elem-
mel, hanem az alatta és felette elhelyezkedő elemekkel is kapcsolatban áll. Ebben az 
esetben az advektív hozamokat a függőleges áramlási sebességet is figyelembe véve 
újabb tagokkal bővíteni kell. A diszperzív hozamokat a diszperziós tenzor 3x3 mé-
retű mátrixának segítségével kell felírni, további normális és diagonális tagokkal bő-
vítve a korábban alkalmazott összefüggést. A források és nyelők hozamai, a degra-
dáció okozta koncentráció-csökkenés, valamint az adszorpció figyelembevétele nem 
változik. 

5.2.2.1.2. A kezdeti és peremfeltételek megadása 
A modell tér- és időbeli határain a szennyezőanyag-mérleg néhány eleme meghatá-
rozatlan, ezek meghatározására perem- és kezdeti feltételeket szükséges alkalmazni. 
Ahhoz, hogy az első időlépcső során a szennyezőanyag hozamok meghatározhatók 
legyenek, kezdeti feltételként a t0 időponthoz tartozó koncentráció-értékeket hasz-
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náljuk fel. Ezek után már minden ti=ti-1+∆t időlépcsőre felírható az egyenletrendszer, 
ahol i az időlépcső sorszáma. 
A modellezett térrész határain a szennyezőanyag-mérleg hiányzó elemeinek pótlásra, 
vagy ezen összetevők számításának lehetővé tételére Dirichlet-típusú vagy Neu-
mann-típusú peremfeltételeket alkalmazhatunk. Dirichlet-típusú peremfeltétel esetén 
az adott szélső hasábelemben (függetlenül az elem szennyezőanyag-mérlegének ala-
kulásától) a koncentrációt időlépcsőről időlépcsőre állandónak vagy egy szabály sze-
rint változónak tekintjük. Leggyakrabban a szennyezőforrástól megfelelően távol 
lévő határelemekben alkalmazzuk, oly módon, hogy az állandó koncentráció értékét 
zérusnak, vagy a háttérterhelésnek megfelelő értékűnek választjuk. Neumann-típusú 
határ esetén a beáramló szennyezőanyag-fluxus értékét tekintjük állandónak, azaz a 
peremi helyzetű elembe a modellezett téren kívülről beáramló szennyezőanyag 
advektív és diszperzív fluxusait, egy adott, meghatározott értékű fluxussal helyette-
sítjük. Speciális esete, amikor a beáramló szennyezőanyag-hozam zérus. 

5.2.2.2. A transzport egyenlet numerikus megoldásainak hibái 
Ugyanúgy, mint a szivárgás alapegyenletének megoldásakor, a transzport-egyenlet 
numerikus megoldásakor is felléphetnek hibák. A megoldás közelítő voltát a továb-
biakban sem tekintjük a megoldás hibájának. 

5.2.2.2.1. A megoldás instabilitása  
Mivel az időbeli folyamatok követésére mind a végeselem, mind a véges differencia 
módszer véges differenciákat használ, éppúgy, mint ahogy azt a szivárgási alap-
egyenlet megoldásánál láttuk, ezért a numerikus hibák is azonosak. 
A megoldás instabilitásán azt értjük, hogy a közelítő megoldás a valódi megoldáshoz 
nem konvergál (44. ábra). Az instabilitás jelensége elsősorban explicit megoldási 
módok esetén jelentkezik, azonban az elemszám növekedésével, elsősorban három-
dimenziós numerikus modellek és/vagy implicit megoldó rutinok használata esetén is 
előfordul. Az instabilitás egyik speciális esete a numerikus oszcilláció, amikor a 
számítások eredményei nem képesek a hibahatáron belül közelíteni a valós megol-
dást. A stabilitás biztosítása érdekében a Courant, a Neumann és a forrás-nyelő sta-
bilitási kritériumoknak kell teljesülniük. 
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Numerikus megoldás

Idö
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Numerikus oszcilláció
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44. ábra 

A numerikus instabilitás és a numerikus oszcilláció jelensége 
 a transzportmodellezésnél 



77 

 

A Courant kritérium azt fejezi ki, hogy advektív úton az adott ∆t időlépcső alatt nem 
léphet ki több szennyezőanyag az elemből, mint amennyi az időlépcső kezdetén az 
elemben tárolt anyagmennyiség. Ennek a feltételnek a modellezett tér minden ele-
mére, minden időlépcső során teljesülnie kell. A Courant kritériumot az (5.61.) 
egyenlet írja le, azonban előrelépéses differenciák alkalmazása esetén a 

1≤+ yx CoCo  feltételnek is teljesülnie kell, ahol Co az úgynevezett Courant-szám, 
vx és vy a Darcy-féle áramlási sebességvektor komponensei, ∆x és ∆y a vizsgált 
elem hossza, illetve szélessége. 
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Háromdimenziós modellek esetén a Courant kritérium a  
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        (5.62.) 

formában írható fel, ahol ∆l az adott elemen belüli áramvonalak sebességirányban 
mért maximális hossza (KÖNIG, 1993).  
A Neumann kritérium azt biztosítja, hogy kizárólag az advektív-diszperzív szennye-
zőanyag-hozamok hatására a koncentráció-gradiens iránya ne változhasson meg. Ma-
tematikai formában: 
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ahol *
xxD  és *

yyD  a diszperzió-állandó mátrixának főátlójában található elemei 
(REDDEL és SUNADA, 1970). 
A forrás- és nyelő-elemek stabilitási kritériuma biztosítja, hogy a nyelők hatására 
bekövetkező szennyezőanyag-mennyiség csökkenése ne legyen nagyobb, mint az 
időlépcső elején az adott elemben tárolt szennyezőanyag-mennyiség, azaz  
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ahol qi,j a pontszerű nyelők és források összegzett hozama az elem egységnyi felü-
letére vetítve, mi,j az elem (átlagos) magassága, n0 a szabad hézagtérfogat. 

5.2.2.2.2. A numerikus diszperzió 
Numerikus diszperzió alatt a szennyezőanyag pusztán advektív transzportja során 
kialakuló éles frontjának - az iteratív számítási ciklusok sorozatának végrehajtása 
közben fellépő pontatlanságok hatására bekövetkező - elmosódását értjük (45. áb-
ra:a). 
A jelenség kialakulásának oka, hogy a szennyezési front számított haladási sebessége 
kissé eltér az advektív áramlási sebességtől. Mivel a numerikus módszerek alkalma-
zásakor az anyagmérleg mindig pontosan teljesül, ezért a sebességbeli eltérés a rend-
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szerben egy relatív koncentráció-csökkenéssel kompenzálódik, így az oldat és a ki-
szoruló víz közötti éles határvonal elmosódik és egy átmeneti zóna alakul ki (HA-
LÁSZ, 1987). Minthogy a hibajelenség eredménye a szennyezőanyag szóródása, 
ezért numerikus diszperziónak nevezik. Az említett hiba bizonyíthatóan fellép 
advektív-diszperzív transzportszámításoknál is, amelynek eredményeként látszólago-
san megnövekednek a diszperzió-állandó tenzorának elemei. Magát a hibát a diffe-
renciálhányadosok differenciahányadossal való közelítésének pontatlansága okozza, 
ami a második deriváltak (diszperzív hozamok) esetén sokkal nagyobb jelentőségű. 

 

Hely

Numerikus megoldás

Koncentráció

Valódi megoldás

Koncentráció

Hely

Numerikus megoldás

Valódi megoldás

a, b,

 
45. ábra 

A numerikus diszperzió és az "Undershoot-Overshoot" jelenség 

5.2.2.2.3. Az "Undershoot-Overshoot" jelenség  
Az "Undershoot-Overshoot" jelenség hasonlít a numerikus oszcillációhoz, ekkor a 
két különböző koncentrációjú hely között a koncentráció érték nem fokozatosan, ha-
nem az alacsony és a magas koncentrációértékekhez oszcillálva közelít (45. ábra:b). 
A jelenség elsősorban a központi differenciák alkalmazásakor fordul elő, így az elő-
relépéses differenciákra való áttéréssel megkerülhető. Ez utóbbi esetben azonban a 
numerikus diszperzió erősebb, mert az ilyen módon képzett differenciahányados na-
gyobb hibával közelíti a differenciálhányadost, mint a központi differenciák esetén. 
A numerikus diszperzió és az "Undershoot-Overshoot" jelenség elkerülhető, ha a 
korábban tárgyalt Courant-kritérium a modellezett tér teljes egészére, mindkét 
(mindhárom) koordináta-tengely irányában teljesül, és ha a hálóra értelmezett Peclet 
szám kisebb, mint 2 (FRIND, 1982):  
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ahol Pe a Peclet-szám.  
Sajnos a kritériumok teljesülése csak magas elemszám esetében biztosítható, azon-
ban ennek korlátot szab a rendelkezésre álló memória. KINZELBACH (1986) arra 
hívja fel a figyelmet, hogy az említett numerikus hibák még a fenti feltételek telje-

sülése esetén is bekövetkezhetnek, ha 10≈>
T

L

α
α

, ahol αL és αT a longitudinális és 

transzverzális diszperzivitás. 
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5.2.3. Részecskeszemléletű szimulációs eljárások 
A részecskeszemléletű megoldások a transzport-egyenlet olyan megoldásai vagy an-
nak analogonjai, melyek valamilyen módon kizárják a numerikus hibák fellépését. A 
részecskeszemléletű megoldások közös jellemzője, hogy a rendszerben található 
szennyező anyagokat egységekbe fogják össze és az egységek mozgását vizsgálják. 
Egy-egy ilyen egységhez, amit részecskének hívunk, mind helyben, mind térben vál-
tozó szennyezőanyag tömeget, mennyiséget rendelhetünk, ami a megoldás rugal-
masságát biztosítja. A részecskeszemléletű megoldások közül a két legelterjedtebbet, 
a karakterisztika módszerét és a véletlen bolyongást mutatjuk be. 

5.2.3.1. Karakterisztika módszere 
A karakterisztika módszere azon alapul, hogy a transzport egyenletet nem helyhez, 
hanem a mozgó vízrészecskékhez kötött koordinátarendszerrel írja le, így a transz-
port egyenletet ordináris differenciálegyenletté alakul. Másképpen megfogalmazva a 
módszer a koncentrációk változását nem álló helyzetből, hanem az áramló folyadék-
kal mintegy együtt mozogva szemléli. Tekintettel a transzportegyenlet ordináris dif-
ferenciálegyenletté fajulására a karakterisztika módszere (többnyire együttesen a vé-
ges differencia módszerrel alkalmazva) kiküszöböli numerikus hibák nagy részét. 
Kiindulási alapként szükséges az áramlási sebességtér jellemzőit, azaz a sebesség-
vektor irányának és nagyságának térbeli és időbeli változását ismerni, ezt többnyire 
véges differencia módszerrel határozzuk meg. Ezt követően olyan pontokat (részecs-
kéket) helyezünk el az áramlási térben, amelyek az áramló vízzel együtt mozognak 
az áramvonal (karakterisztikus vonal) mentén és amelyeknek a helyzetét egy fix 
rácshálóhoz, praktikusan egy véges differencia hálóhoz viszonyítjuk A módszer fo-
lyamán az egyes részecskék megadott, de az egyes időlépcsők során változó nagy-
ságú szennyezőanyag-tömegeket jelképeznek. A karakterisztika módszerét számos 
szoftver alkalmazza. Előnye, hogy könnyen összekapcsolható bármely véges diffe-
rencia elven működő hidrodinamikai számítási rendszerrel. A nehézséget csupán az 
eltérő utakon és különböző sebességgel mozgó részecskékhez kötött koordináta 
rendszerek nyilvántartása okozza. Ezért fordul elő, hogy a részecskék számát limi-
tálni szükséges, ebben az esetben főleg permanens forrás és hosszú időtartamra tör-
ténő számítás esetén a módszer pontossága lecsökkenhet. (KONIKOW és 
BREDEHOEFT, 1978) 

5.2.3.2. A véletlen bolyongás módszere 
A véletlen bolyongás módszerének alapötlete az, hogy a szennyezőanyag porózus 
közegbeli szóródása, diszperziója, legyen az a hidrodinamikai diszperzió, vagy a dif-
fúzió hatására bekövetkező szóródás, véletlen jellegű (sztochasztikus) folyamat. 
Ezért bontsuk a teljes szennyezőanyag tömeget kisebb és megfelelően nagy számú 
egységre, és ezzel a nagyszámú részecskével egyenként szimuláljuk az áramlási se-
bességvektor iránya és nagysága által egyértelműen meghatározott advektív áramlás-
ból eredő elmozdulásokat, majd erre szuperponáljuk a sztochasztikus diszperzív 
transzport-jelenségeket (46. ábra). 
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2. diszperziv lépés

1. konvektiv lépés

 
46. ábra 

A részecske mozgása advektív és diszperzív lépések szuperpozíciójaként értelmezve 
(KINZELBACH, 1986) 

 

A módszer előnyeit PRICKETT és szerzőtársai (1981) a következőkben foglalták 
össze, hogy: 
- Nincs az egyenletnek megoldandó diszperziós tagja, az ezt helyettesítő rész 

mindössze mintegy 10 programsor, ezért a számításokhoz szükséges gépidő kicsi. 
- Csak egyetlen koordinátarendszert és az advektív áramlások számításához fel-

használt véges differencia hálórendszert kell alkalmazni. 
- A koncentrációk eloszlását csak azokban az időpillanatokban kell számítani, ami-

kor azok érdekesek.  
- A részecskéket csak a szennyezett területen lehet felvenni, a szennyezéstől távol 

eső területeken kisebb ismeretesség és ennek következtében pontatlanabb adat-
rendszer is megengedhető. 

- A megoldások egymásra szuperponálhatók, így bármennyi részecskével végez-
hető el a szimuláció anélkül, hogy memóriaproblémák lépnének fel. 

- A tradicionális numerikus hibák (Undershoot-Overshoot jelenség, numerikus 
diszperzió) nem lépnek fel.  

 

A módszer hátrányai: 
- Durva tér- és időbeli felosztás esetén nagyobb koncentráció-változások fordulhat-

nak elő, mint a kezdeti koncentráció érték, tehát "negatív koncentráció-értékek" 
számítását a módszer elve nem zárja ki. 

- A koncentráció-eloszlás képe alacsony számú részecske felhasználásakor nem 
esztétikus és nem is reális 

- A módszer megkívánhatja speciális esetekben igen nagy számú részecskék hasz-
nálatát. (A részecskék száma a gyakorlatban általában nem haladja meg a 10 000 
darabot.) 

- A koncentrációk számításához felhasznált háló osztását optimálni kell. A túl sűrű 
osztás esetén az egyes elemekbe jutó részecskék száma alacsony lesz, ezért durva 
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eredményeket kapunk. Ritka hálóosztás esetén az egyes elemekbe jutó részecske-
szám megfelelően nagy lehet, azonban az összes elemek száma annyira lecsök-
kenhet, hogy emiatt a kapott eredmények túlságosan nagy területre adnak átlag-
értékeket és esztétikailag sem megfelelők. KINZELBACH (1986) a hasábele-
menkénti minimum 20 db részecskét tartja optimálisnak. 

- PRICKETT és szerzőtársai (1981) azt állapították meg, hogy a megfelelő szeny-
nyezőanyag-felhő kialakulása érdekében az időlépcsőt úgy kell módosítani, hogy 
az advektív lépés hossza sosem haladja meg a legkisebb rácsméret ötödét. Ezzel 
egyben biztosítja azt is, hogy a részecske ne legyen képes átugrani bármely nyelő 
felett anélkül, hogy azt észlelte volna. Hibalehetőség rejlik az áramlási sebesség 
hirtelen megváltozásakor. Ekkor előfordulhat, hogy a nagy áramlási sebességgel 
jellemezhető térrészből a részecske mélyen beugrik a stagnáló tartományba, ahol 
szinte csapdázódik. Ezt a problémát csak az időlépcső radikális csökkentésével 
lehet megoldani. 

A módszer alkalmazásakor a kezdeti koncentráció-eloszlásnak megfelelő eloszlású 
azonos szennyezőanyag tömeget jelentő részecskét helyezünk el a vizsgált térrészbe, 
majd az eltelt időnek és a szennyezőforrás aktuális intenzitásának megfelelően újabb 
részecskéket juttatunk a rendszerbe. A vizsgált térrészben található szemcsékre elvé-
gezzük az advektív és a sztochasztikus diszperzív számítási lépést, figyelembe véve a 
késleltetést, illetve a szennyezőanyag bomlását. A bomlás figyelembe vételére szo-
kás a részecske által szimbolizált szennyezőanyag mennyiségének vagy a rendszer-
ben található részecskék darabszámának véletlen-eloszlású csökkentését használni. 
Az időlépcsők végén egy-egy térrészben (elemben) található részecskék száma, az 
általuk szimbolizált szennyezőanyag mennyiség és a pórusok térfogata alapján szá-
mítjuk a koncentrációkat. 



82 

6. A modellszámítások adatrendszere 

Minden modell más és más, ezért a szükséges adatok is kis mértékben eltérhetnek 
egymástól. Jelen fejezetben röviden összefoglaljuk a szivárgási alapegyenlet és a 
transzport-egyenlet megoldásánál szükséges adatrendszer kialakításának, ellenőrzé-
sének és hibáinak legfontosabb elméleti vonatkozásait. 

6.1. A hidrodinamikai és transzportmodellek adatigénye 

6.1.1. A hidrodinamikai modell adatigénye 
A hidrodinamikai modellszámítás során a cél a szivárgási sebességek meghatározása, 
ezért a modellezett térben a hidraulikus potenciál, azaz a nyomásszint értékek meg-
határozására törekszünk, aminek ismeretében a szivárgás sebessége - feltételezve, 
hogy a szivárgási tényező értéke ismert - a Darcy-törvény segítségével meghatároz-
ható. A számítások során a terület vízmérlegét szükséges meghatározni, aminek az 
elemeinek számításához az alábbi paraméterek ismeretére van szükség: 

− a vízadó és vízzáró képződmények geometriája; 
− az áramlási közeg hidraulikus vezetőképességét leíró közegjellemzők: szivárgási 

tényező vagy transzmisszivitás; 
− a közegben a víz tárolódását befolyásoló, a tárolt vízmennyiség megváltozása és 

a nyílt tükrű rendszer esetén a vízszintváltozás, zárt tükrű rendszer esetén a nyo-
másváltozás közötti összefüggést meghatározó paraméterek: hézagtényező vagy 
hézagtérfogat, szabad hézagtérfogat, fajlagos hozam, tárolási tényező és fajlagos 
tárolási tényező; 

− a rendszerben található források és nyelők, mint például az injektáló kutak vagy 
vízkivételek helye, hozama és a kúthozamok időbeli változásai; 

− a függőleges vízforgalom meghatározásához szükséges jellemzők: a felszín alatti 
vizeket tápláló beszivárgás intenzitásának mértéke, amit maradó beszivárgásnak 
is neveznek, a szomszédos víztartókkal való kommunikáció során történő hozzá-
folyás vagy elfolyás hozama, vagy azok meghatározásához az említett vízadók 
nyomásszintje, annak időbeli változása, valamint a rétegeket elválasztó féligát-
eresztő réteg, vagy rétegösszlet függőleges irányú szivárgási tényezője, 

− a felszín alatti vízek vízszintjét befolyásoló felszíni vízfolyások és tavak mértékadó 
vízszintjei, mederfenékszintje, a kolmatált zóna vastagsága és vízáteresztő képessége. 

A fenti jellemzőknek az adott modell határain belüli térbeli és időbeli változásait az 
alapadat-rendszernek tartalmaznia kell. Tekintettel arra, hogy a modell nem izolált, 
ezért annak határain anyagforgalom lehetséges, melynek mértékét az alábbi módo-
kon lehet felvenni (a számítás peremfeltételei): 
- a modell határán be- és kilépő hozamok és azok időbeli változása (Neumann-

típusú határ); 
- a modell határán a nyomásszintek és azok időbeli változása (Dirichlet-típúsú ha-

tár). 
- a környező nyomásszintektől függően változó hozammal jellemzett határ jellem-

zői (általános peremfeltétel (GHB)) 
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Mivel a számítások során nyomás- vagy vízszintváltozásokat kapunk, ezért az első 
közelítés számításához a nyomásszintek térbeli eloszlásának egy kezdeti időpontban 
való ismeretére is szükség van (kezdeti feltétel). 

6.1.2. A transzportmodell-számítás adatigénye 
A szennyezőanyag-terjedési számítások célja az időben változó koncentráció-
eloszlás meghatározása a modellezett térben az ismert áramlási sebességtérben a 
szennyezőanyagra és az áramlási térre jellemző terjedési tulajdonságok felhasználá-
sával. 
A szennyezőanyag-terjedés számításához a teljes modellezett térre vonatkozóan az 
alábbi alapadatok ismeretére van szükség: 

− a vizsgált szennyezőanyag(ok) szempontjából eltérő terjedési tulajdonságokkal 
jellemezhető testek (geológiai képződmények) geometriája; 

− a szivárgás átlagos lineáris sebessége (Darcy-féle sebességek) és iránya a poró-
zus közegben,  

− a szennyezőanyag szóródását diszperzióját meghatározó áramlási közeg-
jellemzők: mértékadó szemcseátmérő, effektív diffúzió-állandó, hidrodinamikai 
diszperzió-állandó vagy longitudinális és transzverzális diszperzivitás, szabad 
hézagtérfogat (az átlagos pórusbeli áramlási sebesség meghatározásához), a kö-
zeg száraz állapotban mért testsűrűsége; 

− az áramló közeg (szennyezőanyag) jellemzői: a folyadék sűrűsége, a diffúzió-
állandó vizes közegben mért értéke, a szennyezőanyag vízben való oldhatósága, 
a szennyezőanyagra vonatkozó megoszlási együttható vagy szorpciós izotermák, 
a szennyezőanyag bomlási együtthatója vagy a felezési idő; 

− telítetlen közegbeli szivárgás esetén a telítettség térbeli változásai;  
- szennyezőanyag-források és -nyelők adatai: a szennyezés pillanatnyi vagy tartós 

jellegének meghatározása, a vizsgált képződménybe jutó szennyezőanyag hoza-
ma (az adott forrás aktivitásának mértéke), pontszerű források vagy nyelők esetén 
a kitermelt vagy injektált szennyezett víz koncentrációja és hozama, tartós szeny-
nyezések esetén a forrás aktív működési periódusának vagy periódusainak megál-
lapítása. 

- peremfeltételek adatai: Dirichlet-peremfeltétel esetén akoncentráció állandó, ami 
megfelel a háttérterhelés értékének vagy zérusnak mennyiben a határ a szennye-
zés által nem érintett területet jelenti, egyébként lehet egy időben adott módon 
változó koncentráció érték. Neumann típusú határ esetén a határokon megadott 
hozamokhoz a szennyezőanyag-koncentrációját is meg kell adni. 

- Kezdeti feltételként egy tetszőleges kezdeti időpontban mért koncentráció-
eloszlás használható fel. 

6.2. A modellszámítások adatigényének kielégítése 

A modellszámítás egyik sarokpontja a megfelelő minőségű és megbízhatóságú adat-
rendszer kialakítása. A számítás során az adatgyűjtés során egy földtani, vízföldtani 
alapadat-rendszert alakítunk ki, amelynek felhasználásával készíthető el a modell-
adatrendszer. Az alapadat-rendszert fúrási rétegsorok, földtani szelvények terepi 
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vagy laboratóriumi mérési eredmények, térképek, légi és űrfelvételek, illetve azok 
dokumentációi alkotják. Az alapadat-rendszer alapján elkészített modell-
adatrendszer már az egyes modell-elemekre az alapadatok alapján valamilyen logi-
kai, matematikai, statisztikai úton származtatott értékeket tartalmazza. Az alap- és a 
modelladat-rendszer közötti legfontosabb különbség abban áll, hogy a modelladat-
rendszer már hipotetikus elemeket, a földtani, vízföldtani kép alapján meghatározott 
koncepción alapuló következtetéseket is tartalmaz, ami a modellezés végeredményét 
jelentősen befolyásolja. Amennyiben a kapott eredmények nem reprezentatívak vagy 
éppen helytelenek, akkor az alapadat-rendszer újraértelmezéséig kell visszamenni, 
majd annak alapján új koncepciót kell kidolgozni, aminek segítségével új modell-
adat-rendszert lehet kialakítani. 

6.2.1. A rendelkezésre álló adatok megbízhatósága, az alapadat-rendszer értékelé-
sének szempontjai 

A hidrodinamikai és transzportmodellezés során a teljes modellezett térrésben kije-
lölt valamennyi elemre meg kell határozni a víz szivárgását és a szennyezőanyagok 
terjedését meghatározó közegjellemzőket, illetve szennyezőanyag-specifikus tulaj-
donságokat. Az adatrendszer meghatározáshoz a területen korábban végzett földtani, 
vízföldtani kutatások adatai állnak rendelkezésre, amelyeket a felhasználás előtt cél-
szerű az alábbi szempontok figyelembevételével értékelni: 
Az adat származása, megbízhatósága. Az adat származásának és megbízhatóságának 
vizsgálata alatt a végzett mérések pontos dokumentációjának fellelhetőségét és az 
azok alapján a mért érték pontosságára levonható következtetések összességét értjük. 
Az adatrendszer kialakítása során előnyben kell részesíteni azokat a vizsgálati ered-
ményeket, melyek dokumentációjában az eredeti mérési adatsor is szerepel, illetve az 
annak felhasználásával kapott eredmény. Ilyen esetekben sor kerülhet a mért adatok 
szükség szerinti újraértékelésre, ellenőrzésére. Fontos adat a mérés pontosságára uta-
ló megjegyzés, esetleg a mérés körülményeinek, a használt eszközöknek a részletes 
leírása. 
A méréstechnika fejlődése. A vizsgálatokhoz felhasznált műszerek mind pontossá-
gukban, mind az általuk kínált szolgáltatások minőségében jelentősen fejlődtek az 
elmúlt évtizedekben. Egyes mérési eljárások abszolút pontossága jelentősen javult új 
elveken működő műszerek kifejlesztése miatt. Számottevő a fejlődés a mérési gyako-
riság terén, mivel a digitális adatgyűjtők elterjedése lehetővé teszi akár 5-10 másod-
percenként egy adott mérés elvégzését, amire korábban a kézi mérések során nem 
volt mód.  
A mérések kiértékelésének fejlődése. A kapott pontosabb és sokszor sokkal nagyobb 
számú mérési eredmények kiértékelése terén áttörést jelent a számítógépes adatfel-
dolgozás megjelenése. A mért értékek közül a kiugró – és ezért feltehetően téves – 
adatok kiszűrhetők, nagy számításigényű inverz számítások végezhetők el. Ugyanazt 
az adatsort emberi többletmunka nélkül sokféle kiértékelési módszerrel vizsgálha-
tunk, ami mind-mind a kapott eredmények nagyobb pontosságához, megbízhatósá-
gához vezetnek. 
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A mérési eljárás pontossága, közvetett vagy közvetlen jellege. A meghatározott pa-
raméterek pontosságát erősen befolyásolja az alkalmazott eljárás közvetett vagy köz-
vetlen jellege. Közvetett eljárásnak tekintjük, amikor egy képződménynek valami-
lyen tetszőleges fizikai vagy kémiai tulajdonságát mérjük, majd annak alapján egy 
másik megismerendő tulajdonságára következtetünk. Például ilyen módon közvetett 
módszerek geofizikai mérések, ahol pl. fajlagos ellenállási adatok alapján anyagi 
minőségre (pl. agyag, iszap, homok, kavics), esetleg szivárgási tényezőre következte-
tünk. Közvetlen ezzel szemben például a szivárgási tényező meghatározása akár pró-
baszivattyúzással, akár laboratóriumban permeabiméteres kísérlettel. A közvetlen 
méréseket jobban megbízhatónak tartjuk és ilyen szempontok alapján a felszíni (pl. 
szeizmikus vagy elektromos módszerek) vagy fúrólyuk (karottázs) geofizikai vizsgá-
latok eredményeit, azok közvetett jellege miatt, elsősorban a területi eltérések és ten-
denciák kimutatására, mintsem a mérési értékek közvetlen felhasználására célszerű 
felhasználni, szemben például a zavartalan magminták laboratóriumi vizsgálati ered-
ményeivel.  
A paraméter meghatározhatóságának pontossága. A modellekben használt paramé-
terek meghatározhatósága egymástól jelentősen eltér. Jellegzetes például a szivárgási 
tényező meghatározásának bizonytalansága, ahol a különféle (terepi, laboratóriumi 
és számításos) meghatározási módszerekkel kapott eredmények gyakran akár nagy-
ságrendileg is különbözhetnek egymástól. Ezzel szemben például a víz- vagy nyo-
másszintek, hőmérsékleti értékek, elektromos vezetőképesség, vagy pH értékek 
meghatározásánál a mérési értékek hibája - a transzportmodellezés szempontjából - 
gyakorlatilag elhanyagolható. Amennyiben nagy meghatározási bizonytalanságú pa-
raméterek adatrendszerét alakítjuk ki törekedni kell arra, hogy azonos módon megha-
tározott adatokból vonjunk le következtetéseket. 
A mérési érték által jellemzett terület nagysága. Az értékelés során lényeges kritéri-
um a mért érték által jellemzett térrész nagyságának értékelése. A térrész korlátozód-
hat: 
- az adott (mag)mintára, ilyen eset például a szivárgási tényező meghatározása 

permeabiméterrel, vagy szemeloszlásból; 
- az adott fúrási pont által jellemzett függélyre, pl. a rétegvastagság, a nyugalmi 

nyomás szintje stb.;  
- az adott mintavételi hely (fúrás, kút) közvetlen közelére, pl. kutak próbaszivattyú-

zásából származó hidraulikai információk;  
- egy vizsgált szelvényre, pl. geoelektromos mérési szelvény, kutatóárok stb. 
- a vizsgált terület egy nagyobb, általában pontosan nem is lehatárolható részére, 

mint pl. rövid ideig tartó nyomjelzéses vizsgálat az szivárgás irányának és sebes-
ségének meghatározására, vagy elektromos geofizikai szelvényezés eredményei; 

- a vizsgált területen belüli több négyzetkilométer nagyságú régiójára, ilyen pl. a 
nyomjelzéses vizsgálatok eredményei karsztos beszivárgási területek és források 
összefüggéseinek vizsgálatára, vagy a regionális nagymélységű geofizikai vizsgá-
latok, medencealjzat-kutatás szolgáltatta eredmények. 

Az, hogy milyen térrészre korlátozott mérések eredményeit használjuk fel, ez az 
adatrendszer felépítési koncepciójától, illetve a modellezési feladattól is függ. Kevés 
adat esetén, néhány geofizikai szelvény által szolgáltatott kisebb pontosságú, de ho-
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mogén eloszlású és minőségű adatrendszer pontosabb modellezési eredményhez ve-
zethet, mint az adott területen található egyetlen fúrásban végzett néhány vizsgálat 
eredményeinek kiterjesztése a modellezett térre. 
A mérési értékek térbeli eloszlása. A reprezentatív adatrendszer kialakítása megköve-
teli, hogy a rendelkezésre álló mérési eredmények térbeli eloszlása arányos legyen az 
adott térségnek a számítási eredményekre gyakorolt hatásának mértékével. Pl. egy 
vízbázis hidrodinamikai vizsgálata során a megfelelő eloszlású mérési hálózat azt 
jelenti, hogy a kút vagy kútcsoport közelében több, távolodva egyre kevesebb mérési 
pont található. A mérési pontok helyének optimális eloszlását a kutatáskor követendő 
elvek jelölik ki, melyek a fokozatosság, az egyenletes megismerés, a teljesség, a gaz-
daságosság és az optimális kockázat vállalásának elve. A mértékadó modell-
adatrendszer kialakításakor azon adatok, mérések, vizsgálatok felhasználására kell 
törekedni, amelyek az említett elveknek a leginkább megfelelnek. 
A mérési értékek időbelisége. Mind a hidrodinamikai, mind a transzportmodellezés 
során alkalmazunk olyan paramétereket, melyek időben pl. a nyomásszintek, a kon-
centrációk, a telítettség stb. függvényében változhatnak. Ugyancsak használunk 
olyan elemeket a rendszerekben, melyek véletlenszerűen, vagy bizonyos törvénysze-
rűségek szerint változnak, pl. folyók vízszintjei, kutak hozama, a meteorológiai vi-
szonyoktól függő talajvízbe történő beszivárgás, stb. Ezen paraméterek esetében kü-
lönösen fontos egy hosszabb periódus vizsgálata, annak érdekében, hogy a paraméter 
időbeli változásának törvényszerűségeit, vagy statisztikai jellemzőit megismerhes-
sük, amihez minél hosszabb adatsorok ismeretére van szükség. Ugyanilyen fontos 
néhány speciális helyzet idősorának ismerete, pl. egy folyó esetében egy hirtelen 
áradás hatására bekövetkező talajvízszint-változások ismerete vagy egy hirtelen be-
következett szennyeződés esetén kialakult koncentrációk adatsora az eltelt idő függ-
vényében. Ezen időben változó folyamatok nyújtanak lehetőséget arra, hogy a közeg 
tulajdonságait mind jobban megismerhessük, ezáltal a modell reprezentativitását nö-
veljük.  
A felsorolt szempontok alapján értékelt adatokból egy olyan ellentmondásmentes 
alapadat-rendszer kialakítására kell törekedni, ami a legmegbízhatóbb adatokon ala-
pul, megfelel a kutatási elveknek, valamennyi rendelkezésre álló földtani, vízföldta-
ni, geofizikai és környezettani ismerettel összhangban áll. A tapasztalat azt mutatja, 
hogy még a legjobban feltárt területek vizsgálata esetén is rákényszerülünk kevésbé 
megbízható mérési eredmények, becsült értékek alkalmazására. Tekintettel arra, 
hogy a számítási eredmények reprezentativitása nem haladhatja meg az alapadat-
rendszer reprezentativitását, ezért az alapadat-rendszer felépítése során a legnagyobb 
körültekintéssel kell eljárni. Az adatrendszer esetleges ellentmondásainak kiszűrésé-
re, a kevésbé jellemző, esetleg hibás adatok korrekciójára a modellek kalibrációja 
során nyílik lehetőség. 

6.2.2. A modell-adatrendszer kialakítása 
A modell-adatrendszer kialakítása során az alapadat-rendszer elemeinek felhasználá-
sával egy modellezési stratégiát állítunk fel. A stratégiát szokás modellezési koncep-
ciónak is nevezni. A modellezési koncepció alapvetően határozza meg a számítási 
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eredményeket, ugyanakkor szabályokba foglalni a teendőket nem lehet. A modelle-
zési koncepció kialakításánál döntő a modellező személy tapasztalata, jártassága a 
felszín alatti vizek áramlástanában, az alkalmazott kémiában, a számítástechnikában, 
az alkalmazott matematikában (numerikus módszerek alkalmazása területén) és még 
számos további részterületen. A modellezési stratégia kialakításának részletei a gya-
korlati hidrodinamikai és transzportmodellezés témakörébe tartozik, ezért ezt a ké-
sőbbiekben tárgyaljuk és itt csak a modelladat-rendszer kialakításának elméleti vo-
natkozásaival, metodikájával foglalkozunk.  
A modell-koncepcióval szemben általános elvárás, hogy a számítások során a való-
ságot a lehető legjobban leírja. A modellezési stratégiának részét képezi 
- a vizsgálandó térdimenziók számának meghatározása, 
- az alkalmazandó matematikai módszer kiválasztása (analitikus, fél-analitikus, 

numerikus), 
- analitikus módszer alkalmazása során az egyszerűsítő feltevések vizsgálata, azaz 

az analitikus megoldás adatigényének meghatározása, 
- numerikus módszer alkalmazása során a modell térbeli szakaszolásának kialakí-

tása, az elemek méretének, alakjának, tájolásának eldöntése, a modellezendő ré-
tegek számának meghatározása, 

- az egyes elemekhez - az alapadat-rendszer adatainak felhasználásával - reprezen-
tatív értékek hozzárendelési módjának megfogalmazása, 

- a fellépő numerikus hibák kezelési stratégiája,  
- a modell kalibrálására alkalmas adatok és szcenáriók számbavétele és előállítá-

sa. 
Analitikus számítás esetén minden - a nyomásszint vagy koncentráció-eloszlást befo-
lyásoló - tényezőt egy-egy adattal, ritkábban egy lineáris összefüggéssel kell jelle-
mezni, amely az alkalmazott képlet egy-egy állandóját jelenti. Ilyen esetben a követ-
kező lehetőségek közül választhatunk: 

− kiválasztjuk a vizsgált területhez legközelebb eső mérési értéket és azt használjuk 
fel. Erre leginkább adathiányos területeken kerül sor, vagy olyan esetben amikor 
az adott paraméter egy nagyobb területre jellemző átlagos érték (pl. egy kútcso-
port termelési vizsgálatából származó szivárgási tényező) áll rendelkezésre;  

− a vizsgálat által érintett területen belül (általában a létesítmény hatóterületén be-
lül) fellelt értékeknek matematikai átlagát képezzük: 
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== 1 ,          (6.1.) 

ahol p a vizsgált paraméter, np az adatok száma és p az átlagérték. 
− vagy súlyozott átlagát képezzük; 
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1 , ahol wi az adott értékre vonatkozó súly-érték.   (6.2.) 

- a vizsgált területen belül fellelt mérési eredmények statisztikai értékelése alapján 
a legjellemzőbb értéket pl. egy adott gyakorisági szintet meghaladó vagy egy 
adott tartóssághoz tartozó értéket veszünk fel. Ez a megoldás csak megfelelően 
nagyszámú adat esetén lehetséges. 

Bármelyik módszerrel is történjék a konstansok meghatározása mindig marad egy 
bizonytalanság a számításban, azaz a minimális kockázatvállalás elve ritkán érvénye-
sül. Indokolt, ezért – különös tekintettel arra, hogy ezek a számítások igen gyorsan 
elvégezhetők – az egyes számításokat nemcsak a legvalószínűbb értékekkel, hanem a 
reálisan előforduló minimális és maximális értékekkel is elvégezni, mert ezzel a gya-
korlatilag lehetséges eredmények intervallumát is meg tudjuk határozni. Az egyes 
számítási eredmények összevetésével még a számítások egyes paraméterekre való 
érzékenységét is megvizsgálhatjuk. 
Numerikus számítás esetén a felvett modell minden egyes elemére vonatkozóan meg 
kell adni a transzportegyenletben szereplő paramétereket. Ilyen esetben a két lehető-
ségünk van: a zónák kialakítása vagy az egyes elemekhez értékek hozzárendelése, 
amit diszkretizálásnak nevezünk. 
A teljes modellezett térrészt egy adott tulajdonság szempontjából egyforma elemeket 
tartalmazó csoportokra bontjuk, melyeken belül az adott paraméter értékét az analiti-
kus módszernél felsorolt lehetőségek közül választva határozzuk meg. Ezt az eljárást 
zónák kialakításának nevezzük. Ennek a megoldásnak egy speciális esete, amikor az 
adott paraméterre egy darab zónát alkalmazunk, ekkor az adott paraméter szempont-
jából nem használjuk ki a numerikus számítások adta térbeli változékonyság model-
lezésének lehetőségét, azaz a paramétert állandónak tekintjük. 
Az adott helyeken ismert paraméterekre (mérési eredmények, származtatott adatok) - 
egy statisztikai vagy matematikai alapokon nyugvó interpolációs eljárás segítségével 
- folytonos felületet (térgörbét) illesztünk. Ennek a felületnek az adott modellelem 
helyén felvett értékét tekintjük a keresett paraméternek. A leírt folyamatot 
diszkretizálásnak nevezzük. 

6.2.2.1. A zónák kialakítása 
A pontszerű mérési, észlelési értékek térbeli kiterjesztésére talán a legkézenfekvőbb 
módszer az állandó paraméterekkel jellemezhető térrészek, zónák kialakítása. A zó-
nákat magyar szakirodalomban előforduló mérnökgeológiai test, illetve vízföldtani 
egység kifejezések egy speciális értelmezésének is tekinthetjük, azonban a térrészek 
elnevezésénél az angol és német nyelvű irodalomban meghonosodott elnevezést vet-
tük át. 
A zónák kialakítása során két problémát kell megoldani: 
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− az egyes zónák térbeli helyzetét (méretét és alakját) kell meghatározni, azaz a 
teret fel kell osztani egy-egy paraméterrel jellemezhető térrészekre; 

- meg kell becsülni a kijelölt zónákra jellemző értékeket. 
 

A zónák elhelyezkedésének meghatározása általában földtani, vízföldtani alapokon 
nyugszik, egy zóna jelenthet egy jellemzően homogén képződményt, vetőkkel hatá-
rolt területeket, eltemetett folyómedreket stb. Fontos következtetéseket lehet levonni 
a földtani környezet kialakulásának ismerete alapján, például az egyes képződmé-
nyeken belül további térrészek különíthetők el, esetleg a képződmény adott paramé-
ter szempontjából történő változásának trendje lehet ismert, mint pl. egy víztartó 
képződmény elagyagosodása. A szemcseméret-eloszlás tendencia jellegű változásá-
nak ismeretében, a szivárgási tényező térbeli eloszlását néhány támpontot szolgáltató 
mérési adat segítségével - a modellezés szempontjából nagy területre - meg lehet 
becsülni. 
Az egyes zónákra jellemző értékek meghatározása történhet bármely korábban felso-
rolt módszerrel, valamint a későbbiekben - a modell-kalibráció egyik lehetséges 
módszereként - bemutatott inverz számítási eljárásokkal.  
A zónaalkotás legnagyobb hibája, hogy a zónák határán egy, de általában több para-
méter ugrásszerűen változik, meg, mert például a szivárgási tényező változása, 
együtt jár a szabad hézagtérfogat és fajlagos hozam változásával, aminek következ-
tében a szomszédos elemek közötti víz- vagy szennyezőanyag-forgalom hatására 
ugrásszerű nyomásszint vagy koncentráció-változások következnek be. Ez a stabili-
tási hibákra érzékeny, általában kevés tárolt vízmennyiséggel jellemezhető model-
leknél instabilitáshoz, illetve oszcillációhoz vezethet. 

6.2.2.2. A diszkretizálás 
Amennyiben ismert a vizsgált terület több pontján egy adott paraméter értéke, akkor 
ezekre a pontokra matematikai eljárások felhasználásával folytonos térfüggvényeket 
lehet fektetni, amelyek a módszertől és az adatok térbeli eloszlásától függő mérték-
ben közelítik a keresett paraméter térbeli eloszlását. Ugyancsak lehetséges a meglévő 
pontokból interpoláció segítségével az adott elemre vagy csomópontra közelítő érték 
meghatározása. 
A modellezés során használt interpolációs eljárások sajátossága, hogy –tekintettel 
arra, hogy valamennyi modellelemre szükséges az ismert értékeken alapuló érték-
becslés elvégzése, ezért – az interpolációs módszernek alkalmasnak kell lennie szük-
ség esetén extrapolációra is, amennyiben a kiindulási adatok mind a diszkretizálással 
érintett, modellezendő területen belül helyezkednek el. Nem engedhető tehát az meg, 
hogy a módszer ne számítson értékeket bármely pontra, még akkor sem, ha az extra-
polációval kapott értékek megbízhatósága erősen megkérdőjelezhető. 
Az eljárás alkalmazása során előre meghatározott diszkrét pontokban (a végeselem 
háló csomópontjai, a véges differencia háló rácspontjai vagy az elemek középpont-
jai) az ismert helyekhez (fúrások, kutatólétesítmények helyei) rendelt ismert paramé-
terértékekből interpolációval határozzuk meg a keresett paraméter értékét. Az inter-
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poláció során feltételezzük, hogy a kiválasztott pontban a keresett paraméter értéke a 
legközelebb eső adatokból származtatható, azaz nem véletlen jellegű. 
Valamennyi interpolációs eljárás esetén szükséges n darab pontban, melynek koordi-
nátái (x1,y1), (x2,y2),… (xn,yn), az interpolálandó mennyiség értékeit (z1, z2, …, zn) 
ismerni. Az interpolációhoz általában a legközelebbi pontokat veszik figyelembe, 
melyeknek egy kettős kritériumrendszernek kell megfelelniük: egyrészt a vizsgált 
ponttól mért abszolút távolságot, másrészt a vizsgált ponthoz viszonyított elhelyez-
kedést veszik figyelembe. Ez utóbbit térnegyedekre vagy térnyolcadokra való osztás-
sal, amit kvadráns vagy oktáns keresésnek hívunk (47. ábra). Ezután az interpoláció-
hoz az egyes térnegyedekbe vagy térnyolcadokba eső legközelebbi n pontot vizsgál-
ják. Amennyiben a vizsgált ponthoz viszonyított helyzete nem veszik figyelembe, azt 
egyszerű keresésnek nevezik. 
Az interpoláció kezdetén meghatározzuk az interpoláció során felhasználandó adatok 
minimális számát, valamint azt a távolságot, melyen belül a paraméterek nagysága 
közötti kapcsolat feltételezhető. Kiindulva abból a feltételezésből, hogy az egymás-
hoz közeli helyeken a vizsgált paraméterek hasonlítanak egymáshoz, a két pont kö-
zötti távolság növekedésével kell lennie egy olyan pontnak, amikortól kezdve a két 
érték függetlenné válik, ezt hatástávolságnak nevezik. Ezután a rácsháló valamennyi 
pontjára a legközelebbi, hatástávolságon belüli adatok felhasználásával, - a követke-
zőkben felsorolt módszerek valamelyikével - a keresett értéket meghatározzuk.  
A leggyakrabban alkalmazott interpolációs módszerek a minimális görbület módsze-
re, a lineáris interpoláció, a Renka-kódszer, a Shepard-módszer, a távolsággal fordí-
tottan arányos súlyozott korrigált átlagszámítás, a radiális bázisfüggvény módszere, a 
krigelés. A módszerek részletes ismertetését az alkalmazott matematikai, 
geostatisztikai szakkönyvek (STEINER, 1990.; de MARSILY, 1986) és a kapcsoló-
dó szoftverek felhasználói kézikönyvei (KECKLER, 1995., PANNATIER , 1996) 
részletesen tartalmazzák. 

kvadráns kereesés oktáns keresés

 
47. ábra 

A kvadráns és az oktáns keresés elve 
(in ed: CLAUSER, 2003) 



91 

6.2.3. Az adatrendszer méretének optimuma 
A modell adatrendszerének abszolút nagysága az elemek és csomópontok számától 
függ, ugyanakkor egy adatrendszer kezelhetőségét, átláthatóságát nagyon megköny-
nyíti, ha trendek, tendenciák, földtani és vízföldtani megfontolások alapján a külön-
böző paraméterek darabszámát lecsökkentjük. PECK és szerzőtársai (1988) elméleti 
vizsgálata rámutatott, hogy pl. egy 1200 elemből álló síkmodell (30 × 40 elem) ese-
tén a számítások összesen egy kb. 38 000 egymástól különböző, bemeneti adatot kí-
vánnának meg, aminek a számát a gyakorlatban 4 és 5 000 közé lehet csökkenteni 
geológiai, vízföldtani háttérinformációk és a jellegzetes tendenciák ismeretének bir-
tokában. 
Az egymástól eltérő adatok számának csökkentésével ugyanakkor problémák is fel-
merülnek. Minden numerikus modell stabilitását csökkenti, amennyiben az egyes 
elemek között bármelyik paraméter tekintetében jelentős nagyságbeli változások 
vannak. Éppen ezért nem célszerű a bemeneti adatok számát nagymértékben csök-
kenteni, mert akkor az a nagymértékű diszkontinuitások miatt akár a modell instabili-
tásához is vezethet. A mai technikai szint mellett előnyösebb a nagyobb területen 
állandónak tekintett paraméterek helyett, a bemutatott geostatisztikai módszerek al-
kalmazásával a természetes folyamatokat jobban követő fokozatos átmenetekkel kö-
vetni az egyes paraméterek változásait. 
Az egymástól eltérő adatok számának meghatározásánál, azaz a megengedhető egy-
szerűsítések eldöntésénél egy optimalizálási folyamatot kell elvégezni, melyek azok 
a területek a modellben, és milyen paraméterek tekintetében, ahol zónák kialakítása 
az átláthatóságot növeli, ugyanakkor várhatóan instabilitást sem okoz, és milyen pa-
raméterek esetében célszerűbb inkább az interpolációkkal számított térfüggvények 
használata. Általános érvényű megoldás ebben a tekintetben nincsen, ugyanakkor a 
zónák vagy a diszkretizálás használatakor a következő tényezőket lehet – a teljesség 
igénye nélkül - figyelembe venni: 
- a mérési értékek (ismert pontok) száma és eloszlása, 
- a paraméter változékonysága abszolút értelemben és a modellezett területre vo-

natkozóan, 
- a paraméter térbeli változékonyságára vonatkozó tendenciák ismerete, 
- a paraméter és egy másik, jobban ismert paraméter korrelálhatósága, 
- a paraméter meghatározhatóságának biztonsága, 
- a paraméter hatásának mértéke a víz- vagy szennyezőanyag-mérlegre és ezáltal a 

végeredményekre. 

6.3. A modell-adatrendszer hibáinak okai és jellegzetességei 

Mivel a modell-adatrendszer lokális mérési értékek sokaságán alapul számos hibát 
rejthet. A továbbiakban - a teljesség igénye nélkül - áttekintjük a lehetséges hibák 
okait, valamint azok néhány általános, jellegzetes tulajdonságát. 
A modell-adatrendszerek hibáinak három jellegzetes oka (PECK et al., 1988.):  

− a felvett paraméterek önmaguk hibásak, vagy nem reprezentatívak; 



92 

− a származtatott értékek a számításhoz felhasznált mérési értékek hibáit továbbvi-
szik (a hibák átöröklődése); 

− a modell általánosítása, egyszerűsítése során kialakított zonális jellemzők - a 
zónán belüli helyes mérési eredmények ellenére - nem reprezentativak.  

 

A hibák átöröklődése. SACHER (1983.) vizsgálataiban a hibák átöröklődési folya-
matát, mint egy, a mérőműszer pontatlanságából eredő, majd a mérés és a jellemző 
paraméter becslésekor továbbnövekvő hibát jellemezte, ami végül az átlagos - várha-
tó - modell-eredménytől eltérő végeredmény létrejöttéhez vezet (48. ábra). Ez a hi-
baöröklődési lánc - közvetett információk esetén - tovább bővül a nyert információ 
interpretációjának pontatlanságaira visszavezethető hibákkal. 
 

Átlagérték

Aktuális 
mérési érték

Észlelt (mért)
érték

A paraméter becsült
értéke a modell-elemben

Aktuális 
becslési érték

Aktuális mérési hiba

Mérési hiba szórása

Mérõmûszer 
pontatlansága

Modell-eredmény

Aktuális
modell-eredmény

Átlagos 
modell-eredmény

Átlagos becslési érték

 
48. ábra 

A hibák átöröklődésének sémája MEHRA, 1978 és MCLAUGHLIN, 1978 nyomán 
(SACHER, 1983) 

 

A mérési hibák hatása. A mérési hibák hatását ún. paraméter-érzékenységi vizsgálat-
tal (input sensitivity analysis) lehet követni, amelyet numerikus módszerek alkalma-
zása esetén a bemutatott séma szerint végezhetünk el (49. ábra). Először előállítunk 
egy bázis-adatrendszert és az adott számítási módszerrel elvégezzük a bázis-
szimulációt. Ezután a bázis adatrendszert a tapasztalt mérési eredmények tartomá-
nyában fokozatosan módosítva újabb számításokat végzünk. A kapott eredmények és 
a bázis-szimuláció eredményének összehasonlítása alapján megállapítható a vizsgált 
modell adott paraméterrel szembeni érzékenysége (HEIDERMANN, 1986.). 
A paraméterhibák jellegzetességei. A paraméterhibákat a mérési pontatlanságok, va-
lamint a mért értékek alapján adathiányos területekre származtatott értékek pontat-
lanságai okozzák. Ezeket a hibákat mérési vagy észlelési, valamint regionalizálási 
(kiterjesztési) hibáknak is nevezik (WINTER, 1981). A paraméterhibák jellegzetes 
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formáit tekintsük át abban az egyszerű esetben, amikor a modellezett térben kevés 
mérési érték áll rendelkezésre (SMITH, 1981.): 

 

Bázis-szimuláció
elvégzése

Alapadatrendszer variánsok 
eredményeinek számítása 
numerikus módszerekkel

Bázisszimuláció és a variánsok
eredményeinek összehasonlítása,

kiértékelése

Bázis-adatrendszer
kialakítása

Adatrendszer variánsok 
kialakítása

  
49. ábra 

Egy alapadat-érzékenységi vizsgálat menete 
HEIDERMANN (1986) 

 

Legyen egy tetszőleges modell-paraméter változása, egy kiválasztott szelvény men-
tén öt pontban mért értékekkel adott (50. ábra:a). Ilyen esetben a modellezés során 
először az döntendő el, hogy tekinthető-e a képződmény az adott jellemző mennyiség 
szempontjából homogénnek, esetleg további zónákra bontva, az egyes régiókra jel-
lemző mennyiséget lehetséges-e állandónak tekinteni. A 50. ábra:b folytonos vonala 
jelzi az első esetet, amikor a mért értékek átlagát tekintettük jellemzőnek a teljes mo-
dellezett zónára. A szaggatott vonalak arra az esetre vonatkoznak, amikor a szelvény 
menti értékek alapján két egymástól eltérő zónára bontottuk a vizsgált területet, de 
azokon belül a vizsgált jellemző állandónak tekinthető. 
Azt, hogy a két modellfeltevés közül melyik a helyesebb, azt a mérések pontosságá-
nak ismeretében lehet eldönteni. A 50. ábra:c a függőleges nyilai a mérési eredmé-
nyek pontosságát jelzik. A folytonos nyilakkal jelölt nagyobb pontosságú mérések 
esetén jogos a több zónára bontás, míg a szaggatott nyilakkal ábrázolt alacsonyabb 
pontosságú mérések esetén az eltérést maguk a mérési hibák is okozhatják.  
A 50. ábra:d a mérési pontok sűrítésének esetét mutatja be. Látható a mérési-észlelési 
hálózat megfelelő megválasztásának fontossága az adott paraméter változékonyságá-
nak függvényében. Az ábrázolt esetben az öt észlelési pont szolgáltatta adatrendszer 
nem reprezentálja megfelelően a paraméter szelvény menti változását. A nem megfe-
lelően megválasztott, térben és időben értelmezett mérési-észlelési gyakoriság a 
transzport-modellezés során elkövetett adathibák egy jelentős forrása (PECK et al., 
1988.). 

6.4. Az alapadat-rendszer ellenőrzése 

Mint ahogy az a modelladat-rendszer hibái okainak felsorolásánál látszik a hibák 
triviális oka az alapadatok saját hibája és a reprezentativitás hiánya. Amennyiben az 
alapadat önmagában hibás, az sokszor már az adatfeldolgozás és értékelés során fel-
tűnik, de legkésőbb a modell első futtatásainak eredményei alapján felderíthető.  
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50. ábra 

A paraméterhibák kialakulása (SMITH nyomán) 
(PECK et al., 1988) 

 

Sokkal nehezebb a nem kellő reprezentativitás kiszűrése, aminek legismertebb mód-
szere a krigeléssel való kereszt-ellenőrzés, melynek angol neve: cross-validation, a 
szakirodalomban meghonosodott. A módszer alapgondolata, hogy amennyiben az 
adatrendszer reprezentatív és ellentmondásmentes, akkor egy ismert ponton mért 
vagy észlelt érték a többi adatból származtatható. Ezért az n észlelési pontot tartal-
mazó rendszerben egymás után egy-egy pontot kiválasztva a további n-1 észlelt érték 
felhasználásával becslést végzünk a kitüntetett pontra. Az észlelt érték és a becsült 
érték alapján a pontokra külön-külön varianciát számolunk, majd térképen ábrázol-
juk. Azokon a területeken, ahol az észlelési pontok száma alacsony, vagy a mért ér-
tékek inhomogén minőségűek, a variancia-értékek kiugróan magasak lesznek, így 
ezeken a területeken esetleges további észlelésre vagy adatgyűjtésre lehet szükség. 
Természetesen magas variancia-értékeket okozhat az adott paraméter hirtelen, eset-
leg kiszámíthatatlanul szeszélyes megváltozása, ilyenkor a cross-validation módszer-
rel egyes területek kizárhatók a statisztikai vizsgálatból. 
Az ellenőrzés másik lehetséges módja különböző vizsgálatok alapján kapott értékek 
grafikus ábrázolása. Amennyiben például szivárgási tényező-értékekkel rendelke-
zünk permeabiméteres kísérletekből és laboratóriumban meghatározott szabad hé-
zagtérfogat vagy próbaszivattyúzásból kapott fajlagos depresszió értékekkel rendel-
kezünk ezeket egymás függvényében ábrázolva a kiugró értékeket ki lehet szűrni. 
Figyelni kell azonban arra, hogy ezen esetekben az érték eltérését egy, a vizsgálat 
során nem figyelembe vett tényező (pl. a kútkiképzés minősége) is okozhatja. 
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7. A modellek kalibrációja 

A modellek kalibrációja az a folyamat, amellyel azt érjük el, hogy a modell és a va-
lóságos rendszer azonos külső hatásokra, ingerekre egymáshoz legjobban közelítő 
válaszokat szolgáltasson (51. ábra). A szennyezőanyag-terjedési modell kalibrálása 
tehát egy sokparaméteres optimalizálási feladat, melynek során törekszünk a mo-
dellparaméterek és peremfeltételek egy olyan együttesének kialakítására, melyben az 
adott transzport-jelenség a legnagyobb valószínűséggel fog megfelelni a valóságban 
lezajló folyamatoknak (HEIDERMANN, 1986.).  
 

Valós rendszer

Kiértékelés és
optimalizálás

Modell

Paraméterek 
megváltoztatása

Valós válasz

Modell-válasz

Bemenõ jel
(inger)

 
51. ábra 

A paraméterbecslés sémája 
HEIDERMANN (1986) 

 

A kalibráció fogalmát másképpen is meg lehet közelíteni (van ROOY és 
ROSBJERG, 1988): Tekintsük az összes paraméter-variáns halmazát. Ennek egy 
részhalmaza azon variánsokat tartalmazza, amelyeket nem zár ki az adatgyűjtés so-
rán kialakított piezometrikus szintek eloszlása. Ugyanígy létezik egy olyan részhal-
maz is, amely megfelel a tapasztalt szivárgási tényező, illetve transzmisszivitás stb. 
eloszlásának. Természetesen az a részhalmaz is meghatározható, amelyet a tapasztalt 
koncentráció-eloszlás alátámaszt, és hasonlóképpen minden ismert paraméter-elosz-
lás által megengedett paraméter-variánsok részhalmaza is meghatározható. Mindezek 
után a paramétereknek keresett, "valósághű" variációja a meghatározott részhalma-
zok metszetében található. Minél több paraméterre történik meg a lehatárolás, annál 
szűkebb körben kell a lehetséges optimumot keresni (52. ábra). 
A modellek kalibrációjának alapvetően két típusa van az inverz számításokon ala-
puló vagy más néven autokalibráció és a hagyományos úton való számítással végzett 
trial-and-error kalibráció. Jelenleg egyre nagyobb lehetőség van a modell-adatrend-
szerek és nagy egyéb célra készített adatbázisok, főképpen térinformatikai rendsze-
rek összekapcsolására, ami szintén felhasználható a modell-adatrendszer kalibrációja 
során. 
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52. ábra 

A lehetséges megoldások halmazának szűkítése a kalibrációnál 
(van ROOY és ROSBJERG, 1988) 

 

7.1. Az inverz számítási eljárásokkal végzett kalibráció 

A szivárgáshidraulikai modellezés során a piezometrikus szinteket számítjuk a hely, 
valamint az idő függvényében adott szivárgási tényező, transzmisszivitás, tárolási 
tényező stb. értékek mellett. A transzportmodellezés - hasonlóképpen - nem más, 
mint a koncentrációértékek számítása a hely és idő függvényében adott, szennyező-
anyag-specifikus terjedési jellemzők, szivárgási sebesség-mező, bomlási és adszorp-
ciós jellemzők esetén. Ebben az esetben tehát a nyomásszint-, illetve a koncentráció-
eloszlás tekinthető a függő változónak, azaz ismeretlennek, amit a többi paraméter 
függvényében határozunk meg. 
Az inverz kalibráció alapgondolata nem más, mint hidraulikai vagy transzport 
egyenletekbe ismert, időben állandó, vagy változó nyomásszinteknek, illetve kon-
centráció-eloszlásoknak, valamint azok idő és hely szerinti deriváltjainak a behe-
lyettesítése, és ezáltal egy máskor ismertnek tekintett paraméter (pl. szivárgási té-
nyező, transzmisszivitás, tárolási tényező, longitudinális vagy transzverzális 
diszperzivitás stb.) visszaszámítása. Másképpen közelítve meg az inverz eljárásokat, 
például keressük például azt vagy azokat a paraméter-eloszlásokat, amelyek esetén a 
valóságban észlelt koncentráció-eloszlás vagy szivárgási sebességtér kialakulhat. 
Az inverz számítási eljárás nemcsak a modellek kalibrációjára, hanem paraméter-
becslésre is felhasználható. A kutatás kezdeti fázisában történő modellezés esetén 
sokszor nem áll rendelkezésre megfelelő számban a szivárgási tényezőre vonatkozó 
adat. Ebben az esetben például az ismert talajvízszint-értékekből és azok időbeli vál-
tozásából a szivárgási tényező területi eloszlása - a nyomásadatok pontosságának és 
reprezentativitásának függvényében becsülhető. Szokás az inverz kalibrációt - az 
iterációs keresési algoritmus felhasználása miatt azonnal kapott végeredmény miatt- 
automatikus kalibrációnak, vagy egyszerűbben autokalibrációnak is nevezni. 
Az inverz számítások szükségesek, mert a gyakorlatban ritkán áll rendelkezésre 
olyan teljes alapadat-rendszer, amely az elvégzendő számítások adatigényét teljes 
mértékben kielégíti, ugyanakkor a hiányzó adatok in situ, illetve laboratóriumi méré-
sekkel történő pótlása időigényes és költséges. Ezen túlmenően léteznek olyan para-
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méterek is, mint pl. a tárolási tényező, a diszperzivitás, melyeknek közvetlen meg-
határozása körülményes és pontatlan, ezért ezen paraméterek meghatározásához az 
inverz számítási módszer nagy segítséget nyújthat.  
Az autokalibráció hibája, hogy az eredmények igen érzékenyek a potenciál-értékek 
(nyomásszintek és koncentrációk) hibáira. Mindez annak a következménye, hogy a 
hidrodinamikai modellben a transzmisszivitás, a tárolási tényező, stb. a nyomásnak 
az idő és a hely szerinti deriváltjai alapján számítható, így kis alapadat-hibák extrém 
nagy hibákhoz vezethetnek a számított paraméterekben, különösen azokon a terüle-
teken, ahol a hidraulikus gradiens kicsi (NEUMANN-YANKOWITZ, 1980.; 
McELWEE, 1982.).  
Tekintettel arra, hogy a diszperzivitás, a diszperzió-állandó, az effektív diffúzióál-
landó a koncentráció második deriváltja, ezen paraméterek tekintetében az inverz 
kalibráció már-már majdnem véghezvihetetlen, mert maga az inverz számítási algo-
ritmus is instabillá válik. Éppen ezért a gyakorlatban ezt a módszert a diszperzivitás-
értékek meghatározására nem használják. Elvi megfontolások alapján a közvetlen 
közelítés gyakorlati alkalmazása a késleltetés meghatározására szorítkozhat, ehhez 
azonban szükséges legalább két időpontban a teljes területre a koncentráció eloszlás 
ismerete, amely a gyakorlatban csak ritkán áll rendelkezésre. 
A hiba kiküszöbölésére elsősorban a terület minél kisebb számú zónákra történő osz-
tását javasolják, aminek megalapozottságát számos alkalmazás bizonyítja 
(EMSELLEMde MARSILY, 1971.; YEH et al., 1983). 
Az autokalibráció másik hibája, hogy a reálistól jelentősen eltérő eredményeket szol-
gáltat, amelyekkel ugyan az adott nyomás-, vagy koncentráció-eloszlás valóban 
megkapható, ugyanakkor az értékek irreálisak. Érzékeltetendő a problémát tekint-
sünk egy kutat, melyben adott hozam mellett adott depresszió alakul ki. Ez de-
pres??szió kisebb szivárgási tényező mellett nagyobb szabad hézagtérfogatot feltéte-
lezve is kialakulhat, ami a valósággal nem összeegyeztethető, hiszen nagyobb szi-
várgási tényező esetén nagyobb a szabad hézagtérfogat is, ugyanakkor az inverz 
számításnál a két eset elvileg egyenértékű eredmény.  
Az inverz számítási megoldások és programok (PEST és klónjai, UCODE stb.) az 
elmúlt időszakban sokat fejlődtek, ugyanakkor megbízhatóságuk, még sokáig nem 
fogja lehetővé tenni ellenőrzés nélküli alkalmazásukat. Minden „sikeres” inverz 
számítás után szükséges a kapott eredményeket a meglévő földtani és vízföldtani 
eredményekkel összevetni, és szükség esetén a számításokat eltérő induló paraméte-
rekkel újrakezdeni. 
Az inverz számítás az alkalmazástól függően lehet egylépcsős vagy többlépcsős ka-
libráció, illetve lehet szimultán kalibráció is. Egylépcsősnek tekintjük a kalibrációt 
ha csak a szivárgás alapegyenlete, vagy csak a transzportegyenlet alapján történik a 
vizsgált paraméter inverz úton történő meghatározása. Kétlépcsős kalibráció esetén 
pl. egy transzmisszivitás-eloszlást mind a nyomásszintek, mind a koncentráció-el-
oszlások alapján számítjuk (53. ábra). A szimultán kalibráció azt jelenti, hogy a 
transzport-egyenlet alapján a modell-adatrendszert mind a vízföldtani, mind a szeny-
nyezőanyag-terjedési jellemzők tekintetében egyszerre kalibráljuk. 
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Az összetett kétlépcsős kalibráció sémája 
(KEIDSER et al., 1990.) 

 

Bár az inverz számítások alkalmazása a gyakorlati modell-számítások során kezd 
elterjedni, ezek az alkalmazások mégis elsősorban a szivárgáshidraulikai paraméte-
rek meghatározására, kalibrálására vonatkoznak. A transzport-paraméterek inverz 
úton való meghatározása egyenlőre csak a tudományos kísérletekben kapott szerepet, 
aminek fontosabb okai (PECK et.al., 1988.): 

− az advektív-diszperzív transzportegyenlet megoldásának numerikus nehézségei; 
− az advektív -diszperziv transzportegyenlet alkalmazásának elméleti korlátai. 
A felsoroltakhoz hozzátehető, hogy a hazai gyakorlatban csak ritkán találkozunk 
olyan nagyságú és pontosságú adatrendszerrel, amely az inverz számítások hatékony 
alkalmazását lehetővé tennék. 

7.2. A trial-and-error módszer (közvetett közelítés) 

A közvetett közelítés során az eredeti egyenletekbe történik az ismeretlen paraméter 
behelyettesítése, mindaddig, amíg a paraméter fokozatos változtatása eredménye-
képpen a kapott koncentráció és nyomásértékek megközelítik a valóságban észlelt 
értékeket. Az explicit egyenletrendszer megoldása bármely, korábban ismertetett 
matematikai megoldással történhet. Ezt a módszert - mivel alapjában véve egyszerű 
próbálgatásról van szó - az angol irodalomból átvéve "trial-and-error" módszernek is 
nevezik.  
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A "trial-and-error" módszer az autokalibráció egyik legnagyobb hibáját küszöböli ki: 
Ez a megoldás ugyanis nem követeli meg a nyomás- vagy koncentrációértékek és 
azok deriváltjainak ismeretét a teljes modellezett térben, ami az autokalibráció pon-
tatlanságának legfőbb forrása. Az eljárás további előnye, hogy semmilyen különö-
sebb speciális matematikai eszköztárat nem igényel. 
 A trial-and-error módszer hátrányai: 

− Mivel a szimulált nyomás- és a becsült paraméterértékek közötti kapcsolat nem 
lineáris, ezért, az alkalmazás során optimalizálási algoritmusok nehezen alkot-
hatók a közelítés pontosságának növelésére. Az eljárást csak gyakorlott, a hidra-
ulikai és transzportfolyamatok összefüggéseit jól ismerő szakember tudja haté-
konyan alkalmazni.  

− A kalibráció igen munkaigényes, számítási oldalról nem hatékony. 
− Nincs lehetőség a kalibrált paraméterek pontosságának számszerűsítésére, arra 

csak a kapott és észlelt eredmények eltérésének nagyságából, illetve a 
hibanagyság területi eloszlásából következtethetünk. 

 

A trial-and-error módszer hátrányainak csökkentésére számos kísérlet történt. A 
megoldást egyfelől új programozási-optimalizálási algoritmusok kifejlesztése, más-
felől statisztikai számításoknak a kalibráció folyamatba történő illesztése jelentik.  
Az algoritmusok terén JACQUARD és JAIN (1965) nemlineáris optimalizálási tech-
nikát dolgozott ki a szimulált és észlelt nyomások különbségei négyzetének minima-
lizálására, melyet később az olajiparban az áteresztőképesség területi megoszlásának 
számítására többen sikeresen alkalmaztak. COATS és szerzőtársai (1970), valamint 
SLATER és DURRER (1971) a lineáris optimalizálási technikát továbbfejlesztették, 
azonban ez a megoldás csak az esetek szűk körében volt alkalmazható a nemlineáris 
jelleg gyakori dominanciája miatt. YEH (1975) új megoldás, az általa iteratív négy-
zetes programozásnak nevezett algoritmus bevezetését javasolta, melynek alkalma-
zását hipotetikus víztartókra be is mutatta. 
A gyakorlatban általában a trial-and-error kalibrációt alkalmazzuk elsősorban egy-
szerű kivitelezhetősége és kis számítógépkapacitás-igénye miatt. A trial-and-error 
kalibráció alkalmazása során előforduló váratlan modell-reakció rámutathat az adat-
rendszer hibáira, például egy - a Sajóládi Vízmű környezetében végzett - szimuláció 
esetén éppen a modell kalibrálása mutatott rá a Hernád folyón Bőcsnél található, ko-
rábban figyelmen kívül hagyott duzzasztás számottevő hatására (SZABÓ-KOVÁCS, 
1991).  
Tapasztalataink szerint, a trial-and-error módszer hatékonysága kisebb rétegzett tá-
rolók esetében. Ilyen esetekben egyes korrekciók hatása nemcsak az adott rétegben, 
hanem a környezőkben is változásokat indukál, melynek következményei nehezen 
követhetők, emiatt volt sikertelen a Gyöngyös-Atkári Vízmű védőidomának megha-
tározásához kialakított első 9 réteges numerikus modell (SZABÓ-KOVÁCS, 1994) 
kalibrációja. Ugyanezen a területen évekkel később felépített 29 réteges modell trial-
and-error kalibrációja ugyanakkor sikeresnek bizonyult egy többéves adatgyűjtő és 
feldolgozó munkát, a környező terület földtani ismereteit átfogó újraértékelést és to-
vábbi feltárást követően (GEOSERVICE, 1998-2000). A Gyöngyös-Atkári Vízmű új 
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védőidom számításai egyben arra is rámutattak, hogy egy jól megismert, de bo-
nyolultabb rendszer kalibrációja kisebb problémát jelent, mint egy kevésbé ismert 
terület nagyobb összevonásokkal és több egyszerűsítéssel elkészített modelljéé 
(GÁMA-GEO, 2000). 

7.3. Az autokalibráció és a trial-and-error módszer összevetése 

A két megoldás összevetésekor megállapítható, hogy mindkét módszer alkalmazása 
megalapozott, mindkettőnek megvannak az előnyei és hátrányai. Az autokalibráció 
terjedése összefügg azzal a ténnyel, hogy alkalmazása kevesebb elméleti ismeretet 
igényel. A számottevő matematikai eszköztár a kalibráló szoftverekbe építve, amo-
lyan fekete dobozként működik és a felhasználó hosszabb-rövidebb idő után az 
„eredményekhez” jut. Amennyiben a kapott végeredmény valóságközeli, akkor ezzel 
a feladat megoldottnak tekinthető, ugyanakkor esettanulmányok és munkajelentések 
bizonyítják, hogy a számítási algoritmusok nem minden esetben vezetnek reális 
eredményekhez. 
A trial-and-error kalibráció a nagyobb elméleti tudásigény mellett egy időigényes 
folyamat. A szükséges idő csökkenése a gyakorlottsági szinttel arányos. A módszer 
igazán nagy előnye az, hogy a modell-adatrendszer változtatásai során a várt és a 
kapott eredmények eltérései sokszor koncepcionális vagy adathibákat tárnak fel, a 
kalibráció végére a modellező szakember teljes mértékben megismeri a vizsgált 
rendszer működését, egyben ismeri az alapadat érzékenységet, valójában egy sok 
részletre kiterjedő vizsgálatnak vetve alá a rendszert.  
Az autokalibrációt a repülésnél használt robotpilótához lehet hasonlítani, amire azt 
megtanították, arra remekül alkalmas. Ugyanakkor váratlan helyzetekben szükséges, 
hogy a gép irányítását a kapitány vegye át, hozzátéve, hogy a landolás általában a 
robotpilótával sokszor simább, mint amikor a kapitány teszi le a gépet. Ugyanez ér-
vényes a kalibrálásra is, az autokalibráció sokszor hatékony és gyors, ugyanakkor 
speciális helyzetekben és főképpen akkor, amikor az adatrendszerben valamilyen 
rejtett hiba, belső ellentmondás van a trial-and-error kalibrációnak nincsen alternatí-
vája. Az autokalibráció használatával elveszítjük a rendszer mélyebb megismerésé-
nek lehetőségét is. Az autokalibrációval kapott paraméterértékek (amennyiben a ka-
libráció sikeres és a keresési algoritmus valóban az optimumot találja meg) általában 
nagyobb pontosságúak. CARRERA és szerzőtársai (1989) egy végeselem modellhez 
használt adatrendszer példáján mutatták be, hogy a mért és a szimulált piezometrikus 
szintek eltérése - autokalibráció alkalmazása esetén - erősen lecsökkent (54. ábra) 

7.4. A térinformatikai rendszerek (GIS) alkalmazási lehetőségei a kalibráció 
során 

A transzport-modellek kalibrálása során egyre nagyobb szerepet játszanak a geográ-
fiai információs rendszerek (térinformatikai rendszerek). A nevezett rendszerekben 
egyszerre találhatók meg a képi, grafikus, numerikus és a szöveges információk egy 
tetszőlegesen bonyolult felépítésű relációs adatbázis keretein belül, amelyek egyfelől 
felhasználhatók a szivárgáshidraulikai és transzportmodellek alap- és modelladat-
rendszerének kialakításához, másfelől azok ellenőrzésére, kalibrálására is alkalmasak 
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(TAMÁS et. al.,2002). Mint azt BIESHEUVEL és HEMKER (1993) egy példán be-
mutatja, a GIS adatbázisban tárolt adatok segítségével történhet a transzportmodell 
adatrendszerének a felépítése, majd a számítások eredményei (nyomás- és koncent-
ráció-eloszlás, szivárgási sebességmező adatai, stb.) visszakerülnek a GIS adatbázis-
ba (55. ábra). 
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54. ábra 

A közvetett és közvetlen kalibráció hatékonyságának összehasonlítása 
(CARRERA et al., 1989) 

 

A központi adatbázishoz kapcsolt térinformatikai rendszer alkalmas arra, hogy a ka-
pott eredményeket grafikus úton megjelenítse, valamint hogy azokat az adatbázisban 
szereplő reprezentatívnak tekintett adatokkal egybevesse. Ellentmondások megléte 
esetén a számításokhoz felhasznált adatrendszer módosítható. A rendszer nagy elő-
nye az alapadat-rendszer felépítésének leegyszerűsödésén túl az is, hogy a területre 
vonatkozó folyamatosan bővülő mérési adatsorok felhasználásával a modell repre-
zentativitása, pontosítása folyamatosan történhet. 
A GIS hidrodinamikai és transzportmodellezési alkalmazásának azonban számos 
hátránya is van, melyek közül a legnagyobb, hogy a legelterjedtebb GIS rendszerek 
elsősorban fejlett demonstrációs eszköztárral, adatbázis kezeléssel rendelkeznek. 
Ezen programok numerikus számítási képességei egyenlőre nem szolgálják ki a hid-
rodinamikai és transzportmodellezés ilyen igényeit. Éppen ezért a megvalósult pro-
jektek elsősorban a kiindulási adatok és eredmények GIS rendszerekkel történő vizu-
alizálásában, és további egyéb célú felhasználásában rejlő lehetőségeket használták 
ki, valamint egy esetlegesen meglévő országos GIS alapú adatbázisból a modellszá-
mításokhoz szükséges adatok átvételét oldották meg. Összességben megállapítható, 
hogy a jelenleg működő GIS rendszerek: ESRI ARC/Info vagy ArcView, Intergraph 
Microstation vagy Geomedia, Sirius 7, stb. egy térképezési feladat megoldására vagy 
adatok és eredmények vizualizációjára alkalmasak, ugyanakkor numerikus modulok 
és alapvető számítási képességek hiányában a transzport-modellezésben közvetlenül 
egyenlőre nem vagy alig alkalmazhatók (TAMÁS et. al., 2002). 
A térinformatikai rendszerek és a hidrodinamikai és transzportmodellek összeköthe-
tőségének igényét mutatja az is, hogy az újabb modellező szoftverek biztosítják az 
adatcsere lehetőségét az említett GIS rendszerekkel, sőt egyes programok egyszerű 
térinformatikai modullal is rendelkeznek, melynek célja a koncepcionális modell ki-
alakításának támogatása. Ezen rendszerek a modellkoncepció megadását követően 
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automatikusan hozzák létre a használatra kiválasztott numerikus számítást elvégző 
szoftver részére a modelladat-rendszert. Ennek az automatizmusnak ugyanolyan hát-
rányai vannak, mint az autokalibrációnak, nevezetesen, hogy kevéssé befolyásolható 
az, hogy az alapadat-rendszer alapján hogyan alakuljon ki a modelladat-rendszer, 
azaz a rendszer „tudását” nem a modellező szakember ismeretei és ötletei, hanem a 
programot készítő munkacsoport felkészültsége és az általuk figyelembe vett szituá-
ciók összessége határozza meg. 
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adataival

 
55. ábra 

Geográfiai Információs Rendszer és a transzportmodell összeillesztése 
(BIESHEUVEL és HEMKER, 1993) 
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8. A Processing MODFLOW for Windows (PMWIN) környezet 
bemutatása 

A Processing MODFLOW for Windows (PMWIN) egy teljes, háromdimenziós kör-
nyezet, talajvíz-áramlási (hidrodinamikai) és transzport-modellezési feladatok meg-
oldásához. Jelen fejezetben a PMWIN 5.x verziójú, Windows 3.1, 9x és XP alatt futó 
verzióját mutatjuk be. 
A PMWIN program professzionális grafikus megjelenítést, véges differencia mód-
szert alkalmazó hidrodinamikai modellt (MODFLOW), a hidrodinamikai és a transz-
portmodell kalibrációjára szolgáló inverz megoldást használó eszközt (PEST és 
UCODE), részecske-követési, egyben advektív transzport modellt (PMPATH), véges 
differencia elven működő, valamint a karakterisztika módszerét használó transzport-
modelleket (MT3D, MOC2D, MT3DMS, és számos további hasznos modellezési 
eszközt tartalmaz. 
A grafikus megjelenítés kényelmes modellezési környezetet biztosít. A grafikus felü-
letre importálható DXF vektorgrafikus és BMP rasztergrafikus állomány. A készített 
modell méretét a gyakorlatban elsősorban a rendelkezésre álló memória határozza 
meg, bár a készítendő modell rendelkezik tényleges méretkorlátokkal (maximálisan 
1000 időlépcső, 80 modellréteg és 250000 cella modellrétegenként). A PMWIN kör-
nyezetben izovonalas és/vagy színskálázott térképeket lehet készíteni mind a beme-
neti adatokból, mind a számítási eredményekből. Az időben változó depressziós teret 
vagy koncentráció—eloszlásokat a animációk formájában is meg lehet tekinteni. Az 
eredményeket bemutató ábrákat sokféle file formátumba lehet elmenteni, úgymint pl. 
Golden Software SURFER DAT (ASCII XYZ), DXF és BMP (Windows Bitmap). 
A diszkrét áramlási egyenleteket a MODFLOW által felkínált megoldási algoritmu-
sokkal lehet megoldani, a környezet valamennyi USGS MODFLOW változatot 
(MODFLOW-88, MODFLOW-96 és MODFLOW-2000) támogatja. A számításokat 
permanens és nem permanens állapotú rendszerekre egyaránt elvégezhetjük. 
A PMWIN az alapcsomagokon kívül további hét MODFLOW csomagot támogat: az 
időben változó nyomású határt (Time-Variant Specified-Head (CHD1, LEAKE et al., 
1991)), a direkt megoldó rutint (DE45, HARBAUGH, 1995), sűrűségfüggő hidrodi-
namikai csomagot (DEN1, SCHAARS és van GERVEN, 1997), a függőleges gát 
csomagot (Horizontal-Flow Barrier (HFB1, HSIEH és FRECKLETON, 1992)), a 
rétegen belüli tározási csomagot (Interbed-Storage (IBS1, LEAKE and PRUDIC, 
1991)), a rezervoár csomagot (RES1, FENSKE et al., 1996) és a speciális patak 
Streamflow-Routing (STR1, PRUDIC, 1988).  
A modellparaméterek kalibrációját a PEST (DOHERTY et al., 1994) és a UCODE 
(POETER - HILL, 1998) programokkal történő inverz számítással is elvégezhetjük, 
automatikus modell-kalibrációs lehetőséget felhasználva. 
A PMPATH (CHIANG - KINZELBACH, 1994, 1998)részecske követő modullal a 
hidrodinamikai modellel számított depressziók és piezometrikus szintek éppúgy 
megjeleníthetők, mint az áramlási sebességtérben felvett áramvonalak térbeli képe. 
Lehetőség van a rendszerben vízrészecskék kijelölésére, majd a víz utjának áramlás 



104 

irányába, illetve azzal szemben történő követésére is. A program különböző, a kép-
ernyőn megvalósítható, grafikus lehetőségeket is kínál, beleértve a hidroizohipszák, a 
depresszió felületek és sebességvektorok ábrázolását. 
A rendszer logikus felépítésű környezetet biztosít 3D transzportmodellek (MT3D 
(ZHENG, 1990), MT3DMS (ZHENG - WANG, 1998), MOC3D (KONIKOW et al., 
1996)) bemeneti állományinak elkészítéséhez, majd a számítások DOS környezetben 
történő futtatásához, végül az eredmények megjelenítéséhez.  
A modellezési eszközök tartalmaznak egy eredmény feldolgozót (Result Extractor), 
egy paraméter interpolálót (Field Interpolator), egy paraméter generátort sztochasz-
tikus szimulációkhoz (Field Generator), egy vízmérleg számítót (Water Budget 
Calculator), egy 2D grafikon megjelenítőt (Graph Viewer), valamint egy bemutató 
eszközt (Presentation tool). 
A Result Extractor megengedi, hogy a felhasználó szimulációs eredmények közül 
egy-egy periódusra vonatkozó eredményeket (piezometrikus szinteket, depressziókat, 
a Darcy-sebességvektorok komponenseit, a felszíni vizekből származó járulékos ho-
zamokat és koncentrációkat) válasszon ki és mentsen el további feldolgozásra. Meg-
tekintheti grafikusan ábrázolt formában az eredményeket vagy elmentheti azokat 
ASCII vagy SURFER-kompatibilis adatfájlokba. 
A Water Budget Calculator nemcsak a felhasználó által megjelölt zónák vízmérle-
gét számítja, hanem az ilyen zónák közötti vízmozgásokat változást is. Ez az eszköz 
nagyon hasznos sok gyakorlati esetben. Megengedi továbbá, hogy a felhasználó 
meghatározza az áramló hozamokat egy egyedi határfelületen keresztül. 
A Field Generator árammezőket generál heterogén transzmisszivitás - vagy szivár-
gási tényező-érték eloszlással. Ez lehetővé teszi, hogy a felhasználó valószínűségel-
méleti alapon szimulálja ismeretlen kismértékű heterogenitások hatásait és befolyá-
sát. A Field Generator MEJÍA (1974) algoritmusát használja. 
A Graph Viewer a szimulációs eredmények (hidraulikus nyomásszintek, depresszi-
ók és koncentrációk) időbeli változásának grafikonjait jeleníti meg. 
A Presentation Tool segítségével a bemeneti és az eredményállományok felirato-
zott, izovonalas térképeit lehet elkészíteni, továbbá színskálás ábrázolásra is lehető-
ség van. A jó minőségű grafikákat SURFER, DXF, HPGL és BMP (Windows 
Bitmap) formátumban lehet elmenteni. Ezen kívül lehetőség van a nem permanens 
számítások eredményeinek grafika-sorozatokkal történő ábrázolására, melyekkel rö-
vid animáció készíthető. 
Rendszerkövetelmények: 
- PC Microsoft Windows 95/98/ME/NT 4.0/XP operációs rendszerrel, 
- 16 MB RAM (32MB vagy több ajánlott), 
- CD-ROM meghajtó és merevlemez, 
- VGA vagy jobb felbontású monitor, 
- Microsoft Mouse vagy kompatibilis egyéb egér. 
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8.1. Munka a PMWIN környezetben 

A PMWIN számos a modellezéssel kapcsolatos program pre- és posztprocesszora. 
Ezen programok általában MS-DOS környezetben futó, többnyire valamilyen 
FORTAN nyelven írott rutinok, melyeknél az adatbevitel nehézkesen szerkeszthető, 
általában hosszú szöveges állományokkal történik és az eredményeket is hosszú, akár 
több 10 MB méretű szöveges, ritkábban bináris állományokban kapjuk meg. Mivel 
ezekkel a szöveges állományokkal nehéz dolgozni, ezért szükségesek azok a prog-
ramok (mint a PMWIN is), melyekben a szimulált rendszer megtervezhető, majd a 
program elkészíti a szükséges input szövegfájlokat a FORTRAN program részére, 
melyek később DOS ablakban futtathatók. Az eredményként kapott állományokat 
ismét egy posztprocesszor feldolgozóprogrammal (PMWIN) jelenítjük meg és érté-
keljük ki (56. ábra). 
 

Preprocesszor
(Adatbevitel és

adatfeldolgozás)

Grid Editor

Field Interpolator

Field Generator

Programok
futtatása

MODFLOW

MT3D

MT3DMS

MOC3D

PEST

UCODE

Kalibráció

DOS

Posztprocesszor
(Eredményfeldolgozás, 

megjelenítés)

PMPATH

Water Budget
 Calculator

Presentation

Graph Viewer

Result Extractor

Windows

Processing MODFLOW keretrendszer

 
56. ábra 

A Processing MODFLOW környezet felépítése 
 

A program indítása a Start menüben a Programok → Processing Modflow 5 → 
Processing Modflow ikonnal lehetséges. A menüből közvetlenül indítható a 
PMPATH részecske-követőprogram, továbbá a Field Generator sztochasztikus 
modellező eszköz és a Field Interpolator interpoláló eszköz (57. ábra), de a felso-
rolt programokat célszerű a főprogramból megnyitni. Az indítás után a nyitóképer-
nyő jelenik meg (58. ábra). 

 
57. ábra 

A Start menüből indítható programok 
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58. ábra 

A Processing MODFLOW indítóképernyője 

8.1.1. A menürendszer 

8.1.1.1. A File menü (59. ábra) 

 
59. ábra 

A File menü 
 

A File → New Model parancs szolgál egy új adatrendszer felépítésére. Célszerű 
minden modellt külön könyvtárba menteni, mivel egyrészt a rendszer alkalmaz köte-
lező nevű állományokat, melyek több modell azonos könyvtárba írása esetén felülír-
ják egymást, másrészt mert egy-egy adatrendszer rengeteg állományból áll, melyek 
strukturálása célszerű. A parancs választása esetén a New Model dialógusablak nyí-
lik meg, ahol egy nevet kell adni a készítendő projektnek, melyet egy pm5 kiterjesz-
tésű állományban tárol a rendszer (60. ábra) 
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60. ábra 

A New Model dialógusablak 
 

A File → Open Model parancs szolgál egy meglévő, korábban létrehozott adatrend-
szer megnyitására. A parancs választása esetén az Open Model dialógusablak nyílik 
meg, ahol kiválaszthatjuk a megnyitandó projekt nevét (61. ábra). 
 

 
61. ábra 

Az Open Model dialógusablak 
 

A File → Convert Model parancs három célra szolgál: Itt konvertálhatjuk a korábbi, 
4.x verziójú modelleket, valamint MODFLOW-88 vagy MODFLOW-96  formátumú 
állományokat 5.x verziójú formátumra, a szükséges állománynév megadása vagy a 

 gomb megnyomása után történő kiválasztás után. Az eredeti modell finomítha-
tó, oly módon, hogy megadhatjuk, hogy egy-egy elemet hány sorra (Refinement 
factor for rows) és oszlopra bontson a rendszer fel (Refinement factor for 
coloumns) (62. ábra). 

PMWIN 4.x és MODFLOW-88/96 állományok konvertálására szolgáló ablakok 
A File → Convert Model parancs harmadik lapja a Telescoping Flow Model egy 
meglévő 5.x verziójú modell részmodelljét készíti el (63. ábra). Ehhez meg kell ad-
nunk egyrészt a meglévő modell nevét a PM Model (*.pm5) szövegdobozba, más-
részt a készítendő modellkivágat első és utolsó sorának és oszlopának (Starting 
coloumn, Ending Coloumn, Starting row, Ending row) sorszámát a meglévő mo-
dell elemszámozása szerint, de a korábbiakhoz hasonlóan elemsűrítés (Refinement 
factor) is kérhető. A készített részmodell peremein a rendszer maga határoz meg pe-
remfeltételeket, amik szükség szerint korrigálandók. 
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62. ábra 

 

Amennyiben sűrítést kérünk, akkor a rendszer helyesen kezeli az intenzív és extenzív 
mennyiségeket, aminek következménye, hogy pl. ha egy cellát, amiben 100 m3/d 
vízkivételt irányoztunk elő, négyfelé bontunk, akkor 4 db 25 m3/d hozammal jellem-
zett kisebb elemet kapunk. Mindezen túlmenően a Telescoping Flow Model ablakkal 
létrehozott új modellt célszerű áttekinteni, mert kerülhetnek az új modellbe logikus, 
ugyanakkor szándékunktól eltérően kialakított sajátosságok, melyeket ezúton lehet 
korrigálni. 

 
63. ábra 

A részmodell kialakítása 
 

File → Model information paranccsal a modell legfontosabb aktuális jellemzőit 
nézhetjük meg, illetve a Simulation title ablakban a modellre vonatkozó saját meg-
jegyzéseket is beírhatjuk. A legfontosabb információkat az „erről a modellről” 
(About this model) ablakban láthatjuk: a projektfájl neve és elérési útja, sorok, osz-
lopok és rétegek száma, időlépcsők száma, permanens vagy nem permanens modell, 
az idő mértékegysége (64. ábra).  
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64. ábra 

A modelladatokat leíró tábla 
 

A File → Save Plot As... paranccsal a képernyőn lévő aktális tartalmat lehet elmen-
teni Windows Bitmap (*.BMP), Hewlett-Packard Graphics Language (HPGL) és 
AutoCAD drawing exchange formátumba (*.dxf) (65. ábra). Az az első raszter-, az 
utóbbi kettő vektrografikus formátum, így a formátumot a további feldolgozási cél-
nak megfelelően célszerű eldönteni. A File szövegdobozban adhatjuk meg a készí-
tendő állomány nevét.  
 

   
65. ábra 

Grafika mentési lehetőségek  Save Plot As paranccsal 
 

File → Print Plot paranccsal az aktuális grafika nyomtatása történhet (66. ábra). A 
legfontosabb opciók a teljes oldalt kitöltő nyomtatás (Use full page) és a lapközépre 
helyezett nyomtatás (Enter on Page). Amennyiben nem teljes oldalra széthúzva 
és/vagy nem középre nyomtatunk, akkor a kép szélességét és hosszúságát mm-ben 
(Image Size (millimeters): Width és Height) és a bal és felső oldali margókat 
(Margins (millimeters): Left és Top) is megadhatjuk. 
File → Animation paranccsal közvetlenül elérhetők a képsorozatként gyártott ani-
mációk. Mivel ezek a Tools → Presentation paranccsal készíthetők, ezért részlete-
sebben ott írjuk le. 
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66. ábra 

A grafika nyomtatása 
 

Az File → Animation és a File → Exit parancsok között a legutóbb készített model-
lek elérési útjait találjuk, melyekre klikkelve ezek közvetlenül behívhatók. Egyszerre 
a PMWIN környezet egy modell kezelésére képes, ezért csak új ablakban elindítva a 
programot lehet két modellt párhuzamosan építeni. Futtatni az azonos alapértelmezé-
sű fájlnevek miatt nem lehet, a környezet egy másik modell aktuális futása esetén 
hibaüzenetet küld és engedélyt kér a futó alkalmazás megszakítására. Mindezt nem 
célszerű megtenni, ezért két modell párhuzamos kezelése csak különösen indokolt 
esetben célszerű. 
File → Exit paranccsal a PMWIN környezet elhagyható. 

8.1.1.2. A Grid menü 
 

 
67. ábra 

A Grid menü 
 

A Grid menüben a szimulálandó rendszer geometriájának és alapvető tulajdonságai-
nak megadása válik lehetővé. 
A Grid → Mesh Size... paranccsal a modell térdimenzióinak méreteit, majd az egyes 
cellák méreteit állíthatjuk be. Amennyiben a modellt éppen most hozzuk létre, akkor 
először a Model Dimension nevű ablakot kell kitölteni, ahol megadhatjuk a rétegek 
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számát (Layers) az oszlopok (Coloumns) darabszámát (Number) és méretét (Size), 
illetve a sorok (Rows) darabszámát (Number) és méretét (Size) (68. ábra). Itt jegyez-
zük meg, hogy a modellezés előtt eldöntendő a hosszúság alkalmazott mértékegysé-
ge, ami a későbbiekben részben meghatározza a további paraméterek esetében al-
kalmazott mértékegységeket is. Pl. ha a hosszúság egysége méter, akkor a szivárgási 
tényezőt m/d, m/s, m/év dimenzióban kell megadni, ha centiméter, akkor cm/d, cm/s, 
cm/év az alkalmazandó mértékegység. Hasznos a hosszúságot méterben mérni, mert 
így használhatjuk a legjobban érzékelhető SI mennyiségeket. 
 

 
68. ábra 

A modell elemrendszerének előzetes definíciója 
 

A modellben később lehetséges az elemek méretét változtatni, a számukat növelni, 
éppúgy mint a modellrétegeket függőlegesen több részre bontani. Ez azonban csak 
előre nagyon átgondoltan történhet, és a gyakorlat azt mutatja, hogy főként a réteg-
szám tekintetében hasznos, ha további változtatás nem történik. Ezután a Grid Editor 
programrész egy módosított változata jelenik meg a 69. ábra szerinti ablakban. 

Itt az egyes cellákon a kurzorral mozoghatunk vagy az egérrel rákattintva jelölhetjük 
ki bármely elemet. Csak akkor lehetséges az egyes elemek kijelölése, ha a kijelölés 
gombot  bekapcsoljuk. A kijelölt elemek koordinátája az ablak alsó szegélyén 
megjelenik a kurzor aktuális pozíciójával együtt. 
A cellák méreteit a cellára klikkelve, majd jobb egérgomb segítségével  feljövő ab-
lakban változtathatjuk meg (70. ábra). Ebben az ablakban, mind az elem méretét 
(Size: Coloumn, Row), hanem a több részre bontását is megadhatjuk a tér három 
irányában (Refinement: Coloumn, Row, Layer). A több részre bontás a rácsháló 
miatt a többi elemek méretét is befolyásolhatja. Amennyiben a több részre bontás 
nem működik, akkor  először az ablakból kilépve e merevlemezre kell írni a háló 
adatait, majd a Grid → Mesh Size... paranccsal újra szerkeszteni és módosítani a 
hálót.  
Az elem kijelölését követően a horizontális irányú részekre bontásra lehetőség van a 
Ctrl-→, Ctrl-↑ billentyűkombinációkkal, mely módosítások visszavonását  a Ctrl-← 
és Ctrl-↓ billentyűkkel lehet elérni. 
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69. ábra 

A modellháló kirajzolása, a modellelemek felülnézetben 
 

 
70. ábra 

Elemméret megváltoztatása és az elem felosztása 
 

Amennyiben a módosítás jelentős, akkor a 71. ábra szerinti üzenet jelenik meg a 
képernyőn, és felajánlja a program az aktuális helyzetnek megfelelő geometria el-
mentését egy külön könyvtárba, mielőtt a mentés megtörténik, így egy korábbi álla-
pothoz vissza lehet térni. Más módon a rácsháló módosítása nem vonható vissza!!! 
A PMWIN környezet lehetőséget nyújt nem a rácsháló északi iránytól különböző 
tájolására, illetve tetszőleges koordinátarendszer (pl. EOV) alkalmazására, amit rész-
letesen a rácsháló tájolása fejezetben, később tárgyalunk. 
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71. ábra 

A korábbi állapot mentésére lehetőséget adó ablak 
 

A Grid → Layer Type... paranccsal az egyes rétegek tulajdonságait adhatjuk meg. 
A parancs hatására  a Layer Options ablak nyílik meg (72. ábra), ahol láthatók az 
egyes rétegek tulajdonságai táblázatos formában. A réteg típusai (Type): 0: zárt tük-
rű, 1: nyílt tükrű, 2: Vegyes tükrű (transzmisszivitás közel állandó), 3. Vegyes tükrű 
(transzmisszivitás változó). Az anizotrópia (Anizotropy factor) tényező a két hori-
zontális főirány (x és y) tekintetében rétegenként megadható, továbbá kényelmi 
funkció, hogy előírható,  hogy a transzmisszivitás (Transmissivity) értékeket és a 
függőleges vízforgalom mérőszámát (Leakance)  a szivárgási tényező és a geometri-
ai adatokból, a tárolási tényezőt (Storage Coefficient) a fajlagos tárolási tényezőből 
és  a rétegvastagságból a szoftver számítsa (Calculated) vagy a felhasználó adja meg 
(User defined). Ez utóbbi lehetőség arra is alkalmat ad, hogy ne csak egymással 
érintkezésben lévő vízadó és vízrekesztő testeket, hanem egymástól ismert távolságra 
található vízadókat is modellezhessünk. Egyben valamennyi rétegnél megadhatjuk, 
hogy az IBS1 és a DEN csomagokkal figyelembe kívánjuk e venni a rétegen belüli 
tározódást, illetve a sűrűségfüggő vízmozgást. 
 

    
72. ábra 

A Layer Options dialógusablak 
 

A Grid → Boundary Condition paranccsal az alkalmazott véges differencia modell 
peremfeltételeit állíthatjuk be. A két almenüvel egyrészt a MODFLOW IBOUND 
paraméterét, másrészt az MT3D/MT3DMS ICBOUND paraméterét lehet megadni a 
később ismertetett Grid Editor segítségével (73. ábra). A készített mátrixokban az 
aktív, azaz változó potenciálú és koncentrációjú cellákat 1-gyel, az állandó nyomású 
és koncentrációjú cellákat –1-gyel jelölik, az inaktív, azaz a számításból kizárt része-
ket pedig 0-val jelölik. 
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73. ábra 

A peremfeltételek kiválasztására szolgáló almenü 
 

A Grid → Top of Layers (TOP) paranccsal a rétegek fedőszintjeit adhatjuk meg. 
Az értékek cellákhoz rendelését a Grid Editorral tehetjük meg, amit később ismerte-
tünk. 
A Grid → Bottom of Layers (BOT) paranccsal a rétegek fedőszintjeit adhatjuk 
meg. Az értékek cellákhoz rendelését a Grid Editorral tehetjük meg, amit később 
ismertetünk. 
Amennyiben olyan rendszert építünk fel, ahol az egyes rétegek egymással érintkez-
nek akkor egy felső réteg feküszintjei megegyeznek az alatta található réteg fedő-
szintjeivel. Ezt a program támogatja oly módon, hogy amennyiben vannak megadott 
fedő vagy feküszintek, akkor egy dialógusablak (74. ábra) segítségével lehetővé te-
szi, a közös fedő vagy feküszintek generálását. 
Amennyiben különálló vízadókat modellezünk, akkor a Nem gombbal megtarthatjuk 
az eltérő fekü és fedőszinteket, de ebben az esetben a Layer Options dialógusablak-
ban az adott rétegek közötti vertikális vízforgalom mértékét (Leakance) a felhaszná-
lónak kell megadnia (User defined).  

 
 

 
74. ábra 

A fedőszintek és a feküszintek illesztését automatizáló dialógusablak 

8.1.1.3. A Parameters menü 
A Parameters menüben (75. ábra) a rendszer Grid menüpontban megadott elemei-
nek általános földtani és vízföldtani jellemzőit adhatjuk meg, illetve az ezen jellem-
zők megadásához szükséges idő dimenzióját. A rendszer mértékegység konzekvens, 
a Grid menü alkalmazásakor magunk döntöttünk a hosszúság mértékegységéről [L] 
és itt az idő [T] mértékegységének megadására is kényszerülünk. Amennyiben ezt is 
eldöntöttük (általában s vagy nap mértékegységet lehet javasolni), akkor a szivárgási 
tényezőket [L]/[T], a transzmisszivitást [L]2/[T] mértékegységre átváltva kell meg-
adni. 
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75. ábra 

A Parameters menü 
 

A Parameters → Time paranccsal az idővel kapcsolatos beállítások érhetők el (76. 
ábra). Az ablakban először az idő mértékegységét célszerű beállítani (Simulation 
Time Unit), ahol a másodperc (seconds), perc (minutes), óra (hours), nap (days) és 
év (years) közül választhatunk. Mindent összevetve a legjobban értelmezhető egysé-
geket nap egység választás esetén kapunk: szivárgási tényező [m/d], 
transzmisszivitás [m2/d], eltelt idő [d], ugyanakkor pl. a beszivárgást [m/d] kell meg-
adnunk [mm/év] helyett. Másodszor a rendszer típusát (Simulation Flow Type) kell 
megadni, ami lehet permanens állapot (Steady-state) vagy nem permanens állapot 
(Transient). Permanens állapotban az időbeli változások elhanyagolhatóak,  az adott 
helyzetben kialakul egy dinamikus egyensúlyi állapot, melyhez tartozó nyomásszin-
teket számítjuk. Nem permanens helyzetben az időben változó depressziós teret és 
koncentráció-eloszlásokat számítjuk. 
A nem permanens folyamatokat azonos jellemzőkkel leírható periódusokra (Period) 
bontjuk, melyeket további időlépcsőkre bonthatunk. A periódusok közül az aktuális 
számítások során figyelembe vetteket aktívnak (Active) jelöljük ki.  A periódusok 
hosszát (Length) a választott mértékegységben adjuk meg. Ezt a periódust bonthatjuk 
az időbeli folyamatok jobb követése érdekében időlépcsőkre (Time Steps), melyek-
nek a darabszámát a 76. ábra táblázatába be kell írni. Az időlépcsők lehetnek azonos 
hosszúak, vagy kezdetben rövidebbek majd egyre hosszabbak, amit egy szorzóténye-
zővel (Multiplier(Flow)) állítunk be. A szorzótényező azt mutatja meg, hogy egy 
időlépcső hányszorosa legyen a következő lépcső hossza. Általában 1-1,15 közötti 
időlépcső szorzótényezők elegendően hosszúak. Konstans időlépcső esetén a  szorzó-
tényező 1. Beállíthatjuk még a transzportmodellnél alkalmazott időlépcsőt 
(Transport Stepsize), azonban itt javasolt 0 értéket beírni, mert akkor a gép számítja 
a program numerikus legkisebb numerikus hibák mellett történő futatásához szüksé-
ges időlépcsőket. Megadható továbbá a szennyeződés terjedési számítások során el-
érhető maximális időlépcsőszám (Max. No. of Transport Steps), amire a túl kicsi 
időlépcsők esetén megvalósuló hosszadalmas számítások elkerüléséhez van szükség. 
Ugyancsak megadható az időlépcső szorzótényező a transzportmodellhez (Multiplier 
(Transport)) is. 
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76. ábra 

Az idő-paraméter beállítására szolgáló ablak 
 

A Parameters → Initial Hydraulic Heads menüben a hidrodinamikai számítások 
kezdeti feltételét jelentő nyugalmi nyomásszint-eloszlásokat adhatjuk meg elemen-
ként. Az adatbevitelt a később bemutatott Grid Editorral lehet elvégezni.  
A Parameters → Boreholes and Observations menüben két táblázattal adhatjuk 
meg a megfigyelő kutak (Boreholes) és az észlelések (Observations) adatait, melye-
ket később az automatikus kalibrációhoz (PEST, UCODE), illetve a modellszámítás 
eredményeinek értékelésénél használhatunk fel.  
A figyelőkút táblázatban (77. ábra) egy sorszán (No.) azonosítja a kutat, mellette a 
kút jelölését is beírhatjuk (Borehole Name), egy adott feladat szempontjából fel-
használandó kutakat aktiválni kell az Active dobozzal. Megadandó a kút helyzete X 
koordináta (=EOV Y) (Easting), Y koordináta (=EOV X) (Northing) és a kúttal szű-
rőzött réteg sorszáma (Layer). 
 

 
77. ábra 

A figyelőkutak adatai 
 



117 

Az észlelések táblázatában (78. ábra) a kút jelölése az azonosító, majd megadandó az 
időpont (Observation Time) az észlelés pontosságát jelölő súlyfaktor (Weight) is. A 
súlyszám minél magasabb, annál jobban veszi azokat figyelembe a program az au-
tomatikus kalibráció során, értelemszerűen a –ás súly az adat figyelmen kívül hagyá-
sát jelenti. Egy kúthoz több időpontbeli észlelés is tartozhat. Az észlelések lehetnek: 
nyomásszintek (Head), depressziók (Drawdown), koncentrációk (Concentration), 
összenyomódási értékek (Compaction), konszolidációs nyomás értékek 
(Preconsolidation Head) és felszínsüllyedés értékei (Subsidence).  
 

  
78. ábra 

Az észlelések táblázatai 
 

A kalibrációhoz szükséges információt a táblázat alján kell beállítani: vagy az észlelt 
nyomásszintek vagy az észlelt depressziók alján történik a kalibráció (Use observed 
heads for the calibration vagy Use observed drawdowns for the calibration). 
A Parameters → Horizontal Hydraulic Conductivity menüben a vízszintes szi-
várgási tényezők eloszlását adhatjuk meg elemenként. Az adatbevitelt a később be-
mutatott Grid Editorral lehet elvégezni.  
A Parameters → Vertical Hydraulic Conductivity menüben a függőleges szivár-
gási tényezők eloszlását adhatjuk meg elemenként. Az adatbevitelt a később bemuta-
tott Grid Editorral lehet elvégezni.  
A Parameters → Specific Storage menüben a fajlagos tárolási eloszlását adhatjuk 
meg elemenként. Az adatbevitelt a később bemutatott Grid Editorral lehet elvégezni.  
A Parameters → Transmissivity menüben a transzmisszivitás eloszlását adhatjuk 
meg elemenként. Az adatbevitelt a később bemutatott Grid Editorral lehet elvégezni. 
Nem kell az adatbevitelt elvégezni, ha korábban a rétegek tulajdonságai (Layer 
Options, 72. ábra) dialógusablakban megadtuk, hogy a vízszintes szivárgási tényezők 
és a modellgeometria alapján történjék az értékek számítása.  
A Parameters → Vertical Leakance menüben a függőleges átszivárgási tényezők 
(b érték)  eloszlását adhatjuk meg elemenként. Az adatbevitelt a később bemutatott 
Grid Editorral lehet elvégezni. Nem kell az adatbevitelt elvégezni, ha korábban a 
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rétegek tulajdonságai (Layer Options, 72. ábra) dialógusablakban megadtuk, hogy a 
vízszintes szivárgási tényezők és a modellgeometria alapján történjék az értékek 
számítása. Kötelező az értékeket megadni, ha a modellezett rétegek nem egymáson 
nyugszanak és közöttük valamilyen nem modellezett vízrekesztő réteg van. Ekkor 
ezt az értéket külön ki kell számítani és meg kell adni. 
A Parameters → Storage Coefficient menüben a tárolási tényező eloszlását adhat-
juk meg elemenként. Az adatbevitelt a később bemutatott Grid Editorral lehet elvé-
gezni. Nem kell az adatbevitelt elvégezni, ha korábban a rétegek tulajdonságai 
(Layer Options, 72. ábra) dialógusablakban megadtuk, hogy a fajlagos tárolási té-
nyezők és a modellgeometria (rétegvastagság) alapján történjék az értékek számítása.  
A Parameters → Effective porosity menüben a szabad hézagtérfogat értékek elosz-
lását adhatjuk meg elemenként. Az adatbevitelt a később bemutatott Grid Editorral 
lehet elvégezni. 
A Parameters → Specific Yield menüben a fajlagos hozam értékek eloszlását ad-
hatjuk meg elemenként. Az adatbevitelt a később bemutatott Grid Editorral lehet 
elvégezni. 

8.1.1.4. A Models menü 
A Models menün keresztül érjük el a Grid menüben leírt geometriájú, a Parameters 
menüben megadott tulajdonságokkal jellemezhető porózus közegben lejátszódó hid-
rodinamikai és transzportfolyamatokat leíró modellek speciális lehetőségeit.  
Az I. kötet csak a hidrodinamikai számításokhoz szükséges programok leírását adja 
meg, a transzportszámítás programjainak magyar nyelvű leírását a II. kötet tartal-
mazza. 
 

 
79. ábra 

A Models menü 
 

A MODFLOW 3D, telített közegben lejátszódó hidrodinamikai folyamatokat leíró 
programcsomag. A MODFLOW moduláris felépítésű FORTRAN program, melyhez 
speciális helyzeteket leíró programcsomagok (Packages) csatlakoztathatók. Itt csak a 
legismertebb csomagokkal foglalkozunk. 
A MOC3D transzportmodell a karakterisztika módszerének segítségével oldja meg a 
transzport egyenletet. A karakterisztika módszerének alkalmazásához a Grid menü-
ben definiált elemosztást használja fel. 
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Az MT3D/MT3DMS programok a MODFLOW-hoz fejlesztett transzportmodellek. 
A két program abban különbözik egymástól, hogy az MT3DMS többkomponensű 
(kompetitív) transzport számítására alkalmas. A programban többfajta módszer al-
kalmazására van lehetőség (véges differencia módszer, karakterisztika módszerének 
két változata). A megoldás során lehetőség van az advektív-diszperzív transzport, a 
lineáris és nem lineáris adszorpció és a bomlás figyelembe vételére is. 
A PEST és az UCODE inverz modellező eszközök, melyekkel egyes paraméterek 
számíthatók. A számítandó paramétereket sorszámokkal kell megjelölni, melyeket 
valamennyi adatbeviteli mezőnél egy paraméterszám (Parameter number) jelöl. A 
két program futtatása előtt egy paraméter listát (Parameter list, 80. ábra) kell össze-
állítani, melyet a Models → PEST → Paraméter List, illetve Models → PEST → 
Paraméter List parancsokkal lehet elérni. 
A listán a paraméter száma (Number) az az érték, amelyiket a változtatandó, azaz 
optimalizálandó paraméter definíciójakor a paraméterszámnak (Parameter Number) 
megadtunk, adható hozzá egy rövid leírás (Description) megadandó az optimalizá-
láshoz használandó kezdőérték (PARVAL1) és az értéktartomány alsó (PARLBND) 
és felső (PARLBND) határa, ahol az optimális érték egyáltalán keresendő. A Group 
Definitions lapon arra nézve adhatunk utasítást, hogy milyen úton keresse az optimá-
lis értéket a program, a Prior Information lapon pedig a keresendő paraméterek kö-
zött fennálló előzetes kapcsolatokat írhatjuk le matematikai formában, pl. az egyik 
képződmény szivárgási tényezője kétszerese a másikénak, stb.. A Control Data a 
program kereső algoritmusának paramétereit adja meg, léteznek alapértelmezett ér-
tékek, de ezeket a gyorsabb vagy jobb keresés érdekében meg lehet változtatni. Az 
Options lap pedig az eredmények megjelenítésére, mentésére vonatkozó lehetősége-
ket kínál fel.  
 

 
80. ábra 

A paraméterlista felépítése 
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8.1.1.5. A Tools menü 
 

 
81. ábra 

A Tools menü 
 

A Tools → Digitizer menüvel egy speciális Grid Editor ablak (82. ábra) érhető el, 
ami lehetővé teszi pontok digitalizálását a modellezett térrészen és a pontokhoz érté-
kek rendelését. A digitalizált pontok és értékek elmentése is lehetséges, ezeket ké-
sőbb a Field Interpolatorral lehet a modell felépítéséhez felhasználni. A digitalizáló 
használatát bemutató példát a II. kötet tartalmaz. 

Az ablakban a digitalizálási képességet a  digitalizáló gomb benyomásával lehet 
aktívvá tenni. Ezután az egérrel a modellezett térre kattintva bárhova pont helyezhető 
el. A lehelyezett pontra jobb egérrel kattintva a hozzárendelt érték adható meg. Egy-
egy pont törlése a lenyomott CTRL billentyű esetén végzett klikkeléssel lehetséges. 
A digitalizáló fájlműveleti parancsai a Value → Points menüpont alól érhetők el. 

 
82. ábra 

A digitalizáló ablak 
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(Tools → Digitizer →)Value → Points → Delete all menüponttal az összes digita-
lizált pont egyszerre törölhető. 
(Tools → Digitizer →)Value → Points → Save as menüponttal az összes digitali-
zált pont egy xyz kiterjesztésű ASCII szövegállományba menthető el. Ez a 
fileformátum a bemeneti állománya a Field Interpolator programnak. 
(Tools → Digitizer →)Value → Points → Load menüponttal a korábban kimentett 
digitalizált pontok újra betölthetők, majd szerkeszthetők. 
A Tools → Field Interpolator (PMDIS)... menüvel ismert adatok alapján (melyek 
lehetnek fúrási pontokból származó adatok vagy egyéb digitalizált értékek) számít-
hatjuk valamennyi elemre a legvalószínűbb értéket, úgy, hogy a pontokra inter- és 
extrapolációval  egy folytonos térfelületet fektetünk és ezek adott elem középpontjá-
ra számított értékeit az elemekhez rendeljük. Az interpolációs megoldásokat koráb-
ban ismertettük. 
A programnak szüksége van a projektfájl nevére (*.pm5), mert innen veszi a rácsháló 
alakját és az elhelyezkedését a használt koordináta rendszerben (ezt a Grid Position 
lapon meg is mutatja). 
A Grid Position mezőt általában be sem kell állítani, hiszen a tájolást általában a 
modellezés korábbi szakaszában már beállítottuk. Ha ez nem volna így, akkor járjunk el 
úgy, ahogyan azt a környezet beállításainál leírtuk. 
Továbbá meg kell adni egy bemeneti állományt, mely vagy a digitalizálóval készített 
állomány vagy egy alábbi szintaxisú szövegfájl. 
 

n 
x1, y1, z1 

x2, y2, z2 

... 
xn, yn, zn, 
 

ahol n az észlelési pontok száma, xi, yi az észlelési pontok koordinátái a tájolásnak 
megfelelő koordinátarendszerben, zi az észlelt és egyben interpolálandó érték a xi, 
yi koordinátájú pontban. 
Ezen állományokon túlmenően meg kell adni a Files lapon a kimeneti állomány ne-
vét(83. ábra). A készített fájl megfelel a PMWIN ASCII mátrix formátumának, amit 
a Grid Editor  segítségével illeszthetünk a  modellbe. A Search/Gridding Method 
lapon állíthatjuk be a keresési módot (Search Method): egyszerű (Simple), kvadráns 
(Quadrant) vagy oktáns (Octant). Az egyszerű keresés annyit tesz, hogy a legköze-
lebbi, a Data Per Sector dobozban megadott darabszámú adatból számítja az inter-
polált értékeket. Kvadráns keresés esetén térnegyedekre osztja a területet a vizsgált 
elem környezetében és valamennyi térnegyedben a legközelebbi, a Data Per 
Sector dobozban megadott darabszámú adatból számítja az interpolált értékeket. 
Oktáns keresés esetén térnyolcadokkal történik mindez. 
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A program négyfajta interpolációs algoritmust ismer: A Shepard-féle távolsággal 
fordítottan arányos súlyozás módszerét, a lineáris interpolációt alkalmazó Renka-féle 
háromszög-módszert, a krigelést és a kétváltozós Akima-módszert. A módszerek 
leírását a geostatisztikai szakirodalomban lehet fellelni. Amennyiben súlyozott átlag-
számítás történik, úgy a súlyt (Weighting Exponent) is meg kell adni. 
 

  
83. ábra 

Az interpoláló eszköz bemeneti adatai 
 

Valamennyi interpolációnak megvan az előnye és hátránya, kiválasztásukhoz ru-
tinra és geostatisztikai ismeretekre van szükség. Bármilyen alapon is történik az 
interpolációs algoritmus kiválasztása, az eredmények izovonalas térképek for-
májában való ábrázolásával a helyes eredményekről való meggyőződés szüksé-
ges. Az extrapolációt lehetőleg el kell kerülni, egyébként a Field Interpolator al-
kalmazása a modell-adatrendszer belső ellentmondásosságához vezet. 
A Tools → Field Generator (PMFGN)... menüvel sztochasztikus modellezéshez 
szükséges eszközt érhetünk el (84. ábra). Az eszköz adott szórású és átlagértékű vé-
letlen, lognormális eloszlású adathalmazokat generál. Ez alkalmas lehet szivárgási 
tényező vagy transzmisszivitási mezők véletlen előállítására, melyeket egymás után 
lefuttatva a modellnek a véletlen hatásokra való érzékenységét vizsgálhatjuk, illetve 
egy-egy vízszint, depresszió kialakulásának valószínűségét határozhatjuk meg. A 
program 1-999 közötti darabszámú (Number of Realizations) adatrendszert generál a 
kimeneti fájlnév (Output File Name) szövegdobozba írt állománynévvel és az állo-
mány sorszámának megfelelő kiterjesztéssel. Megadandó az átlagérték tizes alapú 
logaritmusa (Mean Value (log10)), szórása (Standard Deviation (log10)) . A még 
szignifikáns autokorrelációhoz tartozó távolságot, azaz a hatástávolságot 
(Correlation Length/Field Width) terepi mérések alapján vagy tapasztalati úton kell 
meghatározni.  
A Tools → Presentation menüvel egyrészt bemutató grafikát állíthatunk elő, más-
részt számítások végzésére is alkalmas. Ez a terület olyan, amit a program számítá-
sokra nem használ, azaz állományokkal tetszés szerinti próbaműveleteket végezhe-
tünk anélkül, hogy az a meglévő, működőképes adatrendszerben változást okozna. A 
menüvel egy Grid Editor ablakhoz jutunk, ahol a objektumokat, színeket állíthatunk 
be, izovonalas térképeket rajzolhatunk, mint ahogy az a Grid Editor leírásánál talál-
ható. Többletszolgáltatás az animáció (Animation) parancs, ahol a Grid editorban 
beállított térképek, színskálás ábrázolások szerint lehet a nem permanens számítási 
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eredményekhez tartozó állapotok grafikáit egymás után előállítani, majd mint, képso-
rozatot animációként bemutatni. 
 

 
84. ábra 

A Field Generator adatlapja 
 

  
85. ábra  

Az animációs parancsablak 
 

Az animációhoz egy új könyvtárat kell létrehozni és egy állománynevet kell  hozzá 
megadni (Frame file). Ezt követően az új diák létrehozása (Create New Frames) 
doboznál kell döntést hozni: ha egy meglévő animációt akarunk megtekinteni, akkor 
üresen marad a doboz, ha egy újat szeretnénk létrehozni, akkor kipipálandó. A meg-
jeleníteni akart eredmény típusa (Result Type) lehet piezometrikus szint (Hydraulic 
Head), depresszió (Drawdown) és koncentráció (Concentration), melyet az MT3D, 
MT3DMS vagy a MOC3D programmal hoztunk létre. Ezután a program elkészíti a 
diasorozatot, amit ESC megnyomásig újra és újra lejátszik (85. ábra).  
A Tools → Result Extractor... menüvel az eredmények kinyerése történhet, a 86. 
ábra szerinti lapok segítségével. Valamennyi lap esetén a kiválasztott eredményeket  
az olvas (Read) gomb segítségével híjuk be a táblázatba, majd az alkalmaz (Apply) 
gombbal menthetjük el a beolvasott eredményeket az aktuális Grid Editor ablakba. 
A táblázatosan mutatott mátrix adatait a mentés (Save) gombbal ASCII mátrix for-
mátumban tárolhatjuk el. A az ablak bezárása Close gombbal történik. 
Az tájolás (Orientation) menüben adható meg, hogy a táblázat egy réteg, azaz víz-
szintes sík mentén mutassa a kiválasztott eredményelem alakulását (Plan view), 
megadva a kívánt réteg (Layer) sorszámát, vagy egy oszlop (X-section(Coloumn)) 
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vagy sorirányú (X-section(Row)) függőleges metszet mentén. Ez utóbbi esetekben 
megadandó a kiválasztott oszlop vagy sor sorszáma is. Az oszlopszélesség 
(Coloumn Width) mezőben adható meg a táblázat oszlopainak szélessége. 
A hidrodinamikai számítások eredményeit a MODFLOW lapon nyerhetjük ki. Meg-
adva a periódus (Stress Period) és az azon belüli időlépcső (Time Step) sorszámát és 
a kívánt eredmény típusát. Ez utóbbi lehet nyomásszint (Hydraulic Head), depresz-
sziók (Drawdown), koncentrációk (Concentration), összenyomódási értékek 
(Compaction), konszolidációs nyomás értékek (Preconsolidation Head) és felszín-
süllyedés értékei (Subsidence). és valamennyi a vízmérleget módosító modellelem 
(nyelők/források, állandó nyomású cellák, GHB cellák, folyók, szivárgók, maradó 
beszivárgás, evapotranszspirációs hozamok, stb.), által szállított vízmennyiség. 

 

  
86. ábra 

A Result Extractor eredménykinyerő programrész 
 

Transzportmodell számítási-eredmények kinyerése esetén megadandó az időpont 
(Total Elapsed Time), amikorra vonatkozó állapot eredményeit nyernénk ki. Az esz-
köz segítségével kinyerhetők a koncentrációra, az oldott és a megkötött anyagmeny-
nyiségre vonatkozó eredmények. 
A Tools → Water Budget... menüvel egy vízmérleg meghatározó program indul el. 
A Vízmérleg elemeit számítja ki a teljes modellezett térre, ugyanakkor a Zone gomb-
ra kattintva a modellben zónákat jelölhetünk ki egy Grid Editor ablak segítségével, a 
zónákhoz egy-egy sorszámot rendelhetünk. Ekkor a program a teljes modellen kívül 
az egyes kijelölt zónákra is megadja a vízmérleg elemeit rétegenként.  
A Tools → Graphs menüvel az időben változó eredményeket lehet ábrázolni (87. 
ábra). Ezek: A nyomásszint-idő (Head-Time), depresszió-idő (Drawdown-Time), 
összenyomódás-idő (Compaction-Time), konszolidációs nyomás-idő 
(Preconsolidation Head-Time), süllyedés-idő (Subsidence-Time) és koncentráció-
idő (Concentration-Time) grafikonok. 
A grafikonrajzolóban a észlelőkutak (Boreholes) táblázatából kiválasztható az ábrán 
feltüntetendő kutak száma, illetve, hogy számított vagy észlelt értékek ábrázolását 
tervezzük (Data Type: Calculated, Observation). Beállíthatók az x (idő) tengely 
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(x-Time Axis) paraméterei: kezdő időpont (Min. time), végső időpont (Max. time) és 
osztások száma (Ticks), az ordinátán hasonlóan (minimum, maximum és osztás (Min 
value, Max. value, Ticks)). 

 

 
87. ábra 

A Tools → Graphs menü  
 

  
88. ábra 

A grafikonrajzoló ablak 
 

A beállításoknál megadható a vízszintes és függőleges osztóvonalak rajzolása (Draw 
horizontal/vertical grid) és a tengelyek minimum és maximum értékének automati-
kus változtatása (Auto Adjust Min/Max). A grafikon lineáris vagy szemilogaritmikus 
lehet (Graph Style: Linear, Semi-Log).  
A grafikon a Save Plot As gombbal menthető el, a felhasznált adatokat a Data 
gombbal tekinthetjük meg, az észlelt és mért értékek pontdiagramos megjelenítését a 
Scatter Diagram gombbal lehet elkészíteni. 

8.1.1.6. A Help menü 
 

 
89. ábra 

A Help menü 
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A Help → Contents menüvel a súgó érhető el (90. ábra). A súgó gyakorlatilag a tel-
jes kézikönyvet tartalmazza, ugyanakkor az egyes programok komplett dokumentá-
ciója a telepítőlemezen Adobe Acrobat PDF formátumban is megtalálható. 

 

 
90. ábra 

A Súgó kezdőlapja 
 

A Help → Search For Help On... menüvel a súgóbeli keresés indítható el (91. áb-
ra). 

 
91. ábra 

Keresés a súgóban 
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A Help → About Processing Modflow menüben a használt program verzióját és a 
szerzői jogokra és frissítési lehetőségekre vonatkozó ablak jelenik meg (92. ábra). 

 

 
92. ábra 

Az aktuális verzió száma és copyright üzenetek 

8.2. A Legfontosabb MODFLOW csomagok 

A MODFLOW csomagokat a Modells →MODFLOW menüből lehet elérni (93. 
ábra). 

 
93. ábra 

A MODFLOW csomagok menüje 

8.2.1. Kút csomag (Well package) 
A kút csomag ismert hozamú vízkivételek és betáplálások szimulációjára szolgál. 
Tekintettel arra, hogy a MODFLOW egy-egy elem vízmérlegét számítja, ezért az 
egyes elemekbe eső összes hozamot (az elembe eső szűrőzésű kutak együttes hoza-
mát) (Recharge Rate of the Well) kell bevinni. A termelt hozamok negatív, az injek-
tált hozamok pedig pozitív előjellel szerepelnek a vízmérlegben. 
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94. ábra 

Értékadás a kút csomag esetén 

8.2.2. Szivárgó csomag (Drain package) 
A szivárgó egy olyan víztelenítő létesítmény, ami akkor lép működésbe, ha a szivár-
gó környezetében a talajvízszint magasabbá válik, mint a szivárgó fenékszintje. A 
feltételezés szerint az elvezetett víz mennyisége arányos a drén fenékszintje feletti 
vízoszlop nyomásával és a drén körüli képződmények vízvezető képességével (95. 
ábra). 

)()( dhLKdhCQ dd −⋅⋅=−⋅= ,      (8.1.) 

ahol Qd a drén hozama, Cd a drén vízszállító képessége (Drain Hydraulic 
Conductance), h a nyomásszint az elemben, d a drén fenékszintje (Elvation of the 
Drain), K egy egyenértékű szivárgási tényező, melyik leírja a vízadó és a szivárgó 
belseje közötti nyomásveszteségeket és L a szivárgó hossza az elemben. 

 
95. ábra 

Értékadás a szivárgó csomag esetén 
 

Ha a vízszint alacsonyabban áll, mint a drén, akkor a szivárgónak a vízmérlegre nin-
csen hatása. 

8.2.3. Folyó csomag (River package) 
A folyó csomag annyiban különbözik a szivárgótól, hogy függetlenül a vízállástól, a 
folyónak van hatása a vízmérlegre. Ha a folyó vízállása magasabb, mint a talajvíz 
nyomásszintje, akkor a folyó táplálja a vízadót, ellenkező esetben megcsapolja. A 
folyó elemek oldalfalainak a folyómederben lévő részei vízzáróak, vízforgalom kizá-
rólag a folyó mederfenekén, a kolmatált zónán keresztül lehetséges.  
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96. ábra 

A folyócella definíciója 
 

A folyóból a vízadóba jutó hozamot a  

mederfenékmederfenékfolyófolyófolyó

mederfenékfolyófolyófolyó

hhhahHCQ

hhhahHCQ

≤−⋅=

>−⋅=

),(

),(
   (8.2.) 

képlettel számítjuk a talajvízszint függvényében, ahol h a talajvízszint, Hfolyó a vízál-
lás (Head in the River), hmederfenék a mederfenék szintje (Elevation of Riverbed 
Bottom) és Cfolyó a felszíni és a felszín alatti vizek kapcsolatára jellemző mérőszám 
(Hydraulic Conductance of the Riverbed):  

WL
m
k

C
kolmatált

kolmatált
folyó ⋅= ,        (8.3.) 

ahol kkolmatált és mkolmatált a kolmatált zóna szivárgási tényezője, illetve vastagsága, L a 
folyó hossza, W a szélessége az elemen belül. 

8.2.4. GHB csomag (General Head Boundary) 
A GHB csomaggal puha peremfeltételeket lehet biztosítani. A peremen ki- és be-
áramló vízmennyiség arányos a GHB cellák esetén az aktuális és egy előírt vízszint 
eltérésével, azaz: 

)( hhCQ GHBGHBGHB −⋅= ,         (8.4.) 

ahol QGHB a hozam, hGHB az előírt (Head on the Boundary), h az aktuális vízszint és 
CGHB a perem erősségét jelző mérőszám (GHB Hydraulic Conductance): 

0L
Ak

CGHB
⋅

= ,          (8.5.) 

ahol k a réteg vízszintes szivárgási tényezője, A a szivárgás irányára merőleges felü-
let nagysága az elemben és L0 a perem távolsága az állandó nyomásúnak feltételezett 
határtól. Ez a definíció azt jelenti, hogy felfogható a GHB perem egy olyan cellának, 
mint egy állandó hGHB vízszinttel jellemezhető peremtől ismert L0 távolságra lévő 
cella. 



130 

 
97. ábra 

A GHB cellák adatbeviteli ablaka 

8.2.5. Maradó beszivárgás (Recharge package) 
A maradó beszivárgást egy intenzitásértékkel adjuk meg. 

 
98. ábra 

A maradó beszivárgás megadása 
 

A maradó beszivárgás értékét a Recharge Flux mezőben kell megadni. A beszivár-
gás miatt megjelenő hozamokat a legfelső réteghez (Recharge is only applied to the 
top grid layer), egy az IRCH mezőben megadott sorszámú és ezért területileg eltérő 
mélységben található réteghez (Vertical distribution of recharge is specified in 
IRCH) vagy végül a legfelső aktív cellához (Recharge is applied to the highest 
active cell) rendelhetjük hozzá. Amennyiben az első esetet választottuk, akkor az 
inaktív cellák esetén a beszivárgást a vízmérlegben nem veszi a program figyelembe. 
A hozamot az intenzitás és az elem területének szorzataként kapjuk meg. 

8.2.6. Növényborítottsági csomag (Evapotranspiration) 
A MODFLOW evapotranszspirációs csomagja a növények párologtató hatását és a 
földfelszín kiszáradása miatti vízveszteséget veszi figyelembe (99. ábra). 
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99. ábra 

Evapotranszspiráció párbeszédpanel 
 

A vízvesztés maximális (Maximum ET rate), amennyiben a talajvízállás a felszínhez 
egy megadott hs szinten (Elevation of ET surface) belül közelít és zérus ha egy bi-
zonyos d szint (ET Extinction Depth) alatt van. A két szint között a változást lineá-
risnak tételezzük fel.  
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ahol RETMaximum a maximális vízveszteség  
Az evapotranspirációból fakadó vízveszteségeket a legfelső réteghez (ET is 
calculated for cells in the top grid layer) vagy külön mátrixban (IEVT) adható meg 
az evapotranszspiráció által érintett cellák mélysége (Vertical distribution of 
evapotranspiration is specified in IEVT). 

8.2.7. Függőleges gát csomag (Horizontal Flow Barrier package) 
A csomag célja résfal, szádfal vagy vetők szimulációja. A csomagnál megadandó, 
hogy a cella melyik oldalán (Barrier Direction) és milyen vízvezető képességű gát 
található. Azt a vízvezető képességet a gát anyagának szivárgási tényezője és a vas-
tagságának a hányadosa adja ((Hydraulic conductivity/Thickness) of the Barrier, 
100. ábra).  
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100. ábra 

Függőleges gát megadása 

8.2.8. Visszanedvesedés (Wetting Capability) 
A szimulációk során az elemek, ha elvesztik a vizüket és kiszáradnak, akkor inaktív-
vá válnak. A visszanedvesedési csomag lehetővé teszi a vízszint ismételt emelkedé-
sét követően ez inaktív cellák aktívvá válhatnak. 
A csomag akkor teszi lehetővé egy inaktív cella aktívvá válását, ha a szomszédos 
cellában az előző iteratív lépés során a vízszintje az inaktív cella fenékszintjét vagy 
egy a felhasználó által megadott küszöbszintet (TRESH, Wetting Treshold) meg nem 
halad. Amennyiben a feltétel teljesül, akkor a cella aktívvá válik és a vízszintje a fel-
használó által kiválasztott képlettel számítható (101. ábra). 

 

 
101. ábra 

Visszanedvesedés megadása 
 

8.2.9. Időben változó nyomásszintek csomagja (Time-variant Heads) 
Az időben változó nyomásszintek csomagja által érintett elemeket a zérustól eltérő 
Flag számmal jelölhetjük ki. Ezután az elemben az időlépcső elején (Start Head) és 
a végén kialakuló (End Head) nyomásszinteket kell megadni. A cellában a nyomás-
szint változása a kezdeti értéktől a záróértékéig az egyes időlépcsők során – a feltéte-
lezések szerint - lineárisan változik. 
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102. ábra 

Időben változó nyomásszintek 

8.3. A Grid Editor (rácsháló szerkesztő) használata 

A Grid Editor a program egyik legtöbbet használt rutinja. A PMWIN a modellezés 
során az egyes hálóelemekhez rendelt geometriai adatokat, anyagi tulajdonságokat, 
források és nyelők adatait mátrixok formájában kezeli. Ezen mátrixok kialakítását, 
szerkesztését, módosítását a Grid Editorral végezhetjük el (103. ábra). 

 
103. ábra 

A Grid Editor 
 

Az Grid Editorban a következőket tehetjük meg: 
- Az összes cellához azonos értéket rendelhetünk, 
- Bármely kiválasztott cellához adott értékeket rendelhetünk, 
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- Egy adott, kiválasztott cellaértéket bármely másik cellához hozzárendelhetünk 
(másolás) 

- Egy poligonnal körülhatárolt modellezett részhez, zónához értéket rendelhetünk, 
- Az adott mátrixnak egy kritériumnak megfelelő értékű elemeit megváltoztathat-

juk, 
- Elmenthetjük az elemeket, illetve beolvashatunk korábban számított vagy mentett 

mátrixértékeket, 
- Matematikai műveleteket végezhetünk a mátrixokkal. 
A Grid Editor menürendszerét a 104. ábra az ikonokat a 105. ábra mutatja be. 
 

    
104. ábra 

A Grid Editor menürendszere 
 

A Grid Editor menürendszere 
 
 
 

105. ábra 
A Grid Editor ikonjai a hálószerkesztésnél, a digitalizálásnál és egyéb mátrixok szer-

kesztésénél 
 

Az ikonok szerepe balról jobbra: 

-  Ajtó (Leave Editor): Az editorablak elhagyása, a mátrix aktuális értékekkel 
való 

- elmentése, megfelel a File →Leave Editor parancsnak. 
-  Kijelölés: Kurzor üzemmód, amennyiben benyomva található, úgy a kurzor 

mozgatása lehetséges, így az adott mátrixon belül bármely elemre rámutathatunk. 
-  nagyító: Lenyomása után a modell bármely két pontjára feszített téglalap ala-

kú térrész kinagyítható a lenyomott bal egérgomb segítségével. 
-  kicsinyítő: Lenyomása után a lépték visszaáll az eredeti állapotra. 
-  Cella-zóna váltó gomb: segítségével az adatbeviteli mód cellánkénti bevi-

telről zónás bevitelre változik, megfelel az Options →Input Method parancs-
nak. 

-  Tájoló gomb: A gomb segítségével a térképi észak és a modell y tengely-
nek megfelelő tájolások között váltogathatunk. A gombnak nincs hatása, ha az y 
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tengely észak felé néz. A tájolásról a környezet (Environment) leírásánál lesz 
szó. 

-  Cellaérték másoló gomb (Duplication): ki-be kapcsolható, amíg bekapcsolva 
van, addig a mátrix értékek másolódnak a kurzor mozgatási útjának megfelelően. 

-  Rétegmásoló gomb (Layer copy):  A gomb segítségével lehetőség van a 
 ablakban kijelzett, aktuális réteg mátrixelemeinek egy tetszőleges másik 

rétegbe másolására. A gomb ki/be kapcsolja a teljes mátrix másolási funkciót, ha 
bekapcsolt állapotban egy másik rétegre ugrunk vagy PgDn/PgUp gombbal, vagy 
az aktuális rétegszám átírásával, akkor a meglátogatott rétegekben valamennyi 
mátrixelem a kiindulási hely mátrixelemeinek értékét veszi fel. 

 

A Grid Editor menüparancsai: 
- File → Model information: A modellhez rendelt szöveges leírás lekérése, szer-

kesztése File → Save Plot As: Az éppen ábrázolt mezőtulajdonság (képernyő-
rajz) mentése vektorgrafikus (HPGL vagy DXF) esetleg raszteres (BMP) formá-
tumban. 

- File →Leave Editor: Mátrixszerkesztés befejezése, értékek mentése vagy men-
tés elhagyása 

- Value →Matrix →Reset: Teljes mátrix törlése és egy megadott értékkel való 
felülírása. 

- Value →Matrix →Browse: A mátrix végigböngészése táblázatkezelő formá-
tumban, a mátrix elemeinek mentése SURFER dat formátumban vagy saját for-
mátumban, egy korábban mentett mátrix beolvasása. 

- Value →Zones →Save As vagy Load: Adatbevitelhez felhasznált zónahatárok 
mentése illetve beolvasása. A zónák olyan térrészek, amelyeket azonos tulajdon-
ság jellemez. Ezeket zóna üzemmódra váltás után az egérrel jelölhetjük ki, majd a 
jobb egérgombbal rendelhetünk az egyes zónákhoz értékeket. 

- Value →Search and Modify: Kijelölhetők a modell elemek részhalmazai (pl. 
adott értékintervallumba eső elemek) és a kiválasztott elemekkel multiplikatív és 
additív műveletek végezhetők, esetleg egy adott értékre cserélhetők le. 

- Value →Result Extractor: A Result Extractor az adott mátrix elemeit a 
browserhez hasonlóan megmutatja és további feldolgozásra alkalmas formában 
elmenti a kívánt eredményeket. 

- Options →Maps: definiálhatók olyan dxf rajzfájlok vagy raszteres képek, ame-
lyeket az editorablakban a modellezett térrészen való tájékozódásra használha-
tunk fel. (Lásd a környezet beállítása című részt.) 

- Options →Environment: A képernyőn mutatott térrész határainak definiálása, a 
mátrixadatok esetleges izovonalas formában való ábrázolásának megadása, vek-
torábrázolás megadása (Lásd a környezet beállítása című részt.)  

- Options →Display →Mode →Global vagy Local A vizsgált terület északi 
irányban vagy helyi koordináták szerint tájolva. 

- Options → Input Method → Cell-by-cell vagy Zones: Cellánként vagy zónán-
ként való adatbeviteli mód. 

- Help: Súgó file-ok angolul 
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Az összes cellához azonos érték rendeléséhez kiválasztandó a Value →Matrix 
→Reset parancs: a Reset Matrix párbeszédablak jelenik meg, ahová a kívánt érték 
beírható (106. ábra). Az ablakon belül a program feltünteti a megváltoztatandó pa-
raméter típusát és a dimenzióját is. 
 

 
106. ábra 

A Reset Matrix párbeszédablak 
 

Bármely kiválasztott elemhez adott érték hozzárendeléséhez ki kell választani az 
adott elemet, majd a jobb egérgombbal egyet kattintva a Cell Value párbeszédablak 
jelenik meg. Az ablakban a paraméter neve és dimenziója megjelenik, és beírható az 
új vagy módosított érték. 

 
107. ábra 

A Cell Value párbeszédablak 
 

Egy kiválasztott cellaérték másolásához kiválasztandó az adott cella, amelyhez ren-
delt értéket másolni kívánja, majd megnyomva a  ikont, másolási üzemmódba 
váltunk. Közben az ikonon a kis ablak besárgul. Ezután végigmozgatva a kurzort 
azokon az elemeken, ahova a kijelölt értéket másolni kívánjuk az érték átmásolódik. 
Amennyiben a cellák nem határosak egymással, úgy a cellák között egérrel való ug-
rással lehet folytatni a másolást. A másolással érintett cellák színe ideiglenesen meg-
változik. 
A modellezés során lehetőség van zónák alkalmazására. Minden zóna egy poligon, 
melyen belül a tér, az adott jellemző szempontjából homogénnek tekinthető, azaz 
egy konstans értékkel leírható. Egy zónához érték rendeléséhez válassza ki a zóna 
beviteli üzemmódot a  ikonnal, vagy az Options → Input Method → Zones pa-
ranccsal. Az egérrel kattintva készítsen poligont vagy poligonokat, amelyek a külön-
böző tulajdonságú térrészeket választják el egymástól. A poligon zárásához 
klikkeljen a vonal kezdő pontjára. Amennyiben egymást átfedő zónák vannak, úgy a 
legbelsőbbel kell elkezdeni, majd az egyre nagyobb zónákat kell megrajzolni. 
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Amennyiben helyesen vettük fel a zónákat, úgy az egér mozgatásával mindig kékre 
vált az a zóna amelyben az egérmutató éppen tartózkodik. Amennyiben a poligon 
kijelölését elrontottuk volna, úgy a rajzolás közben a jobb egérgombbal klikkelve az 
adott poligont újrakezdhetjük, amennyiben már kész poligont szeretne törölni, úgy az 
egeret mozgassa az adott poligonon belülre, majd amikor az kékre vált és nyomja 
meg a Delete gombot a klaviatúrán. A zónákhoz értéket rendelni az egérnek a zónán 
belülre mozgatásával lehet, majd amikor az adott zóna határa kékre vált, akkor a jobb 
egérgomb megnyomására megjelenik a Zone Value párbeszédablak. 
 

 
108. ábra 

Adatbevitel a zónákba 
 

Beírva a zónára jellemző értéket az ablakba, majd lenyomva a  gombot a 
poligonnal határolt területen belülre eső cellákhoz a megadott értéket rendeli a prog-
ram. Ha az értékeknek a cellákba másolása (a  gomb megnyomása) elmarad, ak-
kor a zónákról a program nem vesz tudomást, mivel a számításokat nem a zóna, ha-
nem a cellaértékekből felállított mátrixok alapján végzi a program.  
A zonákhoz rendelhető poligonokat a Value →Zones →Save As vagy Load 
paranccsal kimenthetjük vagy később beolvashatjuk. 
Az adott mátrixban egy kritériumnak megfelelő értékű elemek kikereséséhez és 
megváltoztatásához a Value → Search and Modify parancsot használhatjuk (megje-
lenik a Search and Modify párbeszédpanel(109. ábra)). 
A panelben a megváltoztatandó vagy kikeresendő érték a Minimum és Maximum 
oszlopokba írt értékek közé esik. A minimum és maximum érték által meghatározott 
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intervallumba eső elemeket a program a Color cellában mutatott színűre változtatja 
(ráklikkelve megváltoztatható), amennyiben az adott sor aktív (Active). Az Options 
cellában határozandó meg az a művelet, amit végezni akarunk: ez lehet a Value osz-
lopba írt értékkel való helyettesítés (Replace), azzal való szorzás (Multiply) vagy 
összeadás (Add), de csak beszínezhetjük a kiválasztott elemeket is (Display only). 
Ezzel az utóbbi lehetőséggel a terület színskálás térképét is elő lehet állítani. A felső 
Parameter: nevű cellában az éppen szerkeszthető egy vagy több paraméter neve van 
felsorolva, ahonnan a megfelelőt ki kell választani. 
 

 
109. ábra 

A Search and Modify párbeszédablak 
 

Az inaktív cellák figyelmen kívül hagyása (Ignore Inactive Cells) dobozzal lehetővé 
válik, hogy a peremfeltételeknél inaktívvá tett elemek esetében a kijelölt műveletet a 
program ne hajtsa végre.  
Az aktuális beállításokat a Save és Load gombokkal menthetjük vagy behívhatjuk. 
A mátrixelemek szerkesztéséhez és elmentéséhez válassza az Editor Value 
→Matrix →Browse parancsát, amire a Browse Matrix ablak jelenik meg (110. áb-
ra). 
Az ablaknak a legördülő paraméter menüjéből (Parameter:) lehet kiválasztani a 
szerkeszteni vagy menteni kívánt jellemzőt az aktuálisan szerkesztett paraméterek 
közül. Bármely értékre kattintva az érték megváltoztatható vagy megnyomva a Save 
gombot, majd a fájlnév megadása után az ablakban választott formátumban (ASCII 
szöveg vagy SURFER xyz DAT formátum) az OK gomb megnyomására a program 
az adatokat elmenti a merevlemezre. 
A korábban számított és mentett mátrixértékeket beolvasásához válassza az editor 
Value →Matrix →Browse parancsát, az ablak legördülő paraméter menüjéből vá-
lassza ki a beolvasni kívánt paramétert az aktuálisan szerkeszthető paraméterek kö-
zül, majd nyomja meg a Load gombot (Load File ablak megjelenik (111. ábra)). A 
fájlnév megadása után az OK gomb megnyomására a program az adatokat beolvassa 
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a merevlemezről. Amennyiben a beolvasandó mátrix mérete nem fele meg a szer-
kesztendő mátrix méretének, akkor hibaüzenetet kaphatunk. 
 

 
110. ábra 

A Browse Matrix ablak 
 

 
111. ábra 

A Load Matrix párbeszédpanel 
 

A mátrixokkal matematikai műveletek végzéséhez a Load Matrix ablak (111. ábra) 
további opcióit használhatjuk fel. Amennyiben pl. a szivárgási tényező és a rétegvas-
tagság értékeinek megfelelő mátrixiokkal rendelkezünk (ezek származhatnak korábbi 
mentésből vagy pl. a Field Interpolator használatából) úgy a két mátrix szorzataként 
kaphatjuk a transzmisszivitás mátrixot. Ehhez először olvassuk be az egyik szorzan-
dó mártixot pl. a rétegvastagságét, majd második lépésként olvassuk be a szivárgási 
tényező mátrixot de úgy, hogy az ne feülírja, hanem összeszorozza a mátrixok érté-
keit (Options: Multiply). Amennyiben nem szorozni, hanem hozzáadni akarunk a 
korábban beolvasott mátrixhoz akkor az Add, ha kivonni, akkor a Substract, ha osz-
tani, akkor a Divide opciót kell kiválasztani. 
Be lehet olvasni egy részmátrixot is, ekkor a kezdőpont (Start Position) ablakrészben 
a részmátrix bal felső sarkának oszlop (Coloumn) és sorszámát (Row) kell megadni. 
Amennyiben olyan adatokat szerkesztünk, amelyek időben változhatnak (pl. a kutak 
vízhozama stb.) és nem-permanens szimulációt végzünk, úgy a File Leave Editor 
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parancs kiadásakor a Temporal Data ablak jelenik meg (112. ábra). Ez az ablak az 
egyes időlépcsők adatmátrixai közötti váltásra, az adatok időlépcsők közötti másolá-
sára és az adatszerkesztés elhagyására szolgál. 
Egy másik időlépcső adatainak szerkesztéséhez válasszuk ki a táblázatban a megfele-
lő időlépcsőt (Period), majd nyomjuk meg az Edit Data gombot. 
Egyik időlépcső adatainak a másik időlépcsőhöz rendeléséhez (másolás) válasszuk ki 
a táblázatban a megfelelő időlépcsőt (Period), majd nyomjuk meg az Copy Data 
gombot.  A megjelenő ablakban adjuk meg annak az időlépcsőnek a sorszámát ahová 
másolni kívánjuk az adatokat. 
 

 
112. ábra 

 

A különböző periódusokhoz tartozó adatok elérése a Temporal Data ablakkal 
Az adott paraméter adatainak szerkesztésének befejezéséhez nyomja meg a Leave 
Editor gombot! Ahhoz, hogy a számítások során az adott periódus során az adatmát-
rixot a program figyelembe vegye a használat (Use) mezőn belüli dobozt be kell je-
lölni! 

8.4. A munkakörnyezet beállítása 

A modellezési környezet beállításait minden munkafázis során megtehetjük: a 
rácsháló definiálásakor, az adatbevitel során a Grid Editor használatánál, de akár 
az eredmények megtekintése során is. Tanácsként annyi mondható el, hogy minél 
korábban történik mindez annál jobb. Mit is értünk a környezet beállításán: 
- vonalrajzok (digitális alaprajzok) megjelenítését, 
- a rendszernek helyi koordinátarendszerből valós koordináta-rendszerbe illesztését 
- a képernyőn megjelenítésre kerülő elemek (cellák, nyilak, izovonalak stb.) meg-

határozását. 

8.4.1. Vonalrajzok (digitális alaprajzok) megjelenítése 
Kiválasztva a Grid Editor Options → Maps parancsát a Map Options panel jele-
nik meg (113. ábra). 
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A panelban a DXF File dobozokba írja be az ábrázolni kívánt AutoCAD R12 
DXF formátumú állomány nevét, majd a doboz előtti kis kockára ráklikkelve 
jelezze a megjelenítés szándékát. A Fájlnév kiválasztása lehetséges a szövegmező-
ben jobb egér kattintással, amikor egy intéző ablak jelenik meg. A DXF állomá-
nyokból csak a LINE, POLYLINE, POINT, ARC, SOLID, CIRCLE és TEXT típu-
sú objektumok jelennek meg. 
A Line Map File mezőkben ASCII szövegfájlban tárolt vonalak jeleníthetők meg, 
mint pl. Golden Software Blanking (BLN) fájlok. 
 

  
113. ábra 

A Maps Options párbeszédablak 
 

Az X és Y opciók megadásával a bal alsó sarok kezdőkoordinátáit adhatjuk meg, ami 
a rajz vonatkoztatási pontját is jelenti egyben, a Factor mezőbe pedig a rajz méret-
arány-változtatási igényét írhatjuk be, azaz ha pl. a DXF állományban az egység cm, 
de a modellben ugyanez méter akkor a szorzószám 100. Több vonalrajzot is feltehe-
tünk az ábrára, illetve bármelyik megjelenítését tetszés szerint ki is kapcsolhatjuk. 

Ha nem jelenne meg a képernyőn rajz, úgy a modellezett térrész (egyben a kép-
ernyőn látható térrész) nincs fedésben a rajz által lefedett térrésszel, aminek leg-
többször környezet-beállítási, vagy rajzfájlhiba okai lehetnek. 
A Raster Graphic lapon rasztergrafikus (pl. Bitmap)  állományok adhatók meg hát-
térként. A grafika és a valóság közötti kapcsolatot (georeferálás) 2 pont (Point 1 és 
2) segítségével adhatjuk meg. Először adjuk meg a térképi raszteres állomány nevét 
(Filename:), majd adjuk meg a két referenciapont koordinátáit. Ezután a Set gomb 
megnyomásával a kurzor segítségével megjelölhetjük a térképen az adott koordiná-
tájú pontok helyét. 
A térkép nézetét az egérrel változtathatjuk: a nagyítás Shift és bal egérgombbal, a 
kicsinyítés Ctrl és jobb egérgombbal, a teljes térkép nézete az Alt és bal egérgomb-
bal érhető el. 
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8.4.2. Az Options → Environment parancs 
A rendszernek helyi koordinátarendszerből valós koordináta-rendszerbe illeszté-
sét és a képernyőn megjelenítésre kerülő elemek (cellák, nyilak, izovonalak stb.) 
meghatározását az Environment panel megfelelő beállításával érhetjük el, ehhez a 
Grid Editor Options → Environment parancsátkell kiválasztani. Az Environment 
ablakon belül az első lap a megjelenítések beállítására (Appereance), a második a 
koordinátarendszer beállítására, a harmadik az izovonalas térképi ábrázolásra 
(Contours) szolgál. 

8.4.2.1. A megjelenítési beállítások 
A Grid Appearance mezőben a kis dobozok kijelölésével az egyes, speciális 
tulajdonságú cellák esetleges megjelenítését, illetve a megjelenítés színét definiál-
hatjuk. azon elemek amelyek mellett a pipát megjelentetjük, azok az 
editorablakban láthatók lesznek a megadott színnel. A megjelentethető elemek: 
 

Grid Rácsháló Discharge Wells Termelőkutak 
Inactive cells Inaktív cellák Recharge Wells Injektáló kutak 
Fixed Head Állandó nyomású cellák Drain Szivárgók 
Fixed Conc. Állandó konc. cellák Specified Flows (in) Betápláló hozamok 

Bores Fúrások Specified Flows (out) Megcsapoló hozamok 
Observations Megfigyelőkutak Digitized Points Digitalizált pontok 

Gen. Head BoundaryHB cell GHB cellák River or Stream Folyó vagy Patak 

Horizontal Flow Barrier Függőleges helyzetű gátak Reservoir Rezervoár 

Time Variant Spec. Head Időben változó nyomásszintek Time Variant Spec. Conc Időben vált. koncentráció 
 

 
114. ábra 

A megjelenítési beállítások 
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8.4.2.2. A modell tájolása 
A program két koordináta rendszert használ, egyrészt egy helyi koordináta rendszert 
ahol a rácsháló bal alsó sarka a 0,0 koordinátájú pont, másrészt egy valós koordináta-
rendszert, mint amilyen pl. a Magyarországon alkalmazott Gauss-Krüger, sztereogra-
fikus vagy EOV vetületi rendszer koordinátarendszere. Mivel a helyi koordináta-
rendszerben a cellák helye a cellaméretekkel adott, ezért ezt nem kell megadni, 
ugyanakkor a valós koordináta rendszert a modell bal felső sarkának X0 és Y0 pont-
jának valós koordinátáival, illetve a térkép elforgatásának mértékével meg kell adni 
(115. ábra)  

 
115. ábra 

A valós koordinátarendszer megadása 
 

A rácshálót a Grid → Mesh Size ... parancsnál felbukkanó két ikonnal is lehet beál-
lítani: 

-  ikon bekapcsolásával a rácsháló a képernyőn és egyben a valós koordinátasí-
kon mozgatható, 

-  ikon bekapcsolásával a rácsháló a képernyőn és egyben a valós koordinátasí-
kon forgatható. 

A helyi és a valós koordinátarendszer közötti átkapcsolást az alábbi ikonok segítik: 

-  helyi koordinátarendszer, 
-  valós koordinátarendszer. 
A modell-rendszer tájolásához (koordináta rendszer meghatározásához) állítsa be a 
rácsháló megfelelő tájolását (Grid Position mezőrész), majd a képernyő által muta-
tott térrész nagyságát (Worksheet Size). A képernyő által mutatott terület bal alsó 
sarka az X1,Y1; jobb felső sarka az X2, Y2 koordinátájú pont. 
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Figyelem! A magyar EOV rendszerben az EOV X koordináta az y tengelyre az EOV 
Y koordináta az x tengelyre kerül, ezért a bal felső sarok EOV X koordinátája az 
Y0 érték. és ugyanez vonatkozik a képernyő által mutatott térrész valós koordinátá-
inak beállításaira is. 

8.4.2.3. Izovonalas térképek ábrázolása 
Az aktuálisan a Grid Editorban mutatott jellemző megtekintésére és az adatállomány 
ellenőrzésére a térképi megjelenítés ajánlható, amit szintén az Options → 
Environment paranccsal érhetünk el (116. ábra) 
 

 
116. ábra 

Az izovonalak megjelenítése 
 

A láthatóság (Visible) doboz ki/be kapcsolja az izovonalas/színskálás megjelenítést.  
Az izovonalak ábrázolása doboz (Display Contour Lines) az izovonalak megjelení-
tését kapcsolja ki, ekkor csak a színskálás ábrázolás érvényesül. 
A kitöltés (Fill Contours) doboz a színskálás ábrázolást kapcsolja ki/be, míg az 
izovonalak megjelenítése lehetséges marad.  
A felület térbeli leképzését könnyíti meg az izovonal-feliratok dombirányú elhelye-
zése (Orient labels uphill).  
Az inaktív cellák területén a megjelenítés kikapcsolására szolgál az inaktív területek 
fiogyelmen kívül hagyása doboz (Ignore inactive cells). 
A táblázatos részben a fejlécen a Level gombra kattintva állíthatjuk be az első (Mi-
nimum) és (Maximum) utolsó izovonal szintjét és az izovonalak közötti lépésközt 
(Interval). A Fill feliratra kattintva a színkitöltést adhatjuk meg a minimális és a ma-
ximális értékekkel jellemezhető területrészek színével. Az egyes izovonalakra írandó 
cimkét engedélyezzük a Label dobozban. A Label height és Label spacing beállítá-
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sokkal a cimkék magasságát és egymástól való távolságát szabályozhatjuk a térképi 
hosszúság egységekben megadva. 
A Label Format gombbal a cimkék formátumát adhatjuk meg adott számú tizede-
sekre kerekítve tizedes törtként (Fixed) és tudományos számábrázolással ú.n. nor-
málalakban (Exponential) (117. ábra). A cimkékhez elő és utótag is rendelhető 
(Prefix és Suffix mezők) 
 

 
117. ábra 

A feliratok formázása 
 

A Save és Load gombokkal az izovonalas ábrázolások beállításai menthetők el, illet-
ve tölthetők be.  

8.5. A MODFLOW futattása 

Az összes paraméter beállítását követően a Models → MODFLOW → Run 
paranccsal lehet a futtatást elindítani. Ekkor a 118. ábra szerinti ablak jelenik meg. 

 
118. ábra 

A MODFLOW futtatási ablaka 
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A Modflow Version mezőben a futtatandó program verzióját adhatjuk meg. Ha más 
indok nincsen akkor javasolható a MODFLOW-96 program használata. A Modflow 
Program mezőben a kiválasztott programverzió elérési útját állíthatjuk be. 
Az ablakban látható táblázat tájékoztatási célt szolgál. Bemutatja a megadott adat-
rendszer esetén szükséges modulokat, illetve a táblázatban mutatja, hogy egyes cso-
magok újragenerálása szükséges-e. 
Az ablakban előírhatjuk, hogy valamennyi csomagot a program újra elkészítse 
(Regenerate all input files for MODFLOW) még akkor is, ha azok tartalma nem 
változott. A Check the model data doboz az adatrendszer formai ellenőrzésére ad 
utasítást. Amennyiben a csomagokat előállítjuk, de nem indítjuk el (Generate input 
files only, don’t start MODFLOW), akkor erre később a MODFLOW.BAT batch-
fájl elindításával bármikor később is lehetőség van. Mivel a Processing MODFLOW 
saját áramvonal-rajzoló és részecskekövető programmal (PMPATH) rendelkezik, 
ezért a MODPATH használatára nincs szükség. A Don’t generate  MODPATH files 
anyway doboz kiválasztásával az általában szükségtelen állományok generálását tilt-
hatjuk le. 

8.6. Eredmények kiértékelése és PMPATH 

Az eredmények kiértékelésének legegyszerűbb eszköze a PMPATH program haszná-
lata. A PMWIN környezetből a programot a Models → PMPATH (Pathlines and 
Contours) menüponttal lehet elindítani. 
A PMPATH program egy áramvonal követő program, melynek számos alkalmazási 
lehetősége lehet. A rendszerrel a felhasználó által megadott pontból vagy pontokból 
a víz áramlási irányával egyező vagy éppen azzal szemben kirajzolhatók az áramvo-
nalak. Egy szennyezett terület vizsgálata esetén érdekes lehet, hogy az ott beszivárgó 
szennyezett víz milyen úton és mennyi idő alatt merre juthat el. Ebben az esetben a 
víz szivárgási útját követve kell az áramvonalakat meghatározni. Más esetben pedig 
arra lehetünk kíváncsiak, hogy egy természetes vízkilépési helyhez vagy víztermelő 
létesítményhez honnan jut a víz. Ekkor az ismert érkezési pontból (kút, forrás, stb.) a 
víz szivárgásával szemben határozzuk meg, hogy mely területekről érkezik oda a víz 
és mekkora időn belül jut a vízkilépési vagy vízkivételi pontig a víz.  
A rendszer használatához diszkrét vízrészecskéket kell kiválasztani (definiálni) és a 
program a kiválasztott vízrészecskék útját határozza meg és rajzolja ki. Az áramvo-
nalak kirajzolása egyben a hozamok megjelenítésére is alkalmas: amennyiben egyen-
letesen osztjuk szét a vízrészecskéket egy kiindulási területen, akkor a sűrűbben ki-
rajzolt áramvonalak nagyobb, a ritkábban rajzoltak alacsonyabb fluxusokat jeleznek. 
Azokon a területeken, ahol áramvonalak nem futnak, pang a felszín alatti víz. 
A PMPATH elindításakor a 119. ábra szerinti munkaterület jelenik meg. 

A rendszerben először definiálni kell vízrészecskéket. Ehhez a kijelölő  gombot 
kell megnyomni majd a vízrészecskék tervezett helyén lévő cellákat az egérgomb 
lenyomása mellett ki kell jelölni, ekkor az Add Particles panel jelenik meg (120. áb-
ra). 
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119. ábra 

A PMPATH munkakörnyezete egy kútcsoport körüli áramvonalrendszer kirajzolása 
esetén 

 

A Particles lapon az elemoldalak (Cell Faces) lapon megjelölt számozás szerinti 
oldalakra (Particles on cell faces), illetve a cellákon belülre (Particles Within cells) 
lehet a felhasználó által megadott darabszámú vízrészecskét elhelyezni. A henger-
szimmetrikus szivárgási terek jobb követése érdekében az elemek középpontja köré 
rajzolt körökre (Particles on Circles) is lehet vízrészecskéket telepíteni. A tulajdon-
ságok (Properties) lapon a vízrészecske színét és a részecskére jellemző késleltetést 
(Retardation factor). A színbeállításokat felülbírálhatja a modellrétegekhez rendelt 
színskála. 
Lehet még vízrészecskéket a jobb egérgombbal is a rendszerbe helyezni, ekkor min-
den egyes részecskét külön-külön kell megadni. 

A vízrészecskék törléséhez a File  → Delete all particles parancson túl a  gomb 
segítségével is lehet. A gomb bekapcsolt állapota mellett kijelölve egy térrészt, a 
modell kiválasztott rétegén belüli, térrészre eső vízrészecskék törlődnek. 

A kijelölt vízrészecskék mozgását az áramlási irányba a  gombokkal, az áram-
lással szemben a  gombokkal lehet egy időlépcsőre, illetve a teljes szimuláci-
ós időtartamra számítani. 
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120. ábra 

A vízrészecskék hozzáadása panel 
 

A kész áramképet ezután a File  → Save Plot As parancs használatával lehet elmen-
teni és további feldolgozásra előkészíteni. 

8.6.1. A File menü  

 
121. ábra 

A PMPATH File menü 
 

A File → Open model paranccsal egy lefuttatott modell eredményállományai nyit-
hatók meg és jeleníthetők meg a PMPATH környezetben. 



149 

A File → Import model paranccsal MODPATH 3. állományok töltetők be a kör-
nyezetbe. 
A File → Save Plot As... paranccsal a képernyőn lévő aktuális tartalmat lehet elmen-
teni Windows Bitmap (*.BMP), Hewlett-Packard Graphics Language (HPGL) és 
AutoCAD drawing exchange formátumba (*.dxf) 
File → Save Heads As... paranccsal az eredményül kapott nyomásszintek mentése 
történhet meg. 
File → Save Drawdowns As... paranccsal az eredményül kapott depressziókat lehet 
elmenteni. 
File → Save Velocity As... paranccsal az eredményül kapott nyomásszintek és szi-
várgási tényezők alapján számított szivárgási sebességeket lehet elmenteni. A mentés 
során külön kiírhatók az X és Y irányú sebességkomponensek, továbbá az eredő se-
bességvektor is. 
File → Print Plot paranccsal az aktuális grafika nyomtatása történhet. A legfonto-
sabb opciók a teljes oldalt kitöltő nyomtatás (Use full page) és a lapközépre helye-
zett nyomtatás (Center on Page). Amennyiben nem teljes oldalra széthúzva és/vagy 
nem középre nyomtatunk, akkor a kép szélességét és hosszúságát mm-ben (Image 
Size (millimeters): Width és Height) és a bal és felső oldali margókat (Margins 
(millimeters): Left és Top) is megadhatjuk. Egy legördülő menüből megadható, hogy 
a nyomtatásban a felülnézet mellett valamelyik vagy mindegyik keresztmetszeti kép 
is megjelenjék-e. 
A File → Delete All Particles paranccsal a korábban definiált vízrészecskék törölhe-
tők. 
A File → Save Particles As paranccsal az aktuálisan definiált vízrészecskék tulaj-
donságai és helyzetük menthető el. 
A File → Load Particles paranccsal a korábban elmentett vízrészecske adatok tölt-
hetők be. 
A File → Exit paranccsal a PMPATH programot be lehet zárni. 

8.6.2. A Run menü 

 
122. ábra 

A PMPATH Run menü 
 

A Run menü parancsai az Options menüben beállított tulajdonságú vízrészecskék 
mozgását vezérli. A vízrészecskék mozgását lehet az áramlás irányába és azzal ellen-
tétes irányban is vizsgálni.  
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A Run → Forward,  és a Run → Step Forward parancsokkal a vízrészecskék 
áramlási irányba történő mozgását lehet vizsgálni. 
A Run → Backward  és a Run → Step Backward parancsokkal a vízrészecskék 
áramlási iránnal ellentétesen történő mozgását lehet vizsgálni. 
A Run → Restart paranccsal a kijelölt vízrészecskék útjának számítása újra indítha-
tó. 

8.6.3. Az Options menü 

 
123. ábra 

A PMPATH Options menü 
 

  

  
124. ábra 

A környezet beállításai az Environment ablakkal 
 

A környezet beállításainál (Options → Environment, 124. ábra) először a megjele-
nítési beállításokat lehet megadni (Appearance), melyek megegyeznek a PMWIN 
láthatósági beállításaival. A Cross Sections lapon megadható egy sor (Projection 
Row) és oszlop (Projection Coloumn), melynek mentén a program metszeten is áb-
rázolja – adott magassági torzítás (Exaggregation)az áramvonalakat. A láthatóság 
(Visible) doboz engedélyezi a metszetek rajzolását, a háló rajzolás (Show Grid) do-
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boz, pedig a metszeteken teszi lehetővé ez elemek, a vízszint berajzolása (Show 
groundwater surface (potential)) doboz, pedig vízdomborzat ábrázolását. A metsze-
teken ábrázolt mélységtartományt a minimális és maximális magasság (Minimum-
Maximum Elevation) segítségével adhatjuk meg. 
A Velocity vectors lapon az egyes elemekbe rajzolt sebességvektoroknak megfelelő 
nyilak rajzolását lehet engedélyezni (Visible). A nyilak méretét a Vector Size mező-
ben lehet változtatni. 
A Contours lapon az eredmények izovonalas ábrázolását lehet beállítani. A modul 
azonos a PMWIN térképrajzoló moduljával, ugyanakkor itt megadható, hogy az áb-
rázolás a depresszió vagy a nyomásszint értékeket felhasználva történjék. 
Az Options → Particle Tracking Time menüben a vízrészecskék tulajdonságait, 
illetve a számítási feltételeket lehet beállítani (125. ábra).  

 

  
 

 
125. ábra 

Az Options menü beállításai 
 

A Simulation Mode/Time lapon a vizsgált periódus (Stress Period) és a perióduson 
belüli időlépcső (Time Step) számát adhatjuk meg. Beállítható a részecske követésé-
hez egy időlépcső (Step Length) a kiválasztott idő mértékegységben (Unit) és meg-
adható, hogy egy teljes szimuláció hány ilyen időlépcsőt öleljen fel (Maximum 
Steps). Az áramvonalra jeleket lehet rajzolni, melyek megjelenítését, illetve gyakori-
ságát és méretét a Time Mark mezőrészben lehet beállítani. Két szimulációs lehető-
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ség (Simulation Mode) áll rendelkezésre vagy a kiválasztott periódus időlépcsőjének 
megfelelő sebességtérben zajlik a számítás (Flowlines, use the flow field from the 
current time step) vagy a nem permanens számítás során éppen aktuális és folyama-
tosan változó sebességtereket (Pathlines, use transient flow field) használja a rend-
szer a szimulációhoz. Beállítható, hogy a részecskék megálljanak, ha azok egy nye-
lőhöz (pl. kút) érkeznek (Particles stop, when they enter cells with internal sinks). 
A Pathlines/Colors lapon egy színskála segítségével megadható, hogy az egyes mo-
dellrétegeken belül haladó áramvonalak milyen színűek legyenek, ez segíti az ered-
mények értelmezését. 
Az RCH/EVT options lapon a beszivárgás és az evapotranspirációra vonatkozó beál-
lítások tehetők meg. A maradó beszivárgásból eredő hozamot a cella tetejéhez (top 
face), aljához (bottom face), mindkettőhöz (top and bottom face) rendelhetjük, illet-
ve a hozamot eloszthatjuk egyenletesen a cellán belül (distributed source). 
Az evapotranszspirációs hozamokat csak a cellák felső oldalához (top face) lehet 
rendelni, illetve megoszló hozamként kezelhető (distributed source). 

8.6.4. A Help menü 
A Help menün (126. ábra) keresztül érhető el a súgó, illetve a program verziószáma  

 

 
126. ábra 

A PMPATH Help menü 
 

 
127. ábra 

A PMPATH verziószáma és copyright üzenetek 
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